in ©

[ﬂJW/W4

HP LaserdJet 4 Printer
Software Application Notes

(Printing With Your Software)




HP LaserJet 4 Printer
Software Application Notes

(Printing With Your Software)

- Computer
Museum

[bﬁ HEWLETT

PACKARD

HP Part No. C2001-90934
Printed in USA



HP Computer Museum
www.hpmuseum.net

For research and education purposes only.



Notice

Printing History

The information in this document is subject to change
without notice.

HEWLETT-PACKARD MAKES NO WARRANTY OF ANY
KIND WITH REGARD TO THIS MATERIAL,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR APARTICULAR PURPOSE. Hewlett-Packard shall
not be liable for errors contained herein or for incidental
consequential damages in connection with the furnishing,
performance, or use of this material.

This document contains proprietary information which is
protected by copyright. All rights are reserved. No part of
this document may be photocopied, reproduced, or
translated into another language without the prior
written consent of Hewlett-Packard Company.

Copyright©1993 by HEWLETT-PACKARD COMPANY.

Lotus® 1-2-3® are U.S, registered trademarks of Lotus
Development Corporation. Microsoft® is a registered
trademark of Microsoft Corporation. PageMaker® is a
U.S. registered trademark of Aldus Corporation.

Edition 1 11/92 C2001-90934
Edition 2 11/92 C2001-90934
Edition 3 1/93 C2001-90934

This manual was created using Xerox Ventura Publisher
software on an HP Vectra Personal Computer. The
camera-ready copy was printed on an HP LaserJet IIISi
printer and reproduced using standard offset printing.

]
Table of Contents

Chapter
Microsoft Windows version3.0 . . .. ... ... .... 1
Microsoft Windows version 3.1 . . ... ... ...... 2
Lotus 1-2-3release 3.1/3.1+ . . . . .. ... ... .... 3
Lotus 1-2-3release 2.3 . . . . ... ... ......... 4

WordPerfect 5.1 . . . . .. .. ... ... ... ..... 5



Microsoft Windows version 3.0

Table of Contents About This Chapter . .. ............. 1-2
HP First FAX Retrieval System . . . . . ... .. 1-2
Hewlett-Packard Distribution . . . . .. .. ... 1-2
CompuServe . ... .. ..........c.... 1-3

Microsoft Corporation . . . . ........... 1-4
Supported Fonts and Typefaces . . . . . ... .. 1-5
Installing a Printer Driver . . . . . . .. .. ... 1-6
Adding PostSeript Support . . . .. .. ... .. 1-8

GeneralInformation . . . .. ........... 1-10
AddingFonts . . . .. .. ... ... .. ..., 1-10
Using Print Manager. . . .. ... ..... ... 1-15

Common Problems In Windows ......... 1-16

PageMakerversion4.0. . .. ........... 1-19
CommonTasks . . .. ... ............ 1-19
CommonProblems . . . ... .. ......... 1-23

Microsoft Excelversion3.0a ........... 1-24
CommonTasks . . . ... ... .. ... ..... 1-24
Common Problems . . . ... ... ........ 1-26

WordPerfect version 5.1 for Windows . . . ... 1-28
Selecting a Printer Driver . . . . .. .. .. ... 1-28
InstallingFonts . ... ... ........... 1-30
CommonTasks . . .. .. ... ... ....... 1-31
Common Problems . . . ... ... ........ 1-37

Word for Windows version20 ... ....... 1-38
CommonTasks . . .. .. ... ... ....... 1-38
Common Problems . . . . ... ... ....... 1-41

Microsoft Windows version 3.0 1-1



About This
Chapter

HP First FAX
Retrieval System

Jd
Note '.'ﬂ

This chapter is designed to assist you in setting up and
using Windows 3.0 with your HP LaserdJet 4 printer.

Because most Windows 3.0 applications use the
HPPCLS5E printer driver, once you install the printer
driver, you are ready to print from any Windows
application. Additionally, the instructions for paper
handling, printer configuration, and font and typeface
installation are identical in most Windows 3.0
applications. This chapter provides specific instructions
for these common tasks.

This chapter also includes detailed information about
using PageMaker 4.0, Microsoft Excel 3.0a, WordPerfect
for Windows 5.1, and Word for Windows 2.0 with the HP
LaserdJet 4 printer. These instructions can be used as a
guide for other Windows 3.0 software. For information on
selecting printer features through your Windows 3.0
software applications, consult your software
documentation or contact your software company.

Additionally, HP provides Software Application Notes for
selected software packages. These notes are available
through the following distribution sources:

If you would like to have a list of drivers and Software
Application Notes faxed to you:

1. Dial (800) 333-1917 from any touch-tone telephone.
2. Select (1) for HP FIRST.

3. Follow the voice prompts that guide you to select an
index or to enter a document ID number for product
information.

When you have selected all the documents you want,
you will be prompted to enter the telephone number
of the receiving FAX machine.

After HP FIRST acknowledges your documents are
ready, the system will dial the telephone number of
the FAX machine you selected, and the documents
you requested will be sent.

The time required to receive your information will vary
depending on the length or complexity of the documents
you requested.
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Hewlett-Packard  Application notes and drivers are available for selected
Distribution  software packages through Hewlett-Packard Distribution.
Call (303) 353-7650 for information (Monday through
Friday, 7 AM to 6 PM, MST).

CompuServe Ifyou are a member of CompuServe, you can download
Software Application Notes and software drivers from the
HP Peripherals Forum.
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Microsoft
Corporation

Additional Support
Numbers for
Windows
Applications

Microsoft Corporation Customer Support

Windows Technical Support . . . . .. (206) 637-7098
Microsoft Programs and DOS . . . . . (206) 454-2030
Hours . ... .. ...... ... ... 6 AM - 6 PM PST
Required Identification . . . ... ... ...... None
Charge . . . ... .. ... . . .. .. ... ... None

(Charge for DOS support after 90 days)

CorelDraw . .. ... ......... (613) 728-1990
Harvard Graphics for Windows . . . . (408) 988-4005
Lotus 1-2-3 for Windows . . . . .. .. (617) 253-9150
Micrografx Designer . . ... ... .. (214) 234-2694
Microsoft Excel . . ... .. .. .. .. (206) 635-7070
Microsoft Word for Windows . . . . . . (206) 462-9673
Microsoft Works for Windows . . . . . (206) 635-7130
Aldus PageMaker . . .. ... ... .. (206) 628-2040
Aldus Persuasion . . . ... ...... (206) 628-2040
Microsoft Powerpoint . . . . . ... .. (206) 635-7145
WordPerfect for Windows . . . . . . .. (800) 228-1023
QuarkXPress . . . ... .. ...... (303) 894-8899

For information about Microsoft support and warranty
policies, refer to Microsoft documentation.

Product upgrade policies and procedures: To
upgrade your current version of Microsoft Windows, call
Microsoft Customer service at (800) 426-9400. If you are
in the USA or Canada, you can order upgraded printer
drivers for the HP LaserJet family of printers by calling
Hewlett-Packard Distribution at (303) 353-7650; for all
other countries, contact your HP dealer. If you are a
member of CompuServe, you will find current drivers
available on the HP Peripherals Forum.
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Supported Fonts and
Typefaces

Windows Printer
Setup

Verifying Windows Driver
Version

Cartridge Fonts 92286
A,B,C.D.EFGH,ICJKLMN,P,
PC.Q,R TUVWWI, XYZZia

Cartridge Fonts 92290...
S1,82
Cartridge Fonts C2053A...

C01,C02,C03,C04,C05,C06,C07,

C08,C09
Cartridge Fonts C20585A...

Disk-based Fonts...All Hewlett-
Packard LaserJet
Disk-based Fonts

Type Director 2.0...
All Typefaces

Scalable Disk-based Typefaces...
All Typefaces

co1
Cartridge Fonts C20508B...
C80,C90
Cartridge Fonts C2050C...

C80,C90

Support for most HP 92286 and 92290 fonts does not
come with Windows. (Windows does come with support for
the HP 922861IC, 92286PC, and 92286Z cartridges.) For
support with cartridges other than these three, you will
need to get the PCM files, or AutoSupport files. These can
be downloaded from the HP Peripherals Forum on
CompuServe or ordered from Hewlett Packard at (303)
353-7650. See the “Installing Bitmapped and Scalable
Font Cartridges” section of this note for more information.

The information in this section describes how to set up
Windows 3.0 for use with a HP Laserdet 4 printer in PCL
mode.

The procedures in this document assume that Windows is
already installed and operating.

Follow these steps to verify the version of the Windows
3.0 printer driver you are using.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program Window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Highlight HP Laserdet 4 on (port):, Active.
Choose the CONFIGURE button.

Choose the SETUP button.

Choose the ABOUT button. This screen will tell you
which version of the printer driver you have. If you
do not have an HP Laserdet 4 printer driver, call

NS ok w
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Hewlett-Packard Distribution at (303) 353-7650 to
receive a free copy of the most current driver.

8. To exit, choose the OK button four times.
9. Press [ALTI[F4] to exit Control Panel.

Installing a Printer  Follow the instructions in the README file on the
Driver Windows 3.0 updated Driver disk to install the HP
Laserdet 4 printer driver. You can print these instructions
by typing the following at a DOS prompt:

1. Insert disk into drive A:
2. At your DOS prompt type A: to get an A prompt.

3. At the A prompt type COPY README PRN, then
press [Enter].

If the [Form Feed] light on the printer’s control panel
stays on after the README file has printed, more data is
in the print buffer. To print the remaining data in the
print buffer use the following steps:

1. Press and release the [On Line] key to take the
printer offline.

2. Press and release the [Form Feed] key to print the
data in the print buffer, then press and release the
[On Line] key to put the printer back online.

“.l Any HP Laserdet 4 printer you have previously installed
Note ﬂ will use the new PCL 5 Printer Driver and Hewlett-
Packard Font Installer. Remove through the Control
Panel any HP Laserdet 4 printer entries that are not
needed.

Deleting a Printer 1. From the Windows PROGRAM MANAGER menu,
Driver open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Highlight the printer that you wish to delete.
Choose the CONFIGURE button.

Choose the REMOVE button.

You will be asked if you want to remove the printer.

® e~ w

Choose the YES button to remove the printer driver.
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Changing Printer
Defaults

!—l

From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the MAIN menu, double-click on the CONTROL
PANEL icon to open Control Panel.

3. Double-click on the PRINTERS icon.
4. Highlight the name of the printer you wish to change.

5. Choose the CONFIGURE button. At the Printers -
Configure dialog box, you can choose which printer
port you are using by selecting LPT'1, LPT2, COM1,
FILE, etc.

For more information about selecting ports and default
timeouts, consult your Microsoft Windows User’s Guide.

6. Choose the SETUP button.

At the Setup dialog box to the right of the printer
drop-down list box, click on the down-pointing arrow.
Hold the left mouse button down as you scroll
through the list of printers.

7. Select the HP LaserdJet 4 printer.

8. You can change many of your printing options in the
Setup dialog box. You can select the Paper Source,
Paper Size, Orientation, and Graphics Resolution (if
you change resolutions between 300 and 600 dpi and
you have disk-based fonts downloaded to the printer,
you will lose the disk-based fonts in printer memory).

You can also choose Graphic Image Type, Font
Cartridges, Number of Copies, and add soft font and
cartridge font support in the Setup dialog box. (See
Adding Fonts later in this note.) In addition, you can
indicate the amount of Memory that is installed in
the printer, and indicate whether your printer’s Page
Protection feature is turned on.

The Page Protection option also appears in the
Printer Setup dialog box. This setting, in combination
with the Memory box setting, tells the printer driver
how much of the memory available in the printer it
can use,
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Note '.'ﬂ

Adding PostScript
Support

Turning Language
Switching On

configuration, but only reflects it. To change the Page
Protect setting in the printer, use the printer’s control
panel.

The Printer Setup dialog box in the Windows Control
Panel allows you to choose Photographic Images, Line Art
Images, or HP Scandet Images. For an improved
photographic appearance, select Photographic Images.
Your image will have smooth, soft looking contrasts
between shades of gray. Images originally designed with
color will also print better.

For images that have a line draw look, such as clip art,
select Line Art Images. The HP ScandJet Images option is
specially tuned for scanned images from an HP Scandet to
give exceptional quality and clarity to the printed images.
This method uses a variation of the Photographic Images
method. You may want to print your graphics from more
than one of the gray scale printing methods.

9. Once you have changed all of the options for the
features you want to use, choose the OK button four
times.

10. Press [ALTI][F4] to close the Control Panel.

The following instructions describe how to install
PostScript support in Windows 3.0 for your HP Laserdet 4
printer.

If you want to print in PostScript mode to an HP Laserdet
4 printer, you can either select the PostScript personality
on the printer’s front panel, or you can set the printer for -
automatic language switching so it will distinguish
between PostScript and PCL and switch to the
appropriate language for the current job. The following
steps will set the printer for automatic language
switching:

1. Press and release the [On Line] key to take the
printer offline.

2. Press and release the [Menu] key repeatedly until
JOB MENU is displayed on the printer.

3. Press the [Item] key repeatedly until the printer
displays

PERSONALITY=(PCL, PS or AUTO)*
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Installing a PostScript
Printer Driver

4. If the display does not read PERSONALITY=AUTO*
press the [+] key repeatedly until the printer displays:

PERSONALITY=AUTO
5. Press the [Enter] key to save the change. You will see:

PERSONALITY=AUTO*

6. Press the [On Line] key to put the printer back
online.

Follow the instructions in the README file on the
Windows 3.0 printer driver disk to install the HP
LaserdJet 4 printer driver. If your printer is in the PCL
language, you can print these instructions by typing the
following at a DOS prompt:

1. Insert disk into drive A:
2. At your DOS prompt type A: to get an A prompt.

3. At the A prompt type COPY README PRN, then
press [Enter].

If the [Form Feed] light on the printer’s control panel
stays on after the README file has printed, more data is
in the print buffer. To print the remaining data in the
print buffer use the following steps:

1. Press and release the [On Line] key to take the
printer offline.

2. Press and release the [Form Feed] key to print the
data in the print buffer, then press and release the
[On Line] key to put the printer back online.

Microsoft Windows version3.0 1-9




General
Information

Adding Fonts

Using AutoFont Support

Selecting Cartridge Fonts
and Typefaces

The following information is applicable to most of the
software you are likely to use with Windows 3.0 and the
HP Laserdet 4 printer. Read this information carefully; it
will help you avoid the common problems discussed later
in this application note.

The procedure you will follow to add cartridge fonts
depends upon whether the cartridge font support already
exists in Windows, or if you must obtain PCM files or use
AutoFont support. (See the “Installing Bitmapped and
Scalable Font Cartridges” section of this note.)

If your fonts came with AutoFont Support disks, use the
instructions accompanying the font product to install the
AutoFont Support files. Then, follow the instructions
given in this note for installing bitmapped and scalable
font cartridges or disk-based scalable typefaces.

Use the following steps to select a bitmapped cartridge
font or a scalable typeface cartridge font. If you do not
find your font listed, you need to install support files for
your font by following the instructions in the “Installing
Bitmapped and Scalable Font Cartridges” section of this
note.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Select HP Laserdet 4 on (port)., Active.
Choose the CONFIGURE button.
Choose the SETUP button.

Click on the arrow keys on the right of the Cartridges
list box to scroll through the list of available font and
scalable typeface cartridges. To select a cartridge,
highlight the cartridge name. You can select one font
cartridge for your HP Laserdet 4 printer.

8. Choose the OK button three times.
9. Press [ALTI1[F4] to close the Control Panel.

0o gtk w
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Installing Bitmapped and  If you do not find your cartridge font product listed in the
Scalable Font Cartridges  Cartridges list box, add support for your cartridge by
installing either PCM files or Autofont Support files.

PCM'’s are Printer Cartridge Metrics files that contain
font information for bitmapped font cartridges. These files
support cartridges that are not supported by the latest
version of the Windows driver.

AutoFont Support files are files that contain information
to enable Windows 3.0 to add driver support for the
cartridge. AutoFont Support files are on disks which
accompany your cartridge font.

If you have a Hewlett-Packard scalable typeface cartridge
which does not appear on the list of available cartridges,
exit Windows and install the AutoFont support files for
your scalable cartridge. Refer to the note, Installing HP
Scalable Typefaces, which came with your cartridge.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Select HP Laserdet 4 on (port):, Active.
Choose the CONFIGURE button.
Choose the SETUP button.

Choose the FONTS button.

Choose the ADD FONTS button.

Insert the disk that contains your PCM files
(cartridge font support files) in drive A: (or type in the
directory where your AutoFont support files reside;
for example, C:\AUTOFONT) and choose the OK
button.

© X ;e

10. The name of your cartridge will appear in the box on
the right side of the screen.

11. Select the cartridge you wish to install by
highlighting the cartridge name.

12. Choose the ADD button.

13. You will be asked where you want your fonts copied
(default is C:\PCLFONTS). Accept the default or type
in a different directory name and choose the OK
button.
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If the directory you selected does not exist, Windows
will ask if you want it to be created. Choose the OK
button.

14. Choose the EXIT button.

15. The new cartridge will be listed in the Cartridges list
box in the Printer Setup dialog box.

16. Scroll through the list of available font cartridges. To
select your new cartridge, highlight the cartridge
name. You may select one font cartridge for your HP
Laserdet 4 printer.

17. Choose the OK button three times.
18. Press [ALTI1[F4] to exit Control Panel.

Installing Disk-based  If you want to use disk-based bitmapped fonts or
Bitmapped Fonts and  disk-based scalable typefaces in an application, you need
Scalable Typefaces  to use the HP Font Installer to add printer driver support
for your fonts. Use the following steps to install your
disk-based bitmapped fonts or disk-based scalable

typefaces:
".l If you are installing a disk-based scalable typeface, and
Note # you are not using Intellifont for Windows, you need to

install the AutoFont Support files for your scalable
typefaces. Refer to the documentation which shipped with
your scalable typefaces for instructions.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the MAIN menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.

Select HP LaserdJet 4 printer on Port:, Active.
Choose the CONFIGURE button.

Choose the SETUP button.

Choose the FONTS button.

Choose the ADD FONTS button.

Insert the disk that contains your soft font files in
drive A, or type the directory and path where your

© =2 e 0w
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Downloading Fonts as
Permanent

AutoFont files are loaded (the default is
C:\AUTOFONT), and choose the OK button.

10. Afont, or list of fonts, available for installation will
appear in the box on the right side of the screen.

11. Select the fonts you wish to install by highlighting
each font.

12. Choose the ADD button.

13. You will be asked where you want your fonts copied.
(The default is C:\PCLFONTS.) Accept the default or
type in a different directory name and choose the OK
button.

14. Afier the font is installed, it will appear in the box on
the left side of the screen. Windows 3.0 will assign
the font a temporary status by default. If you want
Windows to download your fonts as permanent, see
the “Downloading Fonts as Permanent” section of
this note.

15. Choose the EXIT button, then choose the OK button
three times.

16. Press [ALTI[F4] to close the Control Panel.

Disk-based fonts (soft fonts) and typefaces can be either
permanent or temporary.

Windows assigns disk-based fonts and typefaces
temporary status by default. This means they will be
automatically downloaded by Windows 3.0 with each
print job. The benefit of temporary downloading is that
you need not be concerned with what fonts or typefaces
are currently resident in the printer. The disadvantage of
using temporary downloading is that fonts or typefaces
need to be downloaded before each print job, thereby
increasing print time.

If you consistently use the same group of fonts or
typefaces, you can designate them as permanent.
Permanent fonts and typefaces are stored in your
printer’s memory until the printer is turned off (switching
into PostScript mode will also delete permanent fonts and
typefaces). The benefit of using permanent downloading is
that you won’t have to wait to download fonts and
typefaces before printing jobs throughout the day.

To select fonts and typefaces as permanent, use the HP
Font Installer window.
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1. From the Windows PROGEAM MANAGER menu,
open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Select HP Laserdet 4 on (port):, Active.
Choose the CONFIGURE button.
Choose the SETUP button.

Choose the FONTS button.

Select the font or typeface you want to download to
the printer by highlighting its name (only one font
can be selected at a time for permanent
downloading). Once you have highlighted a font or
typeface, the options Permanent and Temporary
become available for selection.

e A

9. Select the Permanent option button, choose the OK

button in the First permanent font box, then choose
the EXIT button.

A Download options dialog box will be displayed, and
you will be asked to choose either Download now, or
Download at startup. Select the option you want by
clicking on the appropriate option box. If you do not
mark either option, no fonts or typefaces will be
downloaded to the printer.

If you select Download at startup, each time you
re-boot or power-on your computer, the fonts or
typefaces will be downloaded. Make sure that your
printer is powered on and is on line before re-booting
your computer. The HP Font Installer will add a
batch file (BAT) to your AUTOEXEC.BAT file. A DOS
prompt appears asking you to confirm whether you
want to download the fonts or typefaces. If you
answer yes, they will be downloaded and a sample
will be printed. Remember when you start your
computer, it will take additional time to download the
soft fonts. The number of fonts you can download at
one time depends upon the amount of memory you
have in your printer.

You can also use the HP Font Installer to change the

download status of a font or typeface by using the
EDIT button or by highlighting the font or typeface
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and selecting the permanent. or temporary option
button.

10. Choose the OK button four times.
11. Press [ALTI][F4] to close the Control Panel.

Using Print Manager  Print Manager is a software spooler that Windows uses to
free up the computer after a job is sent to the printer. If
Print Manager is on, print speed can be significantly
reduced. Windows prints to the spooler, then the spooler
sends the job to the printer. This two-step process may
double the print time.
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Common
Problems In
Windows

HP LaserJet 4 Printer

Does Not Show Up In
Windows Options

Out of Memory Error
Message

ERROR 20 Displayed on
Printer Control Panel

This section provides a troubleshooting approach to
solving common problems associated with using Windows
3.0 with the HP LaserdJet 4 printer.

If the option for the HP Laserdet 4 Printer does not show
up in Windows, check the following:

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

. Double-click on the PRINTERS icon.

. Select HP Laserdet 4 on (port):, Active.
. Choose the CONFIGURE button.

. Choose the SETUP button.

. Click on the arrow to the right of the Printer
drop-down list box. This is the only place that the HP
Laserdet 4 printer will show up. If it is there, click on
it, then choose the OK button to save your selection.
If the HP Laserdet 4 option is not there, reinstall
your printer driver (see the “Installing a Printer
Driver” section of this note). Call Hewlett-Packard
Distribution at (303) 3537650 (Monday through
Friday, 7 AM to 6 PM, MST) to receive a free copy of
the most current driver; or if you are a member of
CompuServe, you can download the driver from one
of the libraries on the HP Peripherals Forum.

[\]
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If a Windows out of memory error occurs, do the following:

1. Close all unnecessary applications to free additional
memory.

2. If you are running any RAM resident programs (for
example, Sidekick or any screen saver program),
remove them from memory and reboot your computer.

If your printer displays a 20 MEM OVERFLOW message
on its control panel when printing a document, you will
need to add additional memory to the printer or reduce
the graphics resolution of the document being printed.
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To reduce the graphics resolution of your document, follow
these steps:

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

3. Double-click on the PRINTERS icon.
4. Choose the SETUP button.

5. Choose the 300 dpi option button in the Printer
Memory box.

6. Choose the OK button.
7. Choose the CLOSE button.
8. Press [Alt][F4] to close Control Panel.

Font Does Not Print  If the font that you have selected in your Windows
application does not print:

1. Check to make sure you actually have the font you
selected. If it is not a font that is internal to the HP
Laserdet 4 printer, make sure that you have a
cartridge or soft font that supports it.

2. If your font is on a cartridge, take your printer offline,
remove the cartridge, and reinsert it in the printer.
Give the cartridge a firm push until you hear it click
into place. Put the printer back online and print
again. If the document still prints in the wrong font,
follow these steps to print a PCL TYPE LIST:

a. Press and release the [On Line] key to take the
printer offline.

b. Press and release the [Menu] key until TEST
MENU is displayed.

¢. Press and release the [Item] key until PCL
TYPE LIST is displayed, then press the [Enter]
key to print the list.

The PCL TYPE LIST will give you a printout of
all the fonts the printer has available. If the
cartridge fonts do not appear on the TYPE LIST
printout, the cartridge may be damaged or still
not inserted properly.
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3. If you are using a disk-based font, make sure it is in
the proper directory to be downloaded. Read the
“Downloading Fonts as Temporary or Permanent”
section of this note, and make sure your fonts are
selected as temporary if you want Windows to
download them each time you print your document or
permanent, if you have downloaded them before
printing. If you have downloaded the font as
permanent, before printing, take the printer offline
and generate a PCL TYPE LIST (instructions given
in paragraph #2, above); this TYPE LIST will show
all the fonts the printer has available. If the font does
not appear on the printout, it will have to be
downloaded again.

Other Problems  If you are having other types of problems, or if the
suggestions provided in this section have not resolved the
problem:

1. Read the “General Information” section of this
application note.

2. Try printing similar documents. Is the problem
isolated to one document? If so, find and delete
invalid or misplaced format selections in the problem
document.

3. Repeat the installation procedures.

4. Refer to your software documentation or see other
software support information on support services
available. (See the “Additional Support Numbers for
Windows Applications” section of this note.)

Calling for Help  Call Hewlett-Packard’s Customer Support Center. Our
trained technicians will be happy to help you with your
printing needs.

Telephone . . . . .. ... ... ... ... (208) 323-2551
Hours (Mon, Tues,Thur,Fri) . . . . .. 7 AM to 6 PM, MST
Wednesdays . ... .......... 7 AM to 4 PM, MST

When you call Hewlett-Packard, call from a phone next to
your computer and HP LaserJet 4 printer. Assisting you
often requires access to your printer and Windows
document.
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PageMaker
version 4.0

Note 3

Common Tasks

Page Formatting

A
Note Ui

Selecting Fonts

Aldus Corporation Technical Support
Aldus Corporation Customer Support . . (206) 628-2040

Required Identification . ... ... .. Serial Number
Hours . . ... ............. 7 AM-5 PM PST
Charge ... ... ..... ... . ...... see Note

For registered PageMaker owners there are 90 days of
free technical support from Aldus. Contact Aldus for more
information on extended technical support contracts.

This section of the Windows 3.0 note is designed to help
you perform some of the common tasks associated with
PageMaker 4.0.

Page formatting features in PageMaker are selected from
the Page Setup menu which is displayed when you open a
new document, or can be accessed by selecting the File
menu and choosing Page Setup. To create a new document:

1. Select the FILE menu.

2. Choose NEW. From this menu you can select Page
Size, Orientation, and Margins. Page Size options for
the HP LaserdJet 4 printer are Letter, Legal, Tabloid,
and Custom.

You can choose the orientation of your page by
selecting the option button for Za/l (Portrait) or Wide
(Landscape).

Margins can be changed easily by highlighting the
margin you want to change and typing in the new
margin.

All Page Setup options must match Target Printer options
or your document will not print properly.

A font can be selected before typing text, or the current
font can be changed for existing text. The following
instructions apply to changing the font for existing text.

1. To highlight text on your page, select the Text Tool
from the Tbol Box. Position the Text Tool in front of
the first character of the text that you want to
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change. Click and hold the left mouse button and
drag the Text Tool to the end of the text.

2. Select the TYPE menu.
3. Choose the TYPESPECS command. PageMaker will

list all of the typefaces available to you, including
internal fonts, cartridge fonts, soft fonts, and Type
Director fonts in the Font drop-down list box.

Select the typeface you want to use by clicking on the
arrow to the right of the Font drop-down list box.
Select the point size from the list of point sizes shown
in the Size drop-down list box, or type in a size from 4
to 650 points in .1 point increments. If you have
selected a bitmapped font, like the internal Courier
or Line Printer or a font on a non-scalable cartridge,
the listed sizes are the only sizes available. If you
have selected a scalable typeface, like the internal
CG Times or Univers, the sizes shown are only a
small sample of the sizes available. If you wish to use
a size that is not listed, highlight the Size box and
type in the point size you want.

Note

".l Although the HP LaserdJet 4 printer can scale fonts from
. .25 to 999.75 points, PageMaker 4.0 only supports from 4

to 650 points in .1 point increments.

5.

Type Style, Position, and Case choices can also be
made at this menu by clicking on the desired option.

. Choose the OK button to save changes and return to

your document.

Printing on Legal-Size = Follow these steps to use legal size paper.

Paper 1

. Select the FILE menu.
2.
3.

Choose the NEW command.

Click on the down arrow key to the right of the Page
drop-down list box to display Page-size options.

Select LEGAL as your page size.

5. Select the option button next to the orientation you

want to use; TALL (portrait), or WIDE (landscape).

. Margins can be changed easily by highlighting the

margin you want to change and typing in the new
margin,
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Note Jﬂ

Printing Reverse Text

7. Choose the OK button.
8. Select the FILE menu.
9. Choose the Target Printer command.

10. Highlight the printer you wish to change and choose
the SETUP button.

11. Click on the arrow key to the right of the Paper Size
drop-down list box to display paper sizes available

12. Select LEGAL as your Paper Size.

13. Select the option button next to the orientation you
selected in the Page Setup menu.

All Page Setup options must match Printer Setup options
or your document will not print properly.

14. Select MANUAL FEED as your Paper Source if you
do not have a legal-size paper tray. If you do have a
legal-size paper tray, select the appropriate tray as
your Paper Source.

15. Choose the OK button twice to return to your
document.

To print reverse text (white print on a shaded
background), first create a shaded box or circle as your
background. You can use any shade as a background when
printing reverse text.

Creating the Background:

1. Select the Square Drawing Tool from the Toolbox.
(The Rounded Corner or Circle Drawing Tools can be
substituted for the Square Drawing Tool.)

2. Move the mouse to the point on the page where you
want to position the top left corner of the background.

3. Click and hold the left mouse button.

4. Drag the mouse down and to the right to the position
where you want to place the lower right corner of the
background.

Release the left mouse button.
Select the ELEMENT menu.

Choose the FILL command.
Select the desired fill for your background.

o N >
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Selecting Reverse Type:

1.
2.

e A

9.

Select the Text Tool (A) from the Tbolbox.

Move the mouse to the position on the page where
you want the text to begin, then click the left mouse
button.

Select the Type menu.

Choose the TYPE SPECS command.
Select the Font and Size.

Set Color to Paper.

Select the Reverse check box.
Choose the OK button two times.
Type in your text.

Turning Off Reverse Type:

1.
2.
3.

Select the Type menu.
Choose the Type Style command.
Choose the Normal command.

Rotating Text T print in different directions on the page, follow these
steps:

1.
2,

© N S; oW

Select the Text Thol (A) from the Thol Box.

Move the I-Beam to the left side of the page and click
the left mouse button.

Type text.

Select the Pointer from the Tbol Box.
Click on the text you wish to rotate.
Select ELEMENT.

Select Text rotation.

The Text rotation dialog box will appear enabling you
to rotate text in 90-degree increments by choosing
one of the four icons.

After choosing the Text rotation desired, choose the
OK button.

".| You can rotate text in layout view only. You cannot rotate
Note # text while it is opened in the Story Editor; however, you

can edit the text in story view once it has been rotated.
You can rotate any text that occupies a single text block,
is not part of a threaded story, and does not contain any
in-line graphics.
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Printing Special
Characters

A
Note '.'ﬂ

Common Problems

Screen Fonts Appear
Jagged

ERROR 20 Displayed on
Printer Control Panel

If you are using an HP LaserJet 4 printer internal font,
you can print characters available in the Windows 3.1
Latin 1 Symbol Set in PageMaker by holding down the
[Alt] key and pressing @ (zero) on the numeric keypad
followed by the three-digit decimal equivalent of the
character you wish to print. Refer to “Appendix B” in the
HP LaserJet 4 and 4M Printers User’s Manual for an
illustration of the Windows 3.1 Latin 1 Symbol Set and its
decimal equivalents.

Windows applications default to the Windows 3.1 Latin 1
Symbol Set. The characters in this set are the only ones
that can be used unless you have installed and selected a
font that specifically states that it uses a different symbol
set (for example, Math-8, Roman-8).

1. If you are using Intellifont for Windows, make sure its
status is ON by double-clicking on the icon and
checking STATUS.

2. If your screen fonts look jagged only in PageMaker,
check the Stretch Text Above & Vector Text Above
settings and make the following changes.

a. Before you open a document, from the
PageMaker main window, select the EDIT menu.

. Choose the PREFERENCES command.

. Choose the OTHER button.

. Highlight Stretch text above field and type in 600.
e. Highlight Vector text above field and type in 600.
f. Choose the OK button twice.

e T

jol

If your printer displays a 20 MEM OVERFLOW message
on its control panel when printing a document, you will
need to add additional memory to the printer or reduce
the graphics resolution of the document being printed.

You can change graphics resolution by selecting FILE,
Target Printer, Setup, Printer Resolution, and choosing
300 dpi or 600 dpi.
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Microsoft Excel
version 3.0a

Common Tasks

Page Setup

Changing Margins,
Headers or Footers:

Changing the Printer
Setup

Microsoft Corporation Technical Support
Microsoft Excel . . . .. .. ... ... (206) 635-7070

1. Select the FILE menu.
2. Choose the PAGE SETUP command.

Paper Size, Orientation, Document Header and Footer,
and Margins can be changed in the Page Setup dialog box.

To change pvaper size, click on the down arrow to the right
of the Paper Size drop-down list box and highlight your
new selection. If paper size is grayed out, see “Cannot
Select Paper Size in Page Setup” in the “Common
Problems” section of this note.

1. Move the mouse to the beginning of the line.

2. Click and hold the left mouse button.

3. Drag the mouse to the end of the line.

4. Type in a new Margin, Header or Footer.
After all changes are made, choose the OK button to
return to your document.

If you need to make changes to your printer setup (for
example, change the graphics resolution) follow these
steps:

1. Select the FILE menu.

Choose the PRINTER SETUP command.
Select the printer you wish to change.
Choose the SETUP button.

Choose the OK button.

S

Select the Printer, Paper Source (for example, manual
feed, upper tray, lower tray), Orientation and
Graphics Resolution. You can also change settings for
Memory, Cartridge Fonts, Gray Scale, Copies and
Page Protection.

6. Select OK twice to return to your document.
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Selecting Fonts 1. Select the FORMAT menu.
2. Choose the FONT command.

3. Make sure that there is an X in the Printer Fonts
check box. If there is no X, click on the box.

TR If you do not have an X in the Printer Fonts check box,
Note # you will be given a list of raster and stroke fonts. These
fonts generally do not look as clean as printer fonts and
they usually take longer to send to the printer. By
selecting the Printer Fonts check box, you will get a list of
internal, cartridge, and soft fonts that you have available
to you. In addition, you will receive three stroke fonts
(Modern, Roman, and Script).

4. Select typeface.

5. Select the point size in the Size list box. If you are
using a scalable font and do not see the point sizes
that you want, highlight the box where the point
sizes appear and type in the size you want (from 1 -
409 points).

6. If you want to change the style of the font that you
are using, select Bold, Italic, Underline, or Strikeout
in the appropriate Style check box.

7. Choose the OK button.
Printing on Legal-size 1. Select the FILE menu.

Paper Choose the PAGE SETUP command.

3. Click on the arrow to the right of the Paper Size
drop-down list box. Select Legal 8 1/2 x 14 in.

bo

4. Choose Orientation by selecting the option button
next to Portrait or Landscape.

Choose the OK button.

Select the FILE menu.

Choose the PRINTER SETUP command.
Choose the Setup button.

Choose the OK button.

10. Click on the arrow keys to the right of the Paper
Source drop-down list box to scroll through the
available options. If you do not have a legal-size
paper tray, or you do not want to configure the MP
tray to a legal page size, select Manual feed.

© 0 N o o
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Jd
Note '.'ﬂ

Printing Special
Characters

N |
Note '.'ﬂ

Common Problems

Out of Memory Error
Message

ERROR 20 Displayed on

Printer Control Panel

11. Choose the OK button twice to return to your
document.,

If you select number of copies from the PRINT dialog box,
Excel will send the print job that many times. If you
select number of copies in PRINTER SETUP, Excel will
send the copies command directly to the printer and your
documents will print much faster.

If you are using an HP LaserdJet 4 printer internal font,
you can print characters available in the Windows 3.1
Latin 1 Symbol Set in Excel 3.0a by holding down the
[Alt] key and pressing @ (zero) on the numeric keypad
followed by the three-digit decimal equivalent of the
character you wish to print. Refer to “Appendix B” in the
HP Laserdet 4 and 4M Printers User’s Manual for an
illustration of the

Windows 3.1 Latin I Symbol Set and its decimal
equivalents.

Windows applications default to the Windows 3.1 Latin 1
Symbol Set. The characters in this set are the only ones
that can be used unless you have installed and selected a
font that specifically states that is uses a different symbol
set (for example, Math-8, Roman-8).

If an out of memory error occurs while using Windows,
you will need to do the following:

1. Close all unnecessary applications to free memory.

2. If you are running any RAM resident programs
(Sidekick, for example), remove them from memory
and reboot your computer.

If your printer displays a 20 MEM OVERFLOW message
on its control panel when printing a document, you will
need to add additional memory to the printer or reduce
the graphics resolution of the document being printed.

You can change graphics resolution by selecting FILE,
Printer Setup, Setup, OK, Printer Resolution, and
choosing 300 dpi or 600 dpi.
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Cannot Select Fit to Page
or Enlarge/Reduce

Jd
Note '.'ﬂ

Cannot Select Paper Size
in Page Setup

Other Problems

Both the Fit To Page and Reduce and Enlarge features in
the spreadsheet are available only in PostScript and not
with the PCL driver. However, the PCL driver can use Fit
to Page when printing a chart.

Fit to Page and Reduce and Enlarge are available with
the PCL driver in Excel 4.0.

If paper size is grayed out, you will need to check the
following:

Check your driver version in Windows by going into
Control Panel - Printers - Configure - Setup - About. You
need driver version 30.1.04 or later. You must also have
Excel version 3.0a. Tb obtain the update to Excel version
3.0a, contact Microsoft Corporation End User Sales at
(800) 4269400.

As an interim solution, you can go into Windows and from
the Main Window enter Control Panel, Printers, choose
Configure, then go into Setup to make the paper size
selection before entering MS Excel 3.0.

If you are having other types of problems, or if the
suggestions provided in this section have not resolved the
problem:

1. Read the Windows Software Application Note.

2. Try printing similar documents. Is the problem
isolated to one document? If so, find and delete
invalid or misplaced format selections in the problem
document.

3. Repeat the driver installation procedures.

4. Refer to the Microsoft Excel documentation or see
other software support information about support
services available.
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WordPerfect
version 5.1 for
Windows

WordPerfect’s Bulletin
Board Service (BBS)

Selecting a Printer
Driver

Note '.'é

WordPerfect Corporation Technical Support

WordPerfect Printer Support . . . . . . (800) 228-1023
Installation . ... ... ........ (800) 228-6076
Feature Support . ... ... ... .. (800) 228-1029
Network Support . . .. ........ (800) 228-6066
Graphics Support . . . . . ... .. .. (800) 228-6013

Hours .. ... .......... 7 AM to 6 PM MST
Charge . . . ... .. ... . ... .. ... ... None
Required Identification . . . . . . . . License Number
Ordering Printer Disk Updates . . . . (800)222-9409

If you have a modem, you can download printer drivers
free from the WordPerfect bulletin board by calling the
number designated for your modem type.

BBS IBM (Baud 1200 - 2400) . . . . . . (801) 225-4414
BBS High Speed (Baud 9600 - 38400) . (801) 225-4444
BBS 68000 (Baud 1200 -2400) . . . . . (801) 226-1605
BBS Unix (Baud 1200 - 2400) . . . .. (801) 228-9909

If you have questions or need help in using WordPerfect’s
BBS, call the following number for information.

WordPerfect BBS Support . . . .. .. (801) 228-9904

The information and procedures contained in this
document apply to WordPerfect for Windows version 5.1.

WordPerfect for Windows allows you to use the printer
driver written by WordPerfect Corporation or the
Windows printer driver that all other Windows
applications use. The following steps allow you to choose
the WordPerfect printer driver or the Windows printer
driver.

1. Select the File menu.
2. Choose the Select Printer command.

3. Select the Word Perfect option button, or the Windows
option button, in the Printer Drivers list box.

4. Choose the Select button.

If you choose the Windows option button, you must have
installed an HP LaserdJet 4 printer driver in Windows 3.0.
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Installing a Printer Driver  To install the WordPerfect printer driver, follow these
(WordPerfect Driver)  steps:

1. Select the File menu.

2. Choose the Select Printer command.

3. Choose the Add button.

4. Select the HP LaserJet 4 printer and choose the Add

button. -
Computer 5. Choose the OK button.
om
. Museum 6. Choose the HP Laserdet 4 and choose the Select
’ button.

If the HP LaserJet 4 printer is not listed, you can get the
driver by calling HP Distribution at (303) 353-7650 or
WordPerfect Corporation at (800) 222-9409, If you are a
member of CompuServe, you can download the driver
from the HP Peripherals Forum.

ChoosingaPort  The default configuration in WordPerfect for Windows for
(WordPerfect Driver)  the HP Laserdet 4 printer is parallel. However, if you use
a serial port, complete the following steps:

1. Select the File menu.
2. Choose the Select Printer command.

3. Select the HP LaserdJet 4 printer and choose the
Setup button.

4. Select your port from the Port: drop-down list box.
Installing a Sheet Feeder  To make the most of your HP LaserJet 4 printer’s paper

(WordPerfect Driver)  feed options, you should install a sheet feeder. Complete
the following steps to install the sheet feeder:

1. Select the File menu.
2. Choose the Select Printer command.

3. Select the HP Laserdet 4 printer, then choose the
Setup button.

4. Choose the Sheet Feeder button, then use the arrow
keys to scroll through the list of sheet feeders. Select
the sheet feeder option for the HP Laserdet 4 printer.

5. Choose the Select button.
6. Choose the OK button.

7. Choose the Select button.
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Installing Fonts

Installing Fonts  If you have a cartridge or soft font, you need to select
(WordPerfect Driver)  drivers for these fonts in WordPerfect.

“.| Note If you are using the Windows printer driver, see
Note ﬂ “Adding Fonts” under the “General Information” section
of the Windows note.

Use the following steps to select drivers for your fonts.

1.

ok~ » b

© ® 2>

10.

11.

12.

Select the File menu.

Choose the Select Printer command.
Select the WordPerfect option button.
Choose the Setup button.

If you are installing a driver for a soft font, type in
the name of the directory where your soft font files
are kept in the Path for Downloadable Fonts and
Printer Commands: box.

Choose the Cartridges/Fonts button.
Select Cartridges or Soft Fonts.
Choose the Select button.

If you are installing a Cartridge, select your cartridge
from the list, choose the OK button, choose the
CLOSE button, then go to step 15.

If you are installing a soft font, highlight the name of
your soft font group, then choose the Select button.

Use the arrow keys to the right of the Select Fonts list
box to scroll through the font list, and select your font.

If you are selecting soft fonts, be sure to mark one of
the option boxes Present When Print Job Begins or
Can be Loaded / Unloaded During Job.

If you choose Present When Print Job Begins, the font
will be downloaded as permanent and will remain in
printer memory until the printer is powered off or
receives a specific command to delete the font from
memory.

If you choose Can be Loaded / Unloaded During Job,
the font will be assigned a temporary status and will
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Installing Fonts
(Windows Driver)

Common Tasks

Selecting Paper Size

Font Selection

Creating Forms
(WordPerfect Driver)

be downloaded when needed instead of remaining in
printer memory.

13. Choose the OK button, then choose the CLOSE
button.

14. Choose the Close button again.

15. Choose the OK button.

16. Choose the Update button, then choose the CLOSE
button.

If you are using the Windows printer driver, install fonts
according to the instructions in the “Adding Fonts”
section of this application note.

Select the Layout menu.

Choose the Page command.

Choose the PAPER SIZE command.
Select a paper size for your document.
Choose the SELECT button.

S

If you are using the Windows printer driver, the only page
size available will be the size selected in the Printer Setup
dialog box. If you are using the WordPerfect driver, at the
Paper Size screen highlight the page size you need and
choose the Select button.

The following steps select a font using the Font dialog
box. Fonts can also be selected in other ways. See your
WordPerfect user’s documentation for instructions.

Select the Font menu.

Choose the Font command.

Select the font and point size you want.
Choose the OK command.

Lol

Select the Layout menu.

Choose Page command.

Choose the Paper Size command.
Choose the Add button.

Ll
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5. Inthe Add Paper Size dialog box, select Paper Type,
Paper Size, Text Adjustments, Paper Orientation,
Paper Location and Print Options. When all
selections have been made, choose the OK button.

6. Highlight the form you have created and choose the
Select button.

Printing in Landscape
Orientation (WordPerfect
Driver)

Select the Layout menu.
Choose the Page command.

Choose the Paper Size command.

Ll

Select the Standard 11" x 8.5" paper size from the
Paper Size list box.

Choose the Select button.

6. Select the FILE menu, choose the PRINT command,
then choose the PRINT button to print your
document.

o

Printing in Landscape
Orientation (Windows
Driver)

Select the File menu.
Choose the SELECT PRINTER command.
Choose the Setup button.

Ll

Click on the arrow next to the Paper Source drop
down list box.

5. Select the paper tray you want to use, or select the
Manual option.

6. Choose the Landscape option button.
7. Choose the OK button.

8. Select the FILE menu, choose the PRINT command,
then choose the PRINT button to print your
document.

Printing on Legal-Sized Select the Layout menu.
Paper (WordPe.rfect Choose the Page command.
Driver)

Choose the Paper Size command.

Ll

Select the Legal 8.5" x 14" paper size from the Paper
Size list box.

If you have the universal paper tray (set to legal
paper size), or have configured the MP Tray to legal
paper size, edit the form to change the location to
continuous; otherwise select the Manual option. Page
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Printing on Legal-size
Paper (Windows Driver)

Printing on COM-10
Envelopes (WordPerfect
Driver)

orientation (portrait or landscape) should also be
selected on this screen.

5. Choose the SELECT button.
6. Select the FILE menu, choose the PRINT command,

then choose the PRINT button to print your
document.

Select the File menu.
Choose the Select Printer command.
Choose the Setup button.

Click on the arrow to the right of the Paper Size
drop-down list box. Select Legal 8 1/2 x 14 in.

Click on the arrow next to the Paper Source
drop-down list box.

If you have the universal paper tray set to legal or the
MP Tray configured for legal page size, select the
appropriate paper tray. If you do not have the
universal paper tray set to legal paper size or do not
plan to configure the MP Tray to legal paper size,
select the Manual option.

7. Choose the appropriate orientation option button.
8. Choose the OK button, then choose the CLOSE

button.

Select the FILE menu, choose the PRINT command,
then choose the PRINT button to print your
document.

Select the Layout menu.
Choose the Page command.
Choose the Paper Size command.

Highlight the Envelope 9.5" x 4" option. Check the
Location column to make sure it is set to the paper
location you need (for example, Manual or
Continuous). Choose Continuous if you have the
optional envelope feeder or have configured the MP
Tray for a Com-10 envelope paper size.

5. Choose Select.

6. Choose the Margin command, then set the following

margins:

Microsoft Windows version 3.0 1-33




Top 2"
Bottom 1"
Left 4"
Right 1"

7. Select the FILE menu, choose the PRINTcommand,
then choose the PRINT button to print your
document.

Printing on COM-10
Envelopes (Windows
Driver)

1. Select the File menu.

2. Choose the SELECT PRINTER command.
3. Choose the Setup button.
4

. Click on the arrow to the right of the Paper-Size
drop-down list box. Select Com-1041/8x91/2 in.

5. Click on the arrow next to the Paper Source
drop-down list box.

6. Select Envelope if you have the optional envelope
feeder or have configured the MP Tray for a Com-10
envelope paper size. Select the Manual option if you
are manually feeding your envelopes.

7. Choose the Landscape orientation option button, then
choose the OK button

8. Select the Layout Menu
9. Choose the Margin command, then set the following

margins:
rIbp 2"
Bottom 1"
Left 4"
Right 1"

10. Select the FILE menu, choose the PRINTcommand,
then choose the PRINT button to print your
document.

Dual-Bin Printing
{(WordPerfect’s Driver) 1. First select a sheet feeder (see the “Installing a Sheet
Feeder” section of this note).

2. Create a form for each bin you want to use (see the
“Creating a Form” section of this note).

3. Place the cursor at the top of the page you want
printed from a specific bin.

1-34 Microsoft Windows version 3.0



Select the Layout menu.
Choose the Page command.

Choose the Paper Size command.

-

Select the form with the bin you want to use, then
choose the select button.

J Dual-Bin Printing is not supported with the Windows
Note “# Driver

Printing Special  If you need characters not accessible from your keyboard,
Characters  WordPerfect will allow you to print these characters using
the WP Characters command on the Font menu.

1. Position your cursor where you want the special
character to appear.

2. Select the Font menu.
3. Choose the WP Characters command.

4. Click on the arrow keys in the Set drop-down list box
to display the options available, then select the
character set containing the character needed.

5. Select the character you want by clicking on it.

6. Choose the Insert or Insert and Close button.

Special Features  The following special features are supported only with the

WordPerfect driver.
Printing Reverse Text 1. Select the Graphics menu.
(White Text on a Black 2. Choose the User Box command.
Background)
3. Choose the Options command.
4. Choose 100% gray shading by clicking on the up

arrow button next to the Percent text box, then choose
the OK button.

Select the Graphics menu.
Choose the User Box command.

Choose the Create command.

® =N, ;

Select the Text Editor option button, then choose the
OK button.

9. Select the Font menu, then choose the Font command.
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10.

11.
12.
13.

14.

Select Font and Point Size from the list boxes, then
choose the OK button.

Select the Font menu,
Choose the Color command.

Click on and hold the double arrow button in the
Predefined Colors drop-down list box. While holding
down the right mouse button, move the selection
cursor until White is highlighted; release the mouse
button, then choose the OK button.

Type text, then choose the CLOSE button.

".l If you want to see white text on the black background,
Note # Text in Windows System Colors must not be selected. This
option is found under File, Preferences, Display.

Printing Rotated Text = Text rotation is available in WordPerfect for Windows
using the User or Text Box feature (rotated text will print,
but will not appear on the screen).

1.

Select the Graphics menu.

2. Choose the User Box command.
3.
4. Select the Text Editor option button, then choose the

Choose the Create command.

OK button.

Choose the Box Position and Size button, and make
appropriate selections, then choose the OK button.

6. Choose the Rotate button.

7. Select the appropriate option button, then choose the

OK button.

8. Select the Font menu.

9. Choose the Font command.

10.

11.

12,
13.

Select the Font and Point Size you want, then choose
the OK button.

Choose the Box Position button. At the Box Position
and Size dialog box, make any selections you want for
Box Type, Anchor, Size, Vertical Position or Horizontal
Position, then choose the OK button.

Type text.
Choose the OK button, then choose the Close button.
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Graphics Quality Setting
(WordPerfect Driver)

Common Problems

ERROR 20 Displayed on
Printer Contro! Panel

Select the FILE menu.
Choose the PREFERENCES command.
Choose the PRINT command.

Change the Graphics Quality setting in the Document
Settings box.

5. Choose the OK button.

Ll

If your printer displays a 20 MEM OVERFLOW message
on its control panel when printing a document, you will
need to either add additional memory to the printer or
reduce the graphics resolution of the document being
printed.

If you are using WordPerfect’s printer driver, see the
“Graphics Quality Setting (WordPerfect Driver),” section
of this note for instructions about changing graphics
resolution. If you are using the Windows printer driver,
change graphics resolution by selecting: FILE, Print
Setup, Setup, Printer Resolution, then choosing either 300
dpi or 600 dpi.

Microsoft Windows version3.0 1-37



Word for Microsoft Corporation
; i Microsoft Word for Windows
Windows version Customer Support . . . . . . . .. .. (206) 462-9673

2.0

Common Tasks

Printer Setup Select the File menu.
Choose the Print Setup command.
Select the printer you wish to change.

Choose the Setup button.

B o

Use this menu to select the Printer, Paper Source,
Paper Size, Orientation, Number of Copies, and
Graphics Resolution. You can also change settings for
Memory, Cartridge Fonts, and Page Protection if you
have not already done so.

5. Choose the OK button twice to return to your
document.

Selecting Fonts  You can change the font before typing in the text or
highlight a selected portion of the text and then select a
font in one of two ways:

Font Name/Point Size (on the document screen ribbon
bar):

1. Click on the down arrow following the font field.

Microsoft Word will list all of the typefaces available
to you, including internal fonts, installed cartridge
and soft fonts, and Type Director fonts.

2. Select the font you want.

3. Move the mouse to the points field and click on the
down arrow.

If you have selected a bitmapped font, like the internal
Courier or Line Printer, or a non-scalable cartridge/soft
font, the listed sizes are the only sizes available. If you
have selected a scalable font, like the internal CG Times
or Univers, the sizes shown are only a small sample of the
sizes available. If the size you want is not listed, highlight
the points box and type in the point size you want
(between 4 and 127).
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“J Although the HP LaserJet 4 printer can scale fonts from
Note ﬂ .25 to0 999.75 points, Microsoft Word for Windows only
supports from 4 to 127 points in .5 point increments.

Format Character (on the menu bar):
1. Select the Format menu.

Choose the Character command.

Click on the down arrow following the Font field.
Select the font you want.

Move the mouse to the Points field and click on the
down arrow.

ouok

Once again, if you have selected a bitmapped font,
select from the listed sizes. If you have selected a
scalable typeface, you can highlight the Point Size
box and type in a point size between 4 and 127.

While in the CHARACTER dialog box you can also
select font attributes, including bold, italic and bold
italic. '

6. Choose the OK button to return to your document.

Document Format 1. Select the Format menu.

2. Choose the Page Setup command.

At the Printer Setup screen, you can change Margins,
Paper Size, Orientation, and Paper Source.
After all changes are made, select the OK button to
return to your document.
. Select the FORMAT menu.
. Choose the PAGE SETUP command.

Printing on LegaI-Sized 1
2
3. Choose the Size and Orientation option button.
4

Paper

. Click on the down arrow following the Paper Size
field.

5. Select Legal 81/2 x 14 in.

6. Select the Landscape or Portrait option button under
Orientation.

1. Select the Paper Source option button.

Microsoft Windows version3.0 1-39



8. Select a tray from the First Page list box if you have

the universal paper tray or the MP Tray is configured
to legal paper size. Select Manual Feed from the First
Page list box if you do not have a legal-size paper tray.

TR Check your HP Laserdet 4 printer user’s manual for
Note # instructions about setting the MP tray size.

9. Select the appropriate option in the Other Pages list

box.

10. Choose the OK button to return to your document.

Printing on COM-10  Manually fed envelopes can be printed by using the
Envelopes  Envelope icon on the Tbolbar.

Envelopes can be printed automatically from the MP tray
or the optional envelope feeder by making the following
changes:

1.

o4

Select the TOOLS menu.

2. Choose the OPTIONS command.
3.
4. Select the Printer’s Envelope Feeder has been

Select the Print icon.

Installed check box.
Choose the OK button.

6. Select the ENVELOPE button on the Tbolbar. The

Dual-Bin Printing

inside address for the letter will show up in the
Addressed Tb box. You can either accept this address,
or type in another address.

If you want to print a return address on the envelope,
type the address in the Return Address box.

Select the Format menu.

Choose the Page Setup command.

Select the Paper Source option button.

In the First Page list box, highlight the tray which
contains your cover sheet or letterhead.

In the Other Pages list box, highlight the tray which
contains regular paper.
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Printing Special  You can print special characters in Word for Windows by
Characters  following these steps:

1. Select the INSERT menu.
2. Choose the SYMBOL command.

3. Select the symbol set you want from the Symbols
From: drop-down list box.

4. Select the symbol you want, then choose the OK
button.

Common Problems

ERROR 20 Displayed on  If your printer displays a 20 MEM OVERFLOW message
Printer Control Panel  on its control panel when printing a document, you will
need to add additional memory to the printer or reduce
the graphics resolution of the document being printed.

You can change graphics resolution by selecting FILE,
Print Setup, Setup, Printer Resolution, and choosing 300
dpi or 600 dpi.
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About This This chapter is designed to assist you in setting up and

Chapter using MS Windows 3.1 with your HP Laserdet 4 printer and
to guide you generally through the use of Windows 3.1
applications.

Because most Windows 3.1 applications use the HPPCL5E
printer driver, once you install the printer driver, you are
ready to print from any Windows application. Additionally,
the instructions for paper handling, printer configuration,
and font and typeface installation are identical in most
Windows 3.1 applications. This chapter provides specific
instructions for these common tasks.

This chapter also includes detailed information about using
PageMaker 4.0, Microsoft Excel 3.0a, WordPerfect for Win-
dows 5.1, and Word for Windows 2.0 with the HP LaserdJet
4 printer. These instructions can be used as a guide for
other Windows 3.1 software. For information on selecting
printer features through your Windows 3.1 software appli-
cations, consult your software documentation or contact
your software company. '

Additionally, HP provides Software Application Notes for
selected software packages. These notes are available
through the following distribution sources:

HP First FAX  If you would like to have a list of drivers and Software
Retrieval System Application Notes faxed to you:

1. Dial (800) 333-1917 from any touch-tone telephone.
2. Select (1) for HP FIRST.

3. Follow the voice prompts that guide you to select an
index or to enter a document ID number for product
information.

When you have selected all the documents you want,
you will be prompted to enter the telephone number
of the receiving FAX machine.

After HP FIRST acknowledges your documents are
ready, the system will dial the telephone number of
the FAX machine you selected, and the documents
you requested will be sent.

“.l The time required to receive your information will vary
Note # depending on the length or complexity of the documents
you requested.
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Hewlett-Packard  Application notes and drivers are available for selected

Distribution  software packages through Hewlett-Packard Distribution.
Call (303) 353-7650 for information (Monday through
Friday, 7 AM to 6 PM, MST).

CompuServe If you are a member of CompuServe, you can download

Software Application Notes and software drivers from the
HP Peripherals Forum.
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Microsoft
Corporation

Additional Support
Numbers for
Windows
Applications

Microsoft Corporation Customer Support

Windows Technical Support . . . . .. (206) 637-7098
Microsoft Programs and DOS . . . . . (206) 454-2030
Hours . ... .. ......... .. 6 AM - 6 PM PST
Required Identification . . . . . .. ... ... .. None
Charge . . . . . . . . .. .. ... .. None

(Charge for DOS support after 90 days)

CorelDraw . .. ............ (613) 728-1990
Harvard Graphics for Windows . . . . (408) 988-4005
Lotus 1-2-3 for Windows . . . . .. .. (617)253-9150
Micrografx Designer . . .. ... ... (214) 234-2694
Microsoft Excel . . . .. ... ... .. (206) 635-7070
Microsoft Word for Windows . . . . . . (206) 462-9673
Microsoft Works for Windows . . . . . (206) 635-7130
Aldus PageMaker . . . . ... ... .. (206) 628-2040
Aldus Persuasion . . .. .. ... ... (206) 628-2040
Microsoft Powerpoint . . . . .. .. .. (206) 635-7145
WordPerfect for Windows . . . . . . .. (800) 228-1023
Quark XPress . . ... ... ...... (303) 894-8899

For information about Microsoft support and warranty
policies, refer to Microsoft documentation.

Product upgrade policies and procedures: To
upgrade your current version of Microsoft Windows, call
Microsoft Customer Service at (800) 426-9400. If you are
in the USA or Canada, you can order upgraded printer
drivers for the HP LaserdJet family of printers by calling
Hewlett-Packard Distribution at (303) 353-7650; for all
other countries, contact your HP dealer. If you are a
member of CompuServe, you will find current drivers
available on the HP Peripherals Forum.
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Supported Fonts and

Typefaces

Cartridge Fonts 92286
AB,C,D.EFGH,ICJKLMN,P
PC,Q,R,TUVWWI1, X)Y,ZZ1a

Cartridge Fonts 92290...
S1,82
Cartridge Fonts C2053A...

C01,C02,C03,C04,C05,C06,C07,

C08,C09
Cartridge Fonts C2055A...
co1

Disk-based Fonts...All Hewlett-
Packard LaserJet
Disk-based Fonts

Type Director 2.0...
All Typefaces

Scalable Disk-based Typefaces...
All Typefaces

Cartridge Fonts C20508B...
C80,C90
Cartridge Fonts C2050C...
C80,C90

Support for most HP 92286 and 92290 fonts does not
come with Windows. (Windows does come with support for
the HP 922861C, 92286PC, and 922867 cartridges.) For
support with cartridges other than these three, you will
need to get the PCM files, or AutoFont Support files.
These can be downloaded from the HP Peripherals Forum
on CompuServe or ordered from Hewlett Packard at (303)
353-7650. See the “Installing Bitmapped and Scalable
Font Cartridges” section of this note for information about
installing PCM’s and using AutoFont Support.

Windows Printer
Setup

The information in this section describes how to set up
Windows 3.1 for use with an HP Laserdet 4 printer in
PCL mode.

The procedures in this document assume that Windows is
already installed and operating.

Verifying the Windows
Driver Version

Follow these steps to verify the version of the Windows
3.1 printer driver you are using.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program Window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Highlight HP LaserdJet 4 on (port):.
Choose the SETUP button.

Choose the ABOUT button. This screen will tell you
which version of the printer driver you have. If you
do not have an HP LaserJet printer driver, call

IS I A
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Hewlett-Packard Distribution at (303) 353-7650 to
receive a free copy of the most current driver.

7. Tb exit, choose the OK button twice, then choose the
CLOSE button.

8. Press [ALTI][F4] to exit Control Panel.

Installing a Printer  Follow the instructions in the README file on the
Driver Windows 3.1 updated printer driver disk to install the HP
LaserdJet 4 printer driver. You can print these instructions
by typing the following at a DOS prompt:

1. Insert disk into drive A:
2. At your DOS prompt type A: to get an A prompt.

3. At the A prompt type COPY README PRN, then
press [Enter].

If the [Form Feed] light on the printer’s control panel
stays on after the README file has printed, more data is
in the print buffer. To print the remaining data in the
print buffer use the following steps:

1. Press and release the [On Line] key to take the
printer offline.

2. Press and release the [Form Feed] key to print the
data in the print buffer, then press and release the
[On Line] key to put the printer back online.

“.l Any HP LaserdJet 4 printer you have previously installed

Note e will use the new PCL 5 printer driver and
Hewlett-Packard Font Installer. Remove through the
Control Panel any HP Laserdet 4 printer entries that are
not needed.

Deleting a Printer 1. From the Windows PROGRAM MANAGER menu,
Driver open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Highlight the printer that you wish to delete.
Choose the REMOVE button.

You will be asked if you want to remove the printer.

S A

Choose the YES button to remove the printer driver.
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Changing Printer  After installing your LaserJet 4 printer driver, you might
Defaults  need to change your printer default settings. Use the
following steps to change the printer driver’s default
setting.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the MAIN menu, double-click on the CONTROL
PANEL icon to open Control Panel.

3. Double-click on the PRINTERS icon.
4. Highlight the name of the printer you wish to change.

5. Choose the CONNECT button. At the Connect dialog
box, you can choose which printer port you are using
by selecting LPT'1, LPT2, COM1, FILE, for example.

".I For more information about selecting ports and default
v time-out periods, consult your Microsoft Windows User’s
Guide.

Note

6. Choose the SETUP button.

7. You can change many of your printing options in the
Setup dialog box. You can select the Paper Source,
Paper Size, Printer Memory, Orientation, and
Graphics Resolution. (You will lose any disk-based
fonts which have been downloaded when you switch
between 300 and 600 dpi.)

The Page Protection option also appears in the
Printer Setup dialog box. This setting, in combination
with the Memory box setting, tells the printer driver
how much of the memory available in the printer it
can use,

Choose the OPTION button to select type of Gray
Scale. Choose the FONT button to enter the HP Font
Installer to add bitmapped disk-based fonts, scalable
disk-based font, and unlisted cartridge support. (See
“Adding Fonts"later in this note).
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Note '.'ﬂ

Adding PostScript
Support

Turning Language
Switching On

The Options dialog box in the Windows Control Panel
allows you to choose Photographic Images, Line Art
Images, or HP Scandet Images. For an improved
photographic appearance, select Photographic Images.
Your image will have smooth, soft looking contrasts
between shades of gray. Images originally designed with
color will also print better.

For images that have a line draw look, such as clip art,
select Line Art Images. The HP Scandet Images option is
specially tuned for scanned images from an HP Scandet to
give exceptional quality and clarity to the printed images.
This method uses a variation of the Photographic Images
method. You might want to try printing your graphics
from more than one of the gray scale printing methods.

8. Once you have changed all of the options for the
features you want to use in the setup box, choose the
OK button, then choose the CLOSE button.

9. Press [ALT][F4] to close the Control Panel.

The following instructions describe how to install
PostScript support in Windows 3.1 for your HP LaserJet 4
printer.

If you want to print in PostScript mode to an HP LaserdJet
4 printer, you can either select the PostScript personality
on the printer’s control panel, or you can set the printer
for automatic language switching so it will distinguish
between PostScript and PCL and switch to the
appropriate language for the current job. The following
steps will set up the printer for automatic language
switching:

1. Press and release the [On Line] key to take the
printer offline.

2. Press the [Menu] key repeatedly until JOB MENU is
displayed on the printer.

3. Press the [Item] key repeatedly until the printer
displays

PERSONALITY=(PCL, PS or AUTO)*
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Installing a PostScript
Printer Driver

4. If the display does not read PERSONALITY=AUTO*
press the [+] key repeatedly until the printer displays:

PERSONALITY=AUTO
5. Press the [Enter] key to save the change. You will see:

PERSONALITY=AUTO*

6. Press the [On Line] key to put the printer back
online.

Follow the instructions in the README file on the
Windows 3.1 Driver disk to install the Laserdet 4 printer
driver. If the printer is in the PCL language, you can print
these instructions by typing the following at a DOS
prompt:

1. Insert disk into drive A:
2. At the DOS prompt type A: to get an A prompt.

3. At the Aprompt type COPY README PRN, then
press [Enter].

If the [Form Feed] light on the printer’s control panel
stays on after the README file has printed, more data is
in the print buffer. To print the remaining data in the
print buffer use the following steps:

1. Press and release the [On Line] key to take the
printer offline.

2. Press and release the [Form Feed] key to print the
data in the print buffer, then press and release the
[On Line] key to put the printer back online.
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General
Information

Adding Fonts

Using AutoFont Support

Selecting Cartridge Fonts
and Typefaces

The following information is applicable to most of the
software you are likely to use with Windows 3.1 and the
HP Laserdet 4 printer. Read this information carefully; it
will help you to avoid many of the common problems
discussed later in this application note.

The procedure you will follow to add cartridge fonts
depends upon whether Windows already supports your
cartridge, or if you need to obtain PCM files or use
AutoFont Support to add support for the cartridge.

If your fonts came with AutoFont Support disks, use the
instructions accompanying the font product to install the
AutoFont Support files. Then, follow the instructions
given in this note for installing bitmapped and scalable
font cartridges or disk-based scalable typefaces.

Use the following steps to select a bitmapped cartridge
font or a scalable typeface cartridge font. If you do not
find your font listed, you need to install support files for
your font by following the instructions in the “Installing
Bitmapped and Scalable Font Cartridges” section of this
note.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window,

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Select HP LaserdJet 4 on (port).
Choose the SETUP button.

Click on the arrow keys on the right of the Cartridges
list box to scroll through the list of available font and
scalable typeface cartridges. To select a cartridge,
highlight the cartridge name. You can select one font
cartridge for your HP Laserdet 4 printer.

7. Choose the OK button, then choose the CLOSE
button.

8. Press [ALTI[F4] to close the Control Panel.

S gk
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Installing Bitmapped and  If you do not find your cartridge font product listed in the
Scalable Font Cartridges  Cartridges list box, add support for your cartridge by
installing either PCM files or Autofont Support files.

PCM’s are Printer Cartridge Metrics files that contain
font information for bitmapped font cartridges. These files
are used to support cartridges that are not supported by
the latest version of the Windows driver.

AutoFont Support files are files that contain information
which enables Windows 3.1 to add driver support for the
cartridge. AutoFont Support files are on diskettes which
accompany your cartridge font.

If you have a Hewlett-Packard scalable typeface cartridge
which does not appear on the list of available cartridges,
exit Windows and install the AutoFont support files for
your scalable cartridge. Refer to the note Installing HP
Scalable Typefaces, which came with your cartridge.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Select HP LaserdJet 4 on (port).

. Choose the SETUP button.

Choose the FONTS button.

. Choose the ADD FONTS button.

Insert the disk that contains your PCM files
(cartridge font support files) in drive A: (or type in the
directory where your AutoFont support files reside;
i.e., CN\AUTOFONT) and choose the OK button.

9. The name of your cartridge will be displayed in the
box on the right side of the screen.

p .Computer
L Museum

I

10. Select the cartridge you wish to install by
highlighting the cartridge name, then choose the
ADD button.

11. You will be asked where you want your fonts copied
(default is C:\PCLFONTS). Accept the default or type
in a different directory name, then choose the OK
button.
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12. When the copy process is complete, choose the EXIT
button. The new cartridge will be listed in the
Cartridges list box in the Printer Setup dialog box.

13. Scroll through the list of available font cartridges. To
select your new cartridge, highlight the cartridge
name. You can select one font cartridge for your HP
Laserdet 4 printer.

14. Choose the OK button, then choose the CLOSE
button.

15. Press [ALTI[F4] to exit Control Panel.

Installing Disk-based  If you want to use disk-based bitmapped fonts or
Bitmapped Fonts and  disk-based scalable typefaces in an application, you need
Scalable Typefaces  to use the HP Font Installer to add printer driver support
for your fonts, Use the following steps to install your
disk-based bitmapped fonts or disk-based scalable

typefaces.
“.l If you are installing a disk-based scalable typeface, and
Note g you are not using Intellifont for Windows, you need to

install the AutoFont Support files for your scalable
typefaces. Refer to the documentation which shipped with
your typefaces for instructions.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the MAIN menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Select HP LaserdJet 4 printer on (Port)..
Choose the SETUP button.

Choose the FONTS button.

Choose the ADD FONTS button.

Insert the disk that contains your soft font files in
drive A:, or type the directory and path where your
AutoFont files are loaded (the default is
C:\AUTOFONT), then choose the OK button.

9. Afont, or list of fonts, available for installation will
appear in the box on the right side of the screen.
10. Select the fonts you wish to install by highlighting
each font.

11. Choose the ADD button.

© N o
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Downloading Fonts as
Permanent

12. You will be asked where you want your fonts copied.
(The default is C:\PCLFONTS.) Accept the default or
type in a different directory name and choose the OK
button.

13. After the font is installed, it will appear in the box on
the left side of the screen. Windows 3.1 will assign
the font a temporary status by default. If you want
Windows to download your fonts as permanent, see
the “Downloading Fonts as Permanent” section of
this note.

14. Choose the EXIT button, the OK button, then the
CLOSE button.

15. Press [ALTI[F4] to close the Control Panel.

Disk-based fonts (soft fonts) and typefaces can be either
permanent or temporary.

Windows assigns disk-based fonts and typefaces temporary
status by default. This means they will be automatically
downloaded by Windows 3.1 with each print job. The benefit
of temporary downloading is that you need not be concerned
with what fonts or typefaces are currently resident in the
printer. The disadvantage of using temporary downloading
is that fonts or typefaces need to be downloaded before each
print job, thereby increasing print time.

If you consistently use the same group of fonts or
typefaces, you can designate them as permanent.
Permanent fonts and typefaces are stored in your
printer’s memory until the printer is turned off (switching
into PostSeript mode or changing the the printer
resolution between 300 and 600 dpi will also delete
permanent fonts and typefaces). The benefit of using
permanent downloading is that you won't have to wait to
download fonts and typefaces before printing jobs
throughout the day.

To select fonts and typefaces as permanent, use the HP
Font Installer window.

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

Double-click on the PRINTERS icon.
Select HP Laserdet 4 on (port):..
Choose the SETUP button.

Choose the FONT'S button.

SN S
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7. Select the font or typeface you want to download to
the printer by highlighting its name (only one font
can be selected at a time for permanent
downloading). Once you have highlighted a font or
typeface, the options Permanent and Temporary
become available for selection.

8. Select the Permanent option button, choose the OK
button in the First permanent font box, then choose
the EXIT button.

A Downrload options dialog box will be displayed, and
you will be asked to choose either Download now, or
Download at startup. Select the option you want by
clicking on the appropriate option box. If you do not
mark either option, no fonts or typefaces will be
downloaded to the printer.

If you select Download at startup, each time you
re-boot or power-on your computer, the fonts or
typefaces will be downloaded. Make sure that your
printer is powered on and is on line before re-booting
your computer. The HP Font Installer will add a
batch file ( BAT) to your AUTOEXEC.BAT file. A DOS
prompt appears asking you to confirm whether you
want to download the fonts or typefaces. If you
answer yes, they will be downloaded and a sample
will be printed. Remember when you start your
computer, it will take additional time to download
your soft fonts. The number of fonts you can
download at one time depends upon the amount of
memory you have in your printer.

You can also use the HP Font Installer to change the
download status of a font or typeface by using the
EDIT button or by highlighting the font or typeface
and selecting the permanent or temporary option
button.

9. Choose the OK button twice, then choose the CLOSE
button.

10. Press [ALTI[F4] to close the Control Panel.

Using Print Manager Print Manager is a software spooler that Windows uses to
free up the computer after a job is sent to the printer. If
Print Manager is on, print speed can be significantly
reduced. Windows prints to the spooler, then the spooler
sends the job to the printer. This two-step process may
double the print time.
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]
Common
Problems In
Windows

HP LaserJet 4 Printer
Does Not Show Up In
Windows Options

Out of Memory Error
Message

ERROR 20 Displayed on
Printer Control Panel

This section provides a troubleshooting approach to
solving many of the common problems associated with
using Windows 3.1 with the HP LaserdJet 4 printer.

If the option for the HP Laserdet 4 Printer does not show
up in Windows, check the following:

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

3. Double-click on the PRINTERS icon.

If the HP Laserdet 4 option is not listed in the
Printers list box, reinstall your printer driver (see the
“Installing a Printer Driver” section of this note). Call
Hewlett-Packard Distribution at (303) 353-7650
(Monday through Friday, 7 AM to 6 PM, MST) to
receive a free copy of the most current driver; or if
you are a member of CompuServe, you can download
the driver from one of the libraries on the HP
Peripherals Forum.

If a Windows out of memory error occurs, do the following:

1. Close all unnecessary applications to free additional
memory,.

2. If you are running any RAM resident programs (for
example, Sidekick, or any screen-saver program),
remove them from memory and reboot your computer.

If your printer displays a 20 MEM OVERFLOW message
on its control panel when printing a document, you will
need to add additional memory to the printer or reduce
the graphics resolution of the document being printed.

To reduce the graphics resolution of your document, follow
these steps:

1. From the Windows PROGRAM MANAGER menu,
open the MAIN program window.

2. From the Main menu, double-click on the CONTROL
PANEL icon to open Control Panel.

3. Double-click on the PRINTERS icon.
4. Choose the SETUP button.
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5. Choose the 300 dpi option button in the Printer
Memory box.

6. Choose the OK button.
7. Choose the CLOSE button.
8. Press [Alt][F4] to close Control Panel.

Font Does Not Print  If the font that you have selected in your Windows
application does not print:

1. Make sure you actually have the font you selected. If
the font you want to use is not a printer internal font,
make sure the font is on a cartridge or available as a
soft font.

2. If your font is on a cartridge, take your printer offline,
remove the cartridge, and reinsert it in the printer.
Give the cartridge a firm push until you hear it click
into place. Put the printer back online and print
again. If the document still prints in the wrong font,
follow these steps to print a PCL TYPE LIST:

a. Press and release the [On Line] key to take the
printer offline.

b. Press and release the [Menu] key until TEST
MENU is displayed.

¢. Press and release the [Item] key until PCL
TYPE LIST is displayed, then press the [Enter]
key to print the list.

The PCL TYPE LIST will give you a printout of
all the fonts the printer has available. If the
cartridge fonts do not appear on the TYPE LIST
printout, the cartridge may be damaged or still
not. inserted properly.

3. If you are using a disk-based font, make sure it is in
the proper directory to be downloaded. Read the
“Downloading Fonts as Temporary or Permanent”
section of this note, and make sure your fonts are
selected as temporary if you want Windows to
download them each time you print your document or
permanent if you have downloaded them before
printing. If you have downloaded the font as
permanent before printing, take the printer offline
and generate a PCL TYPE LIST (instructions given
in paragraph #2, above); this TYPE LIST will show
all the fonts the printer has available. If the font does
not appear on the printout, it will have to be
downloaded again.
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Other Problems  If you are having other types of problems, or if the
suggestions provided in this section have not resolved the
problem:

1. Read the “General Information” section of this
application note.

2. Try printing similar documents. Is the problem
isolated to one document? If so, find and delete
invalid or misplaced format selections in the problem
document,

3. Repeat the installation procedures.

4. Refer to your software documentation or see other
software support information about support services
available. (See the “Additional Support Numbers for
Windows Applications” section of this note.)

Calling for Help  Call Hewlett-Packard’s Customer Support Center. Our
trained technicians will be happy to help you with your
printing needs.

Telephone . . ... ... .......... (208) 323-2551
Hours (Mon, Tues, Thur, Fri) . . . . . 7 AM to 6 PM, MST
Wednesdays . . ............ 7 AM to 4 PM, MST

When you call Hewlett-Packard, call from a phone next to
your computer and HP LaserJet 4 printer. Assisting you
often requires access to your printer and Windows
document.
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PageMaker
version 4.0

Note '3

Common Tasks

Page Formatting

d
Note UJ

Selecting Fonts

Aldus Corporation Technical Support
Aldus Corporation Customer Support . (206) 628-2040

Required Identification . . . . . .. .. Serial Number
Hours .. ................ 7 AM-5 PM PST
Charge . . . . ... ... ... .. ... .... see Note

For registered PageMaker owners there are 90 days of
free technical support from Aldus. Contact Aldus for more
information on extended technical support contracts.

This section of the Windows 3.1 note is designed to help
you perform some of the common tasks associated with
PageMaker 4.0.

Page formatting features in PageMaker are selected from
the Page Setup menu which is displayed when you open a
new document, or can be accessed by selecting the File
menu and choosing Page Setup. To create a new document:

1. Select the FILE menu.

2. Choose NEW. From this menu you can select Page
Size, Orientation, and Margins. Page Size options for
the HP LaserdJet 4 printer are Letter, Legal, Tabloid,
and Custom.

You can choose the orientation of your page by
selecting the option button for Tall (Portrait) or Wide
{Landscape).

Margins can be changed easily by highlighting the
margin you want to change and typing in the new
margin.

All Page Setup options must match Target Printer options
or your document will not print properly.

Afont can be selected before typing text, or the current
font can be changed for existing text. The following
instructions apply to changing the font for existing text.

1. To highlight text on your page, select the Text Tool
from the Tbol Box. Position the Text Tbol in front of
the first character of the text that you want to
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“.I
Note .ﬂ

Printing on Legal-Size
Paper

2.
3.

4.

change. Click and hold the left mouse button and
drag the Text Tool to the end of the text.

Select the TYPE menu.

Choose the TYPESPECS command. PageMaker will
list all of the typefaces available to you, including
internal fonts, cartridge fonts, soft fonts, and Type
Director fonts in the Font drop-down list box.

Select the typeface you want to use by clicking on the
arrow to the right of the Font drop-down list box.
Select the point size from the list of point sizes shown
in the Size drop-down list box, or type in a size from 4
to 650 points in .1 point increments. If you have
selected a bitmapped font, like the internal Courier
or Line Printer or a font on a non-scalable cartridge,
the listed sizes are the only sizes available. If you
have selected a scalable typeface, like the internal
CG Times or Univers, the sizes shown are only a
small sample of the sizes available. If you wish to use
a size that is not listed, highlight the Size box and
type in the point size you want.

Although the HP Laserdet 4 printer can scale fonts from
.25 t0 999.75 points, PageMaker 4.0 only supports from 4
to 6560 points in .1 point increments.

5.

6.

Type Style, Position, and Case choices can also be
made at this menu by clicking on the desired option.

Choose the OK button to save changes and return to
your document.

Follow these steps to use legal size paper.

1.
2.
3.

Select the FILE menu.
Choose the NEW command.

Click on the down arrow key to the right of the Page
drop-down list box to display Page-size options.

Select LEGAL as your page size.

5. Select the option button next to the orientation you

want to use; TALL (portrait), or WIDE (landscape).

. Margins can be changed easily by highlighting the

margin you want to change and typing in the new
margin.
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7. Choose the OK button.
8. Select the FILE menu.

9. Choose the Target Printer command.

10. Highlight the printer you wish to change and choose
the SETUP button.

11. Click on the arrow key to the right of the Paper Size
drop-down list box to display paper sizes available

12. Select LEGAL as your Paper Size.

13. Select the option button next to the orientation you
selected in the Page Setup menu.

M All Page Setup options must match Printer Setup options
Note # or your document will not print properly.

14. Select MANUAL FEED as your Paper Source if you
do not have a legal-size paper tray. If you do have a
legal-size paper tray, select the appropriate tray as
your Paper Source.

15. Choose the OK button twice to return to your
document.

Printing Reverse Text  Tb print reverse text (white print on a shaded
background), first create a shaded box or circle as your
background. You can use any shade as a background when
printing reverse text.

Creating the Background:

1. Select the Square Drawing Tool from the Tbolbox.
(The Rounded Corner or Circle Drawing Tools can be
substituted for the Square Drawing Tbol.)

2. Move the mouse to the point on the page where you
want to position the top left corner of the background.

3. Click and hold the left mouse button.

4. Drag the mouse down and to the right to the position
where you want to place the lower right corner of the
background.

Release the left mouse button.

Select the ELEMENT menu.

Choose the FILL command.

Select the desired fill for your background.

© =N o
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Selecting Reverse Type:

1.
2.

P NSO W

9.

Select the Text Tool (A) from the Tholbox.

Move the mouse to the position on the page where
you want the text to begin, then click the left mouse
button.

Select the Type menu.

Choose the TYPE SPECS command.
Select the Font and Size.

Set Color to Paper.

Select the Reverse check box.
Choose the OK button two times.
Type in your text.

Turning Off Reverse Type:

1.
2.
3.

Select the Type menu.
Choose the Type Style command.
Choose the Normal command.

Rotating Text  To print in different directions on the page, follow these
steps:

Note

1.
2.

e Al

Select the Text Thol (A) from the Thol Box.

Move the I-Beam to the left side of the page and click
the left mouse button.

Type text.

Select the Pointer from the Tbol Box.
Click on the text you wish to rotate.
Select ELEMENT.

Select Text rotation.

The Text rotation dialog box will appear enabling you
to rotate text in 90-degree increments by choosing
one of the four icons.

After choosing the Text rotation desired, choose the
OK button.

You can rotate text in layout view only. You cannot rotate
text while it is opened in the Story Editor; however, you
can edit the text in story view once it has been rotated.
You can rotate any text that occupies a single text block,
is not part of a threaded story, and does not contain any
in-line graphics.
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Printing Special  You can print special characters in PageMaker by using
Characters the Windows Character Map. Character Map allows you
to select and copy special characters to the clipboard,
then these characters can be pasted into a document in a
Windows application. Look for additional information
about using Character Map in the Windows user’s guide.

If you are using an HP LaserdJet 4 printer internal font,
characters available in the Windows 3.1 Latin 1 Symbol Set
can be printed in PageMaker by holding down the [Alt] key
and pressing J (zero) on the numeric keypad followed by the
three-digit decimal equivalent of the character you wish to
print. Refer to “Appendix B” in the HP LaserJet 4 and 4M
Printers User’s Manual for an illustration of the Windows
3.1 Latin 1 Symbol Set and its decimal equivalents.

".l Windows applications default to the Windows 3.1 Latin 1
Note # Symbol Set. The characters in this set are the only ones
that can be used unless you have installed and selected a
font that specifically states that it uses a different symbol
set (for example, Math-8, Roman-8).

Common Problems

Screen Fonts Appear 1. If you are using Intellifont for Windows, make sure its
Jagged status is ON by double-clicking on the icon and
checking STATUS.

2. If your screen fonts look jagged only in PageMaker,
check the Stretch Text Above & Vector Text Above
settings and make the following changes.

a. Before you open a document, from the PageMaker
main window, select the EDIT menu.

. Choose the PREFERENCES command.

Choose the OTHER button.
. Highlight Stretch text above field and type in 600.
. Highlight Vector text above field and type in 600.
Choose the OK button twice.

o o0 o

ERROR 20 Displayed on  If your printer displays a 20 MEM OVERFLOW message
Printer Control Panel  onits control panel when printing a document, you will
need to add additional memory to the printer or reduce
the graphics resolution of the document being printed.

You can change graphics resolution by selecting FILE,
Target Printer, Setup, Printer Resolution, and choosing
300 dpi or 600 dpi.

2-22 Microsoft Windows version 3.1



Microsoft Excel
version 3.0a

Common Tasks

Page Setup

r-Computer
. Museumt

Changing Margins,
Headers or Footers:

Changing the Printer
Setup

Microsoft Corporation Technical Support
Microsoft Excel . . . . . . . ... .. .. (206) 635-7070

1. Select the FILE menu.
2. Choose the PAGE SETUP command.

Paper Size, Orientation, Document Header and Footer,
and Margins can be changed in the Page Setup dialog box.

To change paper size, click on the down arrow to the right
of the Paper Size drop-down list box and highlight your
new selection. If paper size is grayed out, see “Cannot
Select Paper Size in Page Setup” in the “Common
Problems” section of this note.

1. Move the mouse to the beginning of the line.

2. Click and hold the left mouse button.

3. Drag the mouse to the end of the line.

4. Type in a new Margin, Header or Footer.
After all changes are made, choose the OK button to
return to your document.

If you need to make changes to your printer setup (for
example, change the graphics resolution) follow these
steps:

1. Select the FILE menu.

Choose the PRINTER SETUP command.
Select the printer you wish to change.
Choose the SETUP button.

Choose the OK button.

IS

Select the Printer, Paper Source (for example, manual
feed, upper tray, lower tray), Orientation and
Graphics Resolution. You can also change settings for
Memory, Cartridge Fonts, Gray Scale, Copies and
Page Protection.

6. Select OK twice to return to your document.
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Selecting Fonts 1. Select the FORMAT menu.
2. Choose the FONT command.

3. Make sure that there is an X in the Printer Fonts
check box. If there is no X, click on the box.

".l If you do not have an X in the Printer Fonts check box,

Note ﬂ you will be given a list of raster and stroke fonts. These
fonts generally do not look as clean as printer fonts and
they usually take longer to send to the printer. By
selecting the Printer Fonts check box, you will get a list of
internal, cartridge, and soft fonts that you have available
to you. In addition, you will receive three stroke fonts
(Modern, Roman, and Script).

4. Select typeface.

5. Select the point size in the Size list box. If you are
using a scalable font and do not see the point sizes
that you want, highlight the box where the point
sizes appear and type in the size you want (from 1 -
409 points).

6. If you want to change the style of the font that you
are using, select Bold, Italic, Underline, or Strikeout
in the appropriate Style check box.

7. Choose the OK button.

Printing on Legal-size 1. Select the FILE menu.

Paper 2. Choose the PAGE SETUP command.

3. Click on the arrow to the right of the Paper Size
drop-down list box. Select Legal 8 1/2 x 14 in.

4. Choose Orientation by selecting the option button
next to Portrait or Landscape.

Choose the OK button.

Select the FILE menu.

Choose the PRINTER SETUP command.
Choose the Setup button.

Choose the OK button.

10. Click on the arrow keys to the right of the Paper
Source drop-down list box to scroll through the
available options. If you do not have a legal-size
paper tray, or you do not want to configure the MP
tray to a legal page size, select Manual feed.

© XN ew;
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11. Choose the OK button twice to return to your
document.

“.l If you select number of copies from the PRINT dialog box,

Note # Excel will send the print job that many times. If you
select number of copies in PRINTER SETUP, Excel will
send the copies command directly to the printer and your
documents will print much faster.

Printing Special  You can print special characters in PageMaker by using
Characters  the Windows Character Map. Character Map allows you
to select and copy special characters to the clipboard,
then these characters can be pasted into a document in a
Windows application. Look for additional information
about using Character Map in the Windows user’s guide.

If you are using an HP Laserdet 4 printer internal font,
characters available in the Windows 3.1 Latin 1 Symbol
Set can be printed in Excel 3.0a by holding down the [Alt]
key and pressing @ (zero) on the numeric keypad followed
by the three-digit decimal equivalent of the character you
wish to print. Refer to “Appendix B” in the HP LaserJet 4
and 4M Printers User’s Manual for an illustration of the

Windows 3.1 Latin 1 Symbol Set and its decimal

equivalents.
“.l Windows applications default to the Windows 3.1 Latin 1
Note # Symbol Set. The characters in this set are the only ones

that can be used unless you have installed and selected a
font that specifically states that is uses a different symbol
set (for example, Math-8, Roman-8).

Common Problems

Out of Memory Error  If an out of memory error 6ccurs while using Windows,
Message  you will need to do the following:

1. Close all unnecessary applications to free memory.

2. If you are running any RAM resident programs
(Sidekick, for example), remove them from memory
and reboot your computer.

ERROR 20 Displayed on  If your printer displays a 20 MEM OVERFLOW message
Printer Control Panel  on its control panel when printing a document, you will
need to add additional memory to the printer or reduce
the graphics resolution of the document being printed.
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You can change graphics resolution by selecting FILE,
Printer Setup, Setup, OK, Printer Resolution, and
choosing 300 dpi or 600 dpi.

Cannot Select Fitto Page  Both the Fit To Page and Reduce and Enlarge features in
or Enlarge/Reduce  the spreadsheet are available only in PostScript and not
with the PCL driver. However, the PCL driver can use Fit
to Page when printing a chart.

".l Fit to Page and Reduce and Enlarge are available with
Note P  the PCL driver in Excel 4.0.

Cannot Select Paper Size  If paper size is grayed out, you will need to check the
in Page Setup  following:

Check your driver version in Windows by going into
Control Panel - Printers - Configure - Setup - About. You
need driver version 3.77 or later. You must also have
Excel version 3.0a. Tb obtain the update to Excel version
3.0a, contact Microsoft Corporation End User Sales at
(800) 4269400.

As an interim solution, you can go into Windows and from
the Main Window enter Control Panel, Printers, choose
Configure, then go into Setup to make the paper size
selection before entering MS Excel 3.0.

Other Problems  If you are having other types of problems, or if the
suggestions provided in this section have not resolved the
problem:

1. Read the Windows Software Application Note.

2. Try printing similar documents. Is the problem
isolated to one document? If so, find and delete
invalid or misplaced format selections in the problem
document.,

3. Repeat the driver installation procedures.

4. Refer to the Microsoft Excel documentation or see
other software support information about support
services available.
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]
WordPerfect
version 5.1 for
Windows

WordPerfect’s Bulletin
Board Service (BBS)

Selecting a Printer
Driver

WordPerfect Corporation Technical Support

WordPerfect Printer Support . . . . . . (800) 228-1023
Installation . . . ... .......... (800) 228-6076
Feature Support . . . .. .. ... ... (800) 228-1029
Network Support . . . .. .. ... ... (800) 228-6066
Graphics Support . . . .. ... ... .. (800) 228-6013

Hours .. ............. 7 AM to 6 PM MST
Charge .. .. .. .. ... .. . ... ...... None
Required Identification . .. .. ... License Number
Ordering Printer Disk Updates . . . . . (800) 222-9409

If you have a modem, you can download printer drivers
free from the WordPerfect bulletin board by calling the
number designated for your modem type.

BBS IBM (Baud 1200 -2400) . . .. .. (801) 225-4414
BBS High Speed (Baud 9600 - 38400) . . (801) 225-4444
BBS 68000 (Baud 1200 - 2400) . . . .. (801) 226-1605
BBS Unix (Baud 1200 - 2400) . . . . . . (801) 228-9909

If you have questions or need help in using WordPerfect’s
BBS, call the following number for information.

WordPerfect BBS Support . . . . .. .. (801) 228-9904

The information and procedures contained in this
document apply to WordPerfect for Windows version 5.1.

WordPerfect for Windows allows you to use the printer
driver written by WordPerfect Corporation or the
Windows printer driver that all other Windows
applications use. The following steps allow you to choose
the WordPerfect printer driver or the Windows printer
driver.

1.
2.
3.

Select the File menu.
Choose the Select Printer command.

Select the WordPerfect option button, or the Windows
option button, in the Printer Drivers list box.

. Choose the Select button.

If you choose the Windows option button, you must have
installed an HP Laserdet 4 printer driver in Windows 3.0.
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Installing a Printer Driver T install the WordPerfect printer driver, follow these
(WordPerfect Driver) steps:

1. Select the File menu.

2. Choose the Select Printer command.
3. Choose the Add button.
4

. Select the HP Laserdet 4 printer and choose the Add
button.

Choose the OK button.

6. Choose the HP Laserdet 4 and choose the Select
button.

o

If the HP Laserdet 4 printer is not listed, you can get the
driver by calling HP Distribution at (303) 353-7650 or
WordPerfect Corporation at (800) 222-9409. If you are a
member of CompuServe, you can download the driver
from the HP Peripherals Forum.

Choosinga Port  The default configuration in WordPerfect for Windows for
(WordPerfect Driver)  the HP Laserdet 4 printer is parallel. However, if you use
a serial port, complete the following steps:

1. Select the File menu.
2. Choose the Select Printer command.

3. Select the HP LaserJet 4 printer and choose the
Setup button.

4. Select your port from the Port: drop-down list box.
Installing a Sheet Feeder  Tb make the most of your HP LaserdJet 4 printer’s paper

(WordPerfect Driver)  feed options, you should install a sheet feeder. Complete
the following steps to install the sheet feeder:

1. Select the File menu.
2. Choose the Select Printer command.

3. Select the HP LaserdJet 4 printer, then choose the
Setup button.

4. Choose the Sheet Feeder button, then use the arrow
keys to scroll through the list of sheet feeders. Select
the sheet feeder option for the HP Laserdet 4 printer.

5. Choose the Select button.
6. Choose the OK button.
7. Choose the Select button.
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Installing Fonts

Installing Fonts  If you have a cartridge or soft font, you need to select
(WordPertect Driver)  drivers for these fonts in WordPerfect.

“-| Note If you are using the Windows printer driver, see
Note # “Adding Fonts” under the “General Information” section
of the Windows note.

Use the following steps to select drivers for your fonts.
1. Select the File menu.

Choose the Select Printer command.

Select the WordPerfect option button.

. Choose the Setup button.

SR

If you are installing a driver for a soft font, type in
the name of the directory where your soft font files
are kept in the Path for Downloadable Fonts and
Printer Commands: box.

Choose the Cartridges/Fonts button.
Select Cartridges or Soft Fonts.
Choose the Select button.

W ® =2

If you are installing a Cartridge, select your cartridge
from the list, choose the OK button, choose the
CLOSE button, then go to step 15.

10. If you are installing a soft font, highlight the name of
your soft font group, then choose the Select button.

11. Use the arrow keys to the right of the Select Fonts list
box to scroll through the font list, and select your font.

12. If you are selecting soft fonts, be sure to mark one of
the option boxes Present When Print Job Begins or
Can be Loaded / Unloaded During Job.

If you choose Present When Print Job Begins, the font
will be downloaded as permanent and will remain in
printer memory until the printer is powered off or
receives a specific command to delete the font from
memory.

If you choose Can be Loaded / Unloaded During Job,
the font will be assigned a temporary status and will
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be downloaded when needed instead of remaining in
printer memory.

13. Choose the OK button, then choose the CLOSE
button.

14. Choose the Close button again.

15. Choose the OK button.

16. Choose the Update button, then choose the CLOSE
button.

Installing Fonts  If you are using the Windows printer driver, install fonts
(Windows Driver)  according to the instructions in the “Adding Fonts”
section of this application note.

Common Tasks

Selecting Paper Size Select the Layout menu.

Choose the Page command.

Choose the PAPER SIZE command.
Select a paper size for your document.

Choose the SELECT button.

gk

ll.I If you are using the Windows printer driver, the only page

Note # size available will be the size selected in the Printer Setup
dialog box. If you are using the WordPerfect driver, at the
Paper Size screen highlight the page size you need and
choose the Select button.

Font Selection  The following steps select a font using the Font dialog
box. Fonts can also be selected in other ways. See your
WordPerfect user’s documentation for instructions.

Select the Font menu.

Choose the Font command.

Select the font and point size you want.
Choose the OK command.

oW

Creating Forms
(WordPerfect Driver)

Select the Layout menu.

Choose Page command.

Choose the Paper Size command.
Choose the Add button.

Ll O
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5. In the Add Paper Size dialog box, select Paper Type,
Paper Size, Text Adjustments, Paper Orientation,
Paper Location and Print Options. When all
selections have been made, choose the OK button.

6. Highlight the form you have created and choose the
Select button.

Printing in Landscape
Orientation (WordPerfect
Driver)

Select the Layout menu.
Choose the Page command.
Choose the Paper Size command.

Select the Standard 11" x 8.5" paper size from the
Paper Size list box.

Choose the Select button.

6. Select the FILE menu, choose the PRINT command,
then choose the PRINT button to print your
document.

L e

o

Select the File menu. .
Choose the SELECT PRINTER command.
Choose the Setup button.

Printing in Landscape
Orientation (Windows
Driver)

= w o

Click on the arrow next to the Paper Source drop
down list box.

5. Select the paper tray you want to use, or select the
Manual option.

6. Choose the Landscape option button,
7. Choose the OK button.

8. Select the FILE menu, choose the PRINT command,
then choose the PRINT button to print your

document.
Printing on Legal-Sized . Select the Layout menu.
Paper (WordPel_'fect . Choose the Page command.
Driver)

1
2
3. Choose the Paper Size command.
4

. Select the Legal 8.5" x 14" paper size from the Paper
Size list box.

If you have the universal paper tray (set to legal
paper size), or have configured the MP Tray to legal
paper size, edit the form to change the location to
continuous; otherwise select the Manual option. Page
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orientation (portrait or landscape) should also be
selected on this screen.

5. Choose the SELECT button.

6. Select the FILE menu, choose the PRINT command,
then choose the PRINT button to print your
document.

Printing on Legal-size . Select the File menu.

Paper (Windows Driver) . Choose the Select Printer command.

1
2
3. Choose the Setup button.
4

. Click on the arrow to the right of the Paper Size
drop-down list box. Select Legal 8 1/2 x 14 in.

5. Click on the arrow next to the Paper Source
drop-down list box.

6. If you have the universal paper tray set to legal or the
MP Tray configured for legal page size, select the
appropriate paper tray. If you do not have the
universal paper tray set to legal paper size or do not
plan to configure the MP Tray to legal paper size,
select the Manual option.

7. Choose the appropriate orientation option button.

8. Choose the OK button, then choose the CLOSE
button.

9. Select the FILE menu, choose the PRINT command,
then choose the PRINT button to print your
document.

Printing on COM-10
Envelopes (WordPerfect
Driver)

1. Select the Layout menu.

2. Choose the Page command.

3. Choose the Paper Size command.
4

. Highlight the Envelope 9.5" x 4" option. Check the
Location column to make sure it is set to the paper
location you need (for example, Manual or
Continuous). Choose Continuous if you have the
optional envelope feeder or have configured the MP
Tray for a Com-10 envelope paper size.

5. Choose Select.

6. Choose the Margin command, then set the following
margins:
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Top 2"
Bottom 1"
Left 4"
Right 1"

7. Select the FILE menu, choose the PRINTcommand,
then choose the PRINT button to print your
document.

Printing on COM-10
Envelopes (Windows
Driver)

Select the File menu.
Choose the SELECT PRINTER command.
Choose the Setup button.

Click on the arrow to the right of the Paper-Size
drop-down list box. Select Com-1041/8x91/2 in.

5. Click on the arrow next to the Paper Source
drop-down list box.

Ll A

6. Select Envelope if you have the optional envelope
feeder or have configured the MP Tray for a Com-10
envelope paper size. Select the Manual option if you
are manually feeding your envelopes.

7. Choose the Landscape orientation option button, then
choose the OK button

8. Select the Layout Menu
9. Choose the Margin command, then set the following

margins:
Top 2"
Bottom 1"
Left 4"
Right 1"

10. Select the FILE menu, choose the PRINTcommand,
then choose the PRINT button to print your
document.

Dual-Bin Printing
(WordPerfect’s Driver) 1. First select a sheet feeder (see the “Installing a Sheet
Feeder” section of this note).

2. Create a form for each bin you want to use (see the
“Creating a Form” section of this note).

3. Place the cursor at the top of the page you want
printed from a specific bin.
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Select the Layout menu.
Choose the Page command.

Choose the Paper Size command.

NSO

Select the form with the bin you want to use, then
choose the select button.

Jd Dual-Bin Printing is not supported with the Windows
Note @ Driver

Printing Special  If you need characters not accessible from your keyboard,
Characters = WordPerfect will allow you to print these characters using
the WP Characters command on the Font menu.

1. Position your cursor where you want the special
character to appear.

2. Select the Font menu.
3. Choose the WP Characters command.

4. Click on the arrow keys in the Set drop-down list box
to display the options available, then select the
character set containing the character needed.

5. Select the character you want by clicking on it.

6. Choose the Insert or Insert and Close button.

Special Features  The following special features are supported only with the

WordPerfect driver.
Printing Reverse Text 1. Select the Graphics menu.
(White Text on a Black 2. Choose the User Box command.
Background)
3. Choose the Options command.
4. Choose 100% gray shading by clicking on the up

arrow button next to the Percent text box, then choose
the OK button.

Select the Graphics menu.
Choose the User Box command.
Choose the Create command.

Select the Text Editor option button, then choose the
OK hutton.

9. Select the Font menu, then choose the Font command.

e
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10. Select Font and Point Size from the list boxes, then
choose the OK button.

11. Select the Font menu.
12. Choose the Color command.

13. Click on and hold the double arrow button in the
Predefined Colors drop-down list box. While holding
down the right mouse button, move the selection
cursor until White is highlighted; release the mouse
button, then choose the OK button.

14. Type text, then choose the CLOSE button.

“.l If you want to see white text on the black background,
Note # Text in Windows System Colors must not be selected. This
option is found under File, Preferences, Display.

Printing Rotated Text  Text rotation is available in WordPerfect for Windows
using the User or Text Box feature (rotated text will print,
but will not appear on the screen).

1. Select the Graphics menu.

2. Choose the User Box command.
3. Choose the Create command.
4

. Select the Text Editor option button, then choose the
OK button.

5. Choose the Box Position and Size button, and make
appropriate selections, then choose the OK button.

6. Choose the Rotate button.

7. Select the appropriate option button, then choose the
OK button.

8. Select the Font menu.
9. Choose the Font command.

10. Select the Font and Point Size you want, then choose
the OK button.

11. Choose the Box Position button. At the Box Position
and Size dialog box, make any selections you want for
Box Type, Anchor, Size, Vertical Position or Horizontal
Position, then choose the OK button.

12. Type text.
13. Choose the OK button, then choose the Close button.
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Graphics Quality Setting
(WordPerfect Driver)

Select the FILE menu.
Choose the PREFERENCES command.
Choose the PRINT command.

W oo

Change the Graphics Quality setting in the Document
Settings box.

5. Choose the OK button.
Common Problems

ERROR 20 Displayed on  If your printer displays a 20 MEM OVERFLOW message
Printer Control Panel  on its control panel when printing a document, you will
need to either add additional memory to the printer or
reduce the graphics resolution of the document being
printed.

If you are using WordPerfect’s printer driver, see the
“Graphics Quality Setting (WordPerfect Driver),” section
of this note for instructions about changing graphics
resolution. If you are using the Windows printer driver,
change graphics resolution by selecting: FILE, Print
Setup, Setup, Printer Resolution, then choosing either 300
dpi or 600 dpi.
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Word for Microsoft Corporation
: : Microsoft Word for Windows
\ZNCI)I"IdOWS version Customer Support . . .. ........ (206) 462-9673

Common Tasks

Printer Setup 1. Select the File menu.
2. Choose the Print Setup command.
3. Select the printer you wish to change.
4. Choose the Setup button.
Use this menu to select the Printer, Paper Source,
Paper Size, Orientation, Number of Copies, and
Graphics Resolution. You can also change settings for

Memory, Cartridge Fonts, and Page Protection if you
have not already done so.

5. Choose the OK button twice to return to your
document.

Selecting Fonts  You can change the font before typing in the text or
highlight a selected portion of the text and then select a
font in one of two ways:

Font Name/Point Size (on the document screen ribbon
bar):

1. Click on the down arrow following the font field.

Microsoft Word will list all of the typefaces available
to you, including internal fonts, installed cartridge
and soft fonts, and Type Director fonts.

2. Select the font you want.

3. Move the mouse to the points field and click on the
down arrow.

If you have selected a bitmapped font, like the internal
Courier or Line Printer, or a non-scalable cartridge/soft
font, the listed sizes are the only sizes available. If you
have selected a scalable font, like the internal CG Times
or Univers, the sizes shown are only a small sample of the
sizes available. If the size you want is not listed, highlight
the points box and type in the point size you want

(between 4 and 127).
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".l Although the HP Laserdet 4 printer can scale fonts from
Note # .25 t0 999.75 points, Microsoft Word for Windows only
supports from 4 to 127 points in .5 point increments.

Format Character (on the menu bar):

—

gr ok

Document Format 1.

Select the Format menu.

Choose the Character command.

Click on the down arrow following the Font field.
Select the font you want.

Move the mouse to the Points field and click on the

down arrow.

Once again, if you have selected a bitmapped font,
select from the listed sizes. If you have selected a
scalable typeface, you can highlight the Point Size
box and type in a point size between 4 and 127.

While in the CHARACTER dialog box you can also
select font attributes, including bold, italic and bold
italic.

Choose the OK button to return to your document.

Select the Format menu.

. Choose the Page Sefup command.

At the Printer Setup screen, you can change Margins,
Paper Size, Orientation, and Paper Source.

After all changes are made, select the OK button to
return to your document.

Printing on Legal-Sized
Paper

1. Select the FORMAT menu.

2. Choose the PAGE SETUP command.
3.
4

. Click on the down arrow following the Paper Size

Choose the Size and Orientation option button.

field.

5. Select Legal 8 1/2x 14 in.
6. Select the Landscape or Portrait option button under

Orientation.

Select the Paper Source option button.
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8. Select a tray from the First Page list box if you have
the universal paper tray or the MP Tray is configured
to legal paper size. Select Manual Feed from the First
Page list box if you do not have a legal-size paper tray.

“-| Check your HP LaserdJet 4 printer user’s manual for
Note ﬂ instructions about setting the MP tray size.

9. Select the appropriate option in the Other Pages list
box.

10. Choose the OK button to return to your document.
Printingon COM-10 Manually fed envelopes can be printed by using the
Envelopes  Envelope icon on the Toolbar.

Envelopes can be printed automatically from the MP tray
or the optional envelope feeder by making the following
changes:

1. Select the TOOLS menu.

2. Choose the OPTIONS command.
3. Select the Print icon.
4

. Select the Printer’s Envelope Feeder has been
Installed check box.

Choose the OK button.

6. Select the ENVELOPE button on the Tholbar. The
inside address for the letter will show up in the
Addressed Tb box. You can either accept this address,
or type in another address.

o

If you want to print a return address on the envelope,
type the address in the Return Address box.

Dual-Bin Printing 1. Select the Format menu.

2. Choose the Page Setup command.

3. Select the Paper Source option button.
4

. In the First Page list box, highlight the tray which
contains your cover sheet or letterhead.

5. In the Other Pages list box, highlight the tray which
contains regular paper.
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Printing Special  You can print special characters in Word for Windows by
Characters  following these steps:

1. Select the INSERT menu.

2. Choose the SYMBOL command.

3. Select the symbol set you want from the Symbols
From: drop-down list box.

4. Select the symbol you want, then choose the OK
button.

Common Problems

ERROR 20 Displayed on  If your printer displays a 20 MEM OVERFLOW message
Printer Control Panel  on its control panel when printing a document, you will
need to add additional memory to the printer or reduce
the graphics resolution of the document being printed.

You can change graphics resolution by selecting FILE,
Print Setup, Setup, Printer Resolution, and choosing 300
dpi or 600 dpi.
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About This This document is designed to assist you in setting up and
Ch apter using Lotus 1-2-3 Release 3.1/3.1+ with your HP Laserdet
4 printer.

HP provides Software Application Notes and printer
drivers for selected software packages. These notes and
printer drivers are available through the following
distribution sources:

HP First Fax  If you would like to have a list of drivers and Software
Retrieval System Application Notes faxed to you:

1. Dial (800) 333-1917 from any touch-tone telephone.
2. Select (1) for HP FIRST

3. Follow the voice prompts that guide you to select an
index or to enter a document ID number for product
information.

When you have selected all the documents you want,
you will be prompted to enter the telephone number
of the receiving FAX machine.

After HP FIRST acknowledges your documents are
ready, the system will dial the telephone number of
the FAX machine you selected, and the documents
you requested will be sent.

".l The time required to receive your information will vary
Note g depending on the length or complexity of the documents
you requested.

Hewlett-Packard  Software Application Notes and printer drivers are
Distribution  available for selected software packages through
Hewlett-Packard Distribution. Call (303) 353-7650 for
information (Monday through Friday, 7 AM to 6 PM,
MST).

CompuServe Ifyou are a member of CompuServe, you can download
Software Application Notes and software printer drivers
from the HP Peripherals Forum.
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Lotus Customer Support
Customer Support Number . . . .. .. (900) 454-9009
Developn_1ent Hours . ............ 9 AM to 6 PM, M-F EST
COI‘POI‘atIOH Charge . . . First minute free, $2 subsequent minutes
“Prompt” Member Support . . . . .. .. (800) 223-1662
Hours . .. ........... 24 hours, 7 days a week
Required Identification . .. ... Member ID number
Fonts

Supported Fonts  The fonts listed below can be accessed by using setup
strings with the Lotus 1-2-3 Generic, No backspacing
capability, printer driver. Refer to the font manuals for
the appropriate setup strings. Some of these fonts can be
used with Wysiwyg (“What you see is what you get”). See
the “Printing With Wysiwyg” section of this note.

Cartridge Fonts 92286... Soft Fonts 33412...
A,C,D,E GH,IC",J L MN, DA, EA
PC*,Q,R Y Super Fonts 33412/33413...
Cartridge Fonts 92290... DC
S1 w

Cartridge Fonts C2053A...
Co03, Co4*, Co7*
Cartridge Fonts C2055A...

cot* ]

*These cartridges contain both fixed and proportionally
spaced fonts. The proportional fonts on these cartridges
are not supported by Lotus 1-2-3. Any attempt to use a
proportional font (accessed by setup strings) will result in
tmproperly aligned spreadsheet columns (except when

=
o
@
o
o
@
w
-

€-¢-1 snjo7

using Wysiwyg).
Unsupported Fonts
Cartridge Fonts 92286... Soft Fonts 33412...
BFKPTU VWL XZ AC, AD, AE, AF, RA, RB, SA, SB,
Cartridge Fonis 92290... TA, TB, UA UB
S2
Cartridge Fonts C2053A... Super Fonts 33412...
Co1, C02, CO5, C06, CO8 AG
Type Director...
All
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]
Installation

Printer Port
Configuration

Parallel Interface

Serial Interface

Note U3

Printer Driver

Choices for the HP

LaserdJet 4 Printer

The information in this section will help you install your
HP Laserdet 4 printer driver in Lotus 1-2-3 Release
3.1/3.1+. For additional installation information, see the
Lotus 123 Setting Up booklet.

We suggest including the following MODE command(s) in
your AUTOEXEC.BAT file. Consult your DOS manual or

your Guide to Setting Up the HP Laserdet 4 Printer, which
shipped with your printer, for more information about the

AUTOEXEC.BAT file.

If your printer connects to one of the computer’s parallel
ports (LPTx:), enter the following command in your
AUTOEXEC.BAT file:

MODE LPTx:,, P
(Where x = the computer’s parallel port; for example,
LPT1, LPT2, etc.)

If your printer connects to one of the computer’s serial
ports (COMx:), enter the following commands in your
AUTOEXEC.BAT file:

MODE COMx:9600,N,8,1,P
MODE LPT1:=COMx

(Where x = the computer’s serial port; for example,
COM1, COM2, etc.)

The Laserdet 4 printer factory default baud rate is 9600.
If your printer is set for a different baud rate, replace
9600 in the above MODE command with the baud rate
setting of your printer.

The following printing options are available in Lotu
1-2-3 Release 3.1/3.1+: '

1. You can print using the HP Laserdet 4 PCL 5 printer
driver (a Wysiwyg driver).

2. You can print using the Generic, No backspacing
capabiltiy, printer driver. The Generic, No
backspacing capability, driver should be used if you
want to use setup strings or print multiple ranges on
the same page.
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Selecting a Printer
Driver: Step 1

Option 1: Installing the
HP LaserJet 4 PCL5
Printer Driver

|
Note U3

Option 2: Installing the
Generic, No backspacing
capability Printer Driver

Installing a printer driver for your HP LaserdJet 4 printer
is a two-step process. Follow all the procedures under
each step and complete steps 1 and 2 before printing.

If an HP LaserdJet 4 PCL 5 Wysiwyg driver is not in the
printer box, you can order it free of charge from
Hewlett-Packard Distribution at (303) 353-7650; this
driver is also available on CompuServe in the HP
Peripherals Forum.

Follow the instructions in the README file on the Lotus
1-2-3 Release 3.1/3.1+ printer driver disk to update to the
HP LaserJet 4 PCL 5 printer driver. You can print the
README file by typing the following command at a DOS
prompt:

COPY README PRN

After typing the above command, press the [Enter] key. If
the [Form Feed] light on the printer’s control panel

stays on after the README file has printed, more data is
in the print buffer. To print the remaining data in the
print buffer use the following steps:

1. Press and release the [On Line] key to take the
printer offline.

2. Press and release the [Form Feed] key to print the
data in the print buffer, then press and release the
[On Line] key to put the printer back online.

After installing the HP Laserdet 4 printer driver, follow
the steps in the “Setting Printer Defaults: Step 2”
section of this note.

If you plan to print without using Wysiwyg, or if you plan
to use setup strings or print multiple print ranges on a
page, install the HP Generic, No backspacing capability
printer driver.

Installing the Generic, No backspacing capability printer
driver for your HP LaserdJet 4 printer is a two-step
process. Follow all the procedures under each step and
complete steps 1 and 2 before printing.

Loading Lotus 1-2-3 Release 3.1/3.1+:

If you are already at the INSTALL screen, skip to the
“Installing the Printer Driver” section below. However, if
you are not in Lotus 1-2-3 and want to enter the Lotus
1-2-3 subdirectory, type CD\123r3 (or the subdirectory
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where the Lotus program resides) and press [Enter]. At
the DOS prompt, type LOTUS and press [Enter] to bring
up the the Lotus 123 Access System Menu.

Use your cursor keys to highlight Install, on the Lotus

1-2-3 Access System Menu, then press [Enter] to run the
Install program.

Follow these steps to install the Generic, No backspacing
capability printer driver. See the README file on the
Lotus 1-2-3 Release 3.1/3.1+ driver disk for instructions
about loading the HP LaserdJet 4 PCL 5 Wysiwyg driver.

Installing the Printer Driver:

1. Read the instructions on your screen, then press
[Enter).

2. Select Change Selected Equipment at the MAIN
MENU, then press [Enter].

3. Select Modify Current DCF on the CHANGE
SELECTED EQUIPMENT menu, then press [Enter].

4. Select Change Selected Printer on the Modify Current
DCF menu, then press [Enter].

5. Select Generic on the PRINTER menu, then press
[Enter].

6. Generic Printer should be highlighted. Press [Enter],
make sure No backspacing capability is highlighted,
then press [Enter].

7. Select Return to Menu on the MODIFY CURRENT
DCF menu, then press [Enter].

8. Select Save Changes on the CHANGE SELECTED
EQUIPMENT menu, then press [Enter].

9. Read the instructions on the NAMING YOUR DCF
screen, then press [Enter].

10. Read the instructions on the SPECIFYING A
DISKETTE screen, then press [Enter].

11. Read the information given on the TRANSFERRING
THE 1-2-3 FILES screen, then press [Enter].

12. Read the instructions on the INSTALLATION
SUCCESSFUL screen, then press (Enter].

13. Read the information on the GENERATING FONTS
screen, then press [Enter].

14. Press the [F9] key, highlight End Install Program,
then press [Enter].
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| It is not necessary to generate fonts for the Generic, No
15 ; vo gene
Note J backspacing capability driver.

Step 1 is now complete. Continue with Step 2 before
printing.

Setting Printer  Step 2 is changing the Lotus 1-2-3 default settings to
Defaults: Step 2  work correctly with the HP Laserdet 4 printer. After
running the INSTALL program, you need to select your
printer defaults. The following instructions guide you
through this process.

Selecting 1-2-3  From the Lotus 1-2-3 Access Menu highlight 1-2-3 and
press [Enter].

Accessing the Printer  Press [/] [W]orksheet [Gllobal [D]efalt [Plrinter.
Default Menu

Select Interface 1. Press [LInterface and highlight the number that
corresponds to the interface you are using. Available
interfaces are:

£

' 1 = Parallel 1 5 =DOS device LPT1 3
i 2= Serial 1 6 = DOS device LPT2 ¥
> 7 3 = Parallel 2 7 = DOS device LPT3 @
4 = Serial 2 8 = DOS device LPT4 wr

- w

Interface options 1 through 4 allow Lotus 1-2-3 to route
information directly to the appropriate communications
port. Options 5-9 (Output devices) allow information to be
routed according to the DOS MODE commands you
entered in your AUTOEXEC.BAT file when you set up the
HP LaserdJet 4 printer. (See the “Parallel Interface” and
“Serial Interface” sections of this note and Your Guide to
Setting Up the HP LaserJet 4 Printer). Options 5-8 are
often used if you are experiencing communications or
time-out problems.

l.l If you choose a serial interface, a menu giving baud rate
Note # options will be displayed. Choose the baud rate that
matches the setting on your printer. The HP Laserdet 4
printer default baud rate is 9600.

2. Press [Enter] to save the Interface selection.
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Setting the Other Defaults 1. Use these settings when creating new spreadsheets.
Press each of the letters indicated below and make
the changes as listed (for example, press [AlutoLF,
select NO, then press [Enter]).

[AlutoLF . . . . .. ... .. .. ... .. ...... No
[Lleft (margin) . . ... ... ............. 0
[Rlight (margin). . . ... ... ........... 80
[Tlop(margin) . . . . .. .. ... ... ........ 0
[Blottom (margin) . . . . ... ............. 0
[Plg-Length . .. ... ... For no cartridge drivers 60
Wlait . . .. ... . ... e No
[Sletup . . .. ............ Leave setup blank
[Nlame. . . . . Select the HP driver that you installed
2. Press [Q]uit, then [Ulpdate to save the default
selections.

3. Press [Q]uit to exit the menu.

Step 2 is now complete, and Lotus 1-2-3 Release 3.1/3.1+
is now configured to print with your HP Laserdet 4
printer. Continue to the next section for information
about spreadsheet printing.

".I If you installed a printer driver during the Install
Note ﬂ (Change Selected Equipment) procedure and it does not

show up in the spreadsheet selection ([/] [W]orksheet
[Gllobal [D]efault [Plrinter [N]lame), reinstall the printer
driver.

Reformatting  Spreadsheets that have been printed on printers other
Existing than an HP LaserdJet printer (for example, Epson, IBM)
must be reformatted to print correctly on the HP Laserdet
Spreadsheets 4 printer. To reformat existing spreadsheets to the default
settings, follow these instructions:

1. Retrieve your spreadsheet.

2. Press [/]1 [Plrint [Plrinter [Cllear [Flormat [Q]uit.

3. Your spreadsheet is now reformatted to the default
settings you entered earlier. However, if you wish to
change other parameters, including setup strings, do
S0 NOW.

4. Save your spreadsheet.

5. Print the spreadsheet. In the printer menu ([/] [Plrint
[Plrinter) press [Allign [Glo [Plage (after all
document formatting has been selected and the print
range specified). If you want to print using Wysiwyg,
see the “Printing with Wysiwyg” section of this note.

3-8 Lotus 1-2-3 Release 3.1/3.1+



General This section provides general guidelines for printing
Information spreadsheets.

Form Feed Light  The indicator next to the [Form Feed] key on the HP
Laserdet 4 printer lights whenever page data is stored in
the printer’s memory. Make sure the Form Feed light is
off before sending information to the printer. To clear the
printer’s buffer, press the [On Line] key to take the
printer offline, then press the [Form Feed] key. After the
page ejects, press the [On Line] key to put the printer
back online.

Worksheet Page  Lotus 1-2-3 does not send a form feed at the end of the
Command  document; therefore, data may remain in the printer’s
buffer. To automatically eject the last page of your
document, embed a Worksheet Page command in the
bottom left cell of your print range. To enter this
command press:

[/] [Wlorksheet [Plage

This command automatically inserts a page break, and a

w

double colon (:;) appears on your screen. .32.5
55
»
".l ANO27E in a setup string will prevent the Worksheet Page 3 ,T\;
Note # Command from executing. =
Example:

If your print range is A1..D115, position the cursor in
A116 and press [/] [Wlorksheet [Plage, then change your
print range to Al1..D116.

Formatting  When setting margins or using headers, footers, or
Spreadsheets  borders, you must select the Formatted option (this is
selected by default) within Lotus 1-2-3. To select the
Formatted option, press:

[/] [Plrint [Plrinter [Olptions [QOlther [Flormatted

Maximizing The Printable = To maximize your vertical printable area, select the
Area  Suppress Blank Header printing option. If you are not
printing headers or footers, this option gives you a
three-line top and bottom margin. To select this option,
press:

[/] [P]rint [Plrinter [O]ptions [O]ther [B]lank-Header
[Sluppress
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Printing Footers =~ When printing footers, use the [Plage command (selected
after pressing [G]o in the Printer menu) to eject the last
page from the printer. If this option is not selected, Lotus
1-2-3 cannot identify the last page and will not print the
footer.
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Printing Special v print special characters available with your HP
Characters Laserdet 4 printer, press [Alt] [F1] and then the two

character Compose Sequence from the following table
(after you enter the second Compose value, the character
appears on your screen). First, find the decimal value of
the special character you want to print. (The special
characters and their decimal values can be found in the
appendix of the HP LaserJet 4 and 4M Printers User’s
Manual). Next, use the corresponding two character
Compose Sequence to access the special character.

Special Character Decimal Value Chart

Compose Decimal Compose Decimal Compose Decimal Compose Decimal
Sequence Value Sequence Value Sequence Value Sequence Value
A 161 ”? 185 i 209 O~ 233
AA 162 X0 186 o/ 210 o~ 234
E 163 L= 187 AE 21 us* 235
E~ 164 Y= 188 a* 212 us* 238
E" 165 so 189 i 213 V) 237
n 166 ff 190 o/ 214 \& 238
I" 167 c| 191 ae 215 y" 239
(space) 168 ar 192 A 216 P- 240 w
‘(space) 169 er 193 i 217 p- 241 S
A(space) 170 ot 194 o 218 us* 242 % e
“(space) 171 ur 195 u" 219 us* 243 2 5
~(space) 172 a’ 196 E 220 us* 244 @ -
U 173 e 197 it 221 us* 245 wr
us 174 o 108 ss 222 us* 246 @
us* 175 u’ 199 oA 223 14 247
us* 176 a' 200 A 224 12 248
us* 177 e 201 A~ 225 a_ 249
us* 178 o' 202 a~ 228 o_ 250
us* 179 u' 203 D- : 227 < 251
C, 180 a" 204 d- 228 us* 252
¢ 181 e" 205 r 229 > 253
N~ 182 o’ 206 I 230 +- 254
n~ 183 u" 207 o 231 us* 255
Il 184 A* 208 o 232

US* - Unsupported

) o Special characters are accessed from the current active
Note # symbol set. For example, decimal #210 in the Roman 8
symbol set is the character . To specify an alternative
symbol set, include the command for the desired symbol
set in a Lotus 1-2-3 setup string (for example, \027(10U
for the PC-8 (IBM-US) symbol set).
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Example:

To print the British pound sign in the Roman-8 symbol
set, find decimal value 187 in the table above. Tb the left
is the two character Compose Sequence, L=. Press [Alt]
[F1] then L=,

For additional information about special characters, refer
to your Lotus 123 Release 3.1/3. 1+ Reference book or call
Lotus Technical Support.

Embedding Printer  Lotus 1-2-3 Release 3.1/3.1+ supports embedded printer
Commands commands. This feature gives advanced users the power
to enhance printer output.

Lotus 1-2-3 requires that embedded printer commands be
placed in a blank row, at the left-most column of the
current print range. An embedded printer command
requires one row to initiate the command, and one row to
terminate the command; therefore, any action or feature
accessed by an embedded printer command is active for a
minimum of one row.

Tb embed a printer command, precede the command with
two vertical bars (11 ) (located above the back-slash [\]
key). After typing the two vertical bars, the worksheet
will show only one bar but the cell content line will show
two.

Example:

Tb embed the printer command for italic print, position
your cursor in the left-most column of a blank row in your
print range, then enter the following: | | \027(s1S. This
command will give italic print to the currently selected
font.

".I Tb avoid unwanted page ejects, do not include a reset
Note # command (\027E) in embedded printer commands.
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Common Tasks The following pages provide information about print
features, setup strings, font selection, and print settings.

Resetting Printer’s  The following setup strings and settings are valid only if
Printing Menu to  your HP Laserdet 4 printer’s Printing Menu is set to
factory default and you have selected the Generic printer
Factory Defaults driver. To reset the printer to its factory default settings,
use the following steps:

1. Press [On Line] to take the printer offline.

2. Hold down the [Shift] and [Menu] keys on the
printer for about 10 seconds until RESET=MENU
appears.

Besides returning the printer to its factory default
settings, Reset Menu also clears the page buffer,
removes all temporary personality data such as
downloaded typefaces, and resets all printing
environment parameters (such as number of copies,
paper size, etc.). Items in the Config, Parallel, Serial
and AUX10 menus will not be reset.

£

3. Press the [On Line] key to return the printer online.

Compressed/  Lotus 1-2-3 Release 3.1/3.1+ has an advanced option that
Expanded Pitch allows you to select either compressed or expanded pitch.
To access this menu press: [/] [Plrint [P)rinter [Olptions
[Aldvanced [L]ayout[Plitch.

= r-
9

c
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D i
-

Page Orientation  Page orientation is a menu option in Lotus 1-2-3 Release
3.1/3.1+. To select page orientation, press [/] [P] [Plrinter
[Olptions [Aldvanced [L]ayout [Qlrientation [Plortrait or
[L]andscape.

Select Setup Strings  Ifyou are using the Lotus 1-2-3 Generic printer driver,
you may select font and line-spacing attributes for your
spreadsheet by entering setup strings.

To enter a setup string, press [/] [Plrint [P]rinter
[Olptions [Sletup, then enter the desired setup string
from the lists on the “Portrait Printing (Generic Printer
Driver)” and “Landscape Printing (Generic Printer
Driver)” sections of this note. Refer to your Lotus 1-2-3
Release 3.1/3.1+ Reference book for more information
about using setup strings.
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Portrait Printing (Generic Printer Driver)

".l When using the setup strings on this page, note the differ-
Note ﬂ ences in these characters:

= lower case letter “1” 1 = numeric one
O = upper case letter “0” g = numeric zero
/1 [Plrint [Plrinter [O]ptions [Sletup [Plage [Mlargins

Length [Rlight
LETTER FPAPER, 60 lines per page (6 lines/inch):

10 cpi \@27& 12200\ 927(sdpl1gH 60 80

12 cpi \027& {2a@0\927(sdp12H 60 96

16.67 cpi*  \027&£2af0\#27(s¥p16.67h8.5vAT 60 134
LETTER PAPER, 66 lines per page (6.6 lines/inch):

10 cpi \D27& { 2aff07.27C\P27(sdpldH 66 80

12 cpi \@27& £ 2ad07.27C\#27(s@p12H 66 96

16.67 cpi* \P27&(2a807.27C\P27(sPpl6.67Th8.5vAT 66 134
LETTER FPAPER, 80 lines per page (8 lines/inch):

10 cpi \@27& £ 2a008D\#27(sdplPH 80 80

12 cpi \P27& ¢ 2a808D\ #27(sdpl12H 80 96

16.67 cpi* \@27&£2af08D\P27(sfpl16.67h8.5v4T 80 134
LEGAL PAPER (using a legal tray), 78 lines per page (6 lines/inch):

10 cpi \@27& 13200\ 927(sfplgH 78 80

12 cpi \027& {3adO\P27(sdpl12H 78 96

16.67 cpi* \927&£3a00\927(s¥p16.67h8.5vAT 78 134
LEGAL PAPER (using a legal tray), 104 lines per page (8 lines/inch):

10 cpi \927& £ 3affo8D\F27(sdpldH 100 80

12 cpi \027& {3ado8D\ @27(sdpl2H 100 96

16.67 cpi* \@27&£3a@08D\927(sfpl6.67h8.5v4T 100 134
LEGAL PAPER (manual feed), 78 lines per page (6 lines/inch):

10 cpi \927& { 3a2h@O\927(splgH 78 80

12 cpi \B27& £3a2hPO\ g2 7(s0p1 2H 78 96

16.67 cpi*  \#27&£3a2hg0\@27(s0p16.67h8.5vAT 78 134
LEGAL PAPER (manual feed), 104 lines per page (8 lines/inch):

10 cpi \P27& { 3a2h@o8D\ #27(sPpldH 100 80

12 cpi \#27& £ 3a2hgo8D\F27(sgpl12H 100 96

16.67 cpi* \P27&[3a2hPo8D\F27(s@p16.67h8.5v4T 100 134

*This printer command will produce 16.67 character per inch (cpi) Line Printer type. Since the
HP LaserJet 4 printer has scalable Courier and scalable Letter Gothic typefaces, the font
selection command could be written \@27(s@p16.6 7Th4499T to produce 16.67 pitch Courier or
\927(s@p16.67Th4192T to produce 16.67 pitch Letter Gothic.
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Landscape Printing (Genetic Printer Driver)

[/1 [Plrint [P]rinter [Olptions [S]etup [Plage [M]argins
Length [Rlight
LETTER PAPER, 45 lines per page (6 lines/inch):

10 cpi \P27& £2a10\427(sdp1dH 45 106
12 cpi \027&£2a10\027(sPp12H 45 127
16.67 cpi* \@27&£2a10\027(s@p16.67h8.5vAT 45 177
LETTER PAPER, 66 lines per page (8.8 lines/inch):
10 cpi \P27&£2a105.45C\@27(s@p10H 66 106
12 cpi \@927&£2a105.45C\027(sPp12H 66 127
16.67 cpi* \@27&£2a105.45C\@27(s@p16.67h8.5vAT 66 177
LEGAL PAPER (using a legal tray), 45 lines per page (6 lines/inch):
10 cpi \P27&£3a10\927(sPp1PH 45 136
12 cpi \@27&£3a10\027(s@p12H 45 163
16.67 cpi* \@#27&£3a10\027(sdp16.67h8.5vAT 45 227
17.75 cpi** \@27&£3a10\027(sdp17.75h4099T 45 240
LEGAL PAPER (using a legal tray), 66 lines per page (8.8 lines/inch):
10 cpi \@27& £3a105.45C\@27(s@p 10H 66 136 (&%)
12 cpi \P27& £3a105.45C\@27(sdpl12H 66 163 iy
16.67 cpi*  \@P27&£3a105.45C\P#27(sfp16.67h8.5v4T 66 221 § =
17.75 cpi** \P27&£3a105.45C \@27(sPp17.75h4099T 66 240 8%
LEGAL PAPER (manual feed), 45 lines per page (6 lines/inch): ‘_‘i’ I:U
10 cpi \@27& £3a2h10\027(s@p10H 45 136 «@
12 cpi \@27& £3a2h10\@27(sdp12H 45 163
16.67 cpi* \P27&£3a2h10\@27(sPp16.67h8.5vH4T 45 227
17.75 cpi** \@#27&£3a2h10\027(slp17.75h4099T 45 240
LEGAL PAPER (manual feed), 66 lines per page (8.8 lines/inch):
10 cpi \P27&£3a2h105.45C\@27(sfp 10H 66 136
12 cpi \P27&£3a2h105.45C\A27(sdp12H 66 163
16.67 cpi* \@27&£3a2h105.45C\@#27(sPp16.67h8.5v4T 66 2217
17.75 cpi** \@27&£3a2h105.45C\@#27(sP¥p17.75h4099T 66 240

*This printer command will produce 16.67 character per inch {cpi) Line Printer type. Since the
HP LaserdJet 4 printer has both scalable Courier and sealable Letter Gothic typefaces, the font
selection command could be written \@27(sfp16.67h4899T to produce 16.67 pitch Courier or
\@27(sgpl16.67h4192T to produce 16.67 pitch Letter Gothic.

**The HP LaserJet 4 printer offers scalable Courier and scalable Letter Gothic typefaces. This
printer command will produce 17.75 pitch Courier print. If Letter Gothic typeface is needed, the
printer command should be modified to read \@27(sffpl7.75h4102T.
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Printing With
Wysiwyg

Common Tasks  This section provides information about using your HP
Laserdet 4 printer with the Lotus 1-2-3 version 3.1/3.1+
Wysiwyg option.

Wysiwyg allows far greater control of print functions than
Lotus 123 version 3.1/3.1+ alone provides. Fonts can be
selected for specific sections of the worksheet;
underlining, shading, and bolding can be applied to a
specific range; paper feed options can be selected; and the
Preview function can be used to view the spreadsheet as it
will appear when printed.

Enabling Wysiwyg To use Wysiwyg you must load it into memory. Wysiwyg
can be added automatically upon entering Lotus 1-2-3 or
invoked during the current Lotus 123 session. The
following instructions apply to adding Wysiwyg during a
Lotus 1-2-3 session. The Lotus 1-2-3 documentation gives
instructions for loading Wysiwyg automatically.

1. Start Lotus 1-2-3.

2. To enable Wysiwyg, hold down the [Alt | key on your
computer’s keyboard, then press the [F10] key.

3. Select [L]oad.
4. Highlight WYSIWYG.PLC, then press [Enter].

5. Select No Key if you plan to use a mouse or [:] (colon)
to display the Wysiwyg main menu. This Wysiwyg
function may also be assigned to [Alt-F7], [Alt-F8],
[Alt-F9] or [Alt-F10]. After making your selection,
the Wysiwyg add-in program will load into memory.
Press [Q]uit to return to the Lotus 1-2-3 spreadsheet
screen.

“.l Press [:] (colon) or press the alternate key you chose
. during the add-in process to activate the Wysiwyg menu.
To use Lotus 1-2-3 menus and functions, use the [/] key.

Note
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Selecting a Printer  Wysiwyg supports the following Hewlett-Packard
and Font Cartridge  cartridges:

Cartridge Fonts 92286

ABCDEFGH,
JEKLMNPQT
U, VYZ

1. Tb choose a printer, press [:] [Plrint [Clonfiguration
[Plrinter. Select the HP LaserJet 4 printer you
selected in the Install program, then press [Enter].

2. If you plan to use a font cartridge, choose [1]st
Cartridge; select your cartridge from the cartridges
listed, then choose [Q]uit.

Formatting a Page 1. To select the Page-Size, Margins, Titles, Borders, and
Compression for your document, press [:] [Plrint
[L]ayout and make all page layout settings.

2. Press [Qluit to exit the Layout menu.

€

".l If you change the margin settings below the defaults,
Note ﬂ Top=.5", Bottom=.55", Left=.5", Right=.5", data may be
lost.
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Inserting or Removinga  Wysiwyg allows you to insert and remove manual page
Page Break  breaks in spreadsheets.

Tb insert a page break, press [:] [Wlorksheet [Plage, then
choose [Rlow or [Clolumn [Qluit.

To remove a page break, press [:] [W]orksheet [Plage
[Dlelete.

Specifying Page 1. Press [:] [Plrint [Clonfiguration [Q]rientation.
Orientation and Paper

X 2. Select the document Orientation (Portrait or
Location

Landscape), then press [Enter].

3. Select [Blin, set the paper location (Manual or Tray),
then press [Enter].

4. Press [Q]uit to exit the Configuration menu.
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Selecting Fonts 1. Select a Wysiwyg font by pressing [:] [Flormat [Flont.
Select any of the listed fonts by highlighting or typing
the font number. When asked for the range to change,
highlight the area to be formatted by using the arrow

keys, then press [Enter].

2. Change the attributes of Wysiwyg fonts by typing [:]
[Flormat. The Format menu lists the following
attribute selections: Bold, Italics, Underline, Color,
Lines, Shade, and Reset.

3. Select the attribute you want to apply to a given
range by typing the first letter of the attribute (for
example, press [I] for italics), or highlight the
attribute with the cursor, then press [Enter] to select
it.

4. Press [Slet, select the range to be changed by using
the arrow keys to highlight the range, then press
[Enter].

You can use up to eight typefaces per worksheet file.

Selecting Cartridge Fonts

To use cartridge fonts, follow these steps to modify the
font set to include the cartridge fonts:

1. Press [:] [Flormat [Flont [Rleplace, type the number
of a listed font you want to replace with one of the
cartridge fonts, then press [Qlther.

2. At the Select typeface: menu, highlight the font you
want to add to your font list, then press [Enter].

3. Type in the point size of the cartridge font you want
to use (make sure the point size is available on your
cartridge), then press [Enter]. The cartridge font will
be listed in the Wysiwyg font selection box (see Note
below).

4. Type the number of the font to select it, highlight the
range to be changed, then press [Enter].

“.| If you want the font list change to be permanent, press [:]
Note # [Flormat [Flont [D]efault [Ulpdate, then press [Qluit.
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Printing a Document

Selecting Legal-size
Paper

Note U3

Printing Reverse Text

1. Print a Wysiwyg document by pressing [:] [P]rint
[Rlange [Slet. Select the printable range by typing in
the range values or pressing [.] (period key), then
using the arrow keys to highlight the range. After the
range has been selected press [Enter].

2. Select a printer by pressing [Clonfig [Plrinter, then
select the HP LaserJet 4 printer driver you installed.

3. Press [Q]uit.
4. Press [Glo to print the document.

Follow these steps to select a legal form size:

1. Press [:] [Plrint [L]ayout [Plage-size [6]:Legal, make
other Page Layout selections, then press [Q]uit.

2. Press [Clonfiguration [Qlrientation, then select
Portrait or Landscape.

3 Press [Blin and choose the paper location (Manual or
Tray), then press [Q]uit.

4. Set the Range, then press [Glo to print the document.

To print on legal-size paper, you must have the universal
paper tray set to legal, the MP tray configured as legal, or
have specified “Manual” under Wysiwyg’s Bin selection
option.

The Wysiwyg option allows printing white text on a black
background. To print reverse text follow these steps:

1. Press [:] [Flormat [SThade [Slolid, highlight the range
you want to have a solid shade, then press [Enter].

2. Press [:] [Flormat [Flont, select the font you want and
specify the range to change, then press [Enter].

3. Press [:] [Flormat [Clolor [R]everse, specify the
range, then press [Enter].

4. Type text.

5. Press [:] [Plrint [R]ange [S]et, specify the range to
print, then press [Enter].

6. Press [Clonfig [Plrinter, select the HP LaserJet 4
printer, then press [Enter]. Press [Q]uit, then [Glo to
print the document.
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Printing a Graph

Create or retrieve a graph.

2. Press [:] [Plrint [Rlange [Slet, select the printable
range by typing in the range values or highlighting
the area with the arrow keys, then press [Enter].

3. Press [Llayout, make page format settings, then
press [Qluit to exit the Layout menu.

4. Press [Clonfiguration [Plrinter, then select the
HP Laserdet 4 printer you installed.

5. Press [Olrientation to choose page orientation.

6. Press [Blin to select paper location (Manual or Tray),
then press [Q]uit.

7. Press [Glo to print the graph.
Common Problems

“Out of Memory” Error  Problem: An Out of Memory error message appears in
Lotus 1-2-3 while trying to print using Wysiwyg.

Cause: There is not enough available memory (RAM) in
your computer.

Solutions:

1. Disable the Lotus 1-2-3 Undo feature by typing [/]
[Wlorksheet [Gllobal [Dlefault [Olther [UIndo
[Dlisable [Ulpdate [Q]uit.

2. Check your AUTOEXEC.BAT and CONFIG.SYS files
for any memory resident programs that are loaded
during startup. (For information about
AUTOEXEC.BAT and CONFIG.SYS files, check your
DOS manual.)

3. If you use [/] [Slystem to exit Lotus 1-2-3, type exit,
(not 123), to re-enter Lotus; otherwise the program
will attempt to load a second copy of itself. If you
have more than one copy of Lotus 123 running at
once, exit to the DOS level, then re-enter Lotus 1-2-3.
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Printing Graphs
in Lotus 1-2-3

Portrait Graph

Landscape Graph

P--Computer
. Museum

J
Note U

Image Sizing Setting
(Image-Sz)

Margin-Fill

This section provides information about printing graphs
using Lotus 1-2-3 without the Wysiwyg option. You must
install one of the HP Laserdet printer drivers to print
graphs with Lotus 1-2-3 Release 3.1/3.1+. You cannot
print graphs with the Generic printer driver. To install an
HP Laserdet printer driver, refer to the installation
portion of this note.

To print a graph in portrait orientation:

1. Press [/] [Plrint [Plrinter [IImage.

2. Select either [Clurrent (this prints the currently
displayed graph) or [N]amed (this allows you to print
a previously named graph).

3. Press [Allign [Glo [Plage to print the document.

To print a graph in landscape orientation:
1. Press [/] [Plrint [Plrinter {TImage.

2. Select either [Clurrent or [N]amed, then select
[Olptions [Aldvanced [Flmage [R]otate [Yles [Q]uit
[Qluit [Q]uit.

3. Press [Allign [Glo [Plage to print the document.

When you rotate a graph, only the graph rotates; the page
margins remain the same.

To change the size of a graph, use the image size settings
found underl/] {Plrint [Printer [Olptions [Aldvanced
[IImage [IImage-Sz. The default shape of a graph is four
units in width for every three units in length. For more
information about these settings see the Lotus 1-2-3
Release 3.1/3. 1+ Reference manual.

The Margin-Fill option does not change the default graph
shape, but fills the graph on the page between the right
and left margins (see the paragraph “Landscape Graph”
for the location of landscape right and left margins). The
maximum right margin is determined by the selected
printer driver and assumes a 0 (zero) left margin (see the
[Mlargins [Rlight column on the setup string pages for
maximum settings).

Press [/] [Plrint [Plrinter [Olptions [Aldvanced [IImage
[IImage-Sz [M]argin-Fill to select Margin-Fill.
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Length-Fill  The Length-Fill option does not change the default graph
shape but uses the length you request to create the
largest graph possible.

Press [/] [Plrint [P]rinter [Olptions [A]dvanced [IJmage
[Ilmage-Sz [L]ength-Fill to select Length-Fill.

Reshape  The Reshape option sizes the graph according to the width
and length specified.

Press [/I[Plrint [Plrinter [Q]ption [A]ldvanced [Ilmage
[IImage-Sz [Rleshape to select Reshape.

Graphics Densities v change the graphic output in Lotus 1-2-3 Release
3.1/3.1+:

Press I/] [Plrint [Plrinter [Olptions [Aldvanced [Ilmage
[Dlensity, and select [Flinal or [D]raft.

Novell Networks  If you print graphs on a Novell network, make sure that
the File Contents selection in the Novell utility '
PRINTCON is set to Byte stream rather than Text. An
incorrect setting can cause a blank page to print.
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Common This section discusses solutions to common problems ‘
associated with using Lotus 1-2-3 Release 3.1/3.1+ with

Problems your HP LaserdJet 4 printer. These and other problems
may be avoided if you follow the instructions in the
“Installation,” “General Information,” and “Common
Tasks” sections of this note.

Page Does Not Eject Problem: The last page of the spreadsheet does not
automatically eject.

Solution: The keystroke sequence to follow (assuming
you have already correctly set your print range and
desired print options) when sending a spreadsheet to
print is:

[/1 [P]rint [P]rinter [A]lign [Glo [Plage

The [Plage command sends a form feed command to the
printer; this command causes the printer to gject the page.

Creeping Text  Problem: The first page of your spreadsheet prints
correctly but following pages have larger and larger top
margins.

€

Solutions:
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1. If you are using a setup string that contains a vertical
line spacing command (which affects the number of
lines printed on the page), set the Lotus 1-2-3 page
length to the number of lines per page specified by
the vertical line spacing command. For example: if
you are printing a portrait document, a vertical line
spacing command which prints 6.6 lines per inch will
require a 66 lines per page page length setting in
Lotus 1-2-3 (6.6 lines per inch x 10 inches); if you are
printing a landscape document, a vertical line
spacing command that produces 8.8 lines per inch
will require a 66 lines per page page length setting in
Lotus 1-2-3 (8.8 lines per inch x 7.5 inches). See the
“Common Tasks,” “Portrait Printing (Generic Printer
Driver),” and “Landscape Printing (Generic Printer
Driver)” sections of this application note for
additional information.

€-2-1 snjo7

2. If you are not using a setup string which contains a
vertical line spacing command, and you are printing
a portrait letter-size document, set the Lotus 1-2-3
page length to 60 to correspond to FORM=60 LINES,
(your HP LaserdJet 4 printer’s default lines per page).
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Another Printer Print

See the “Setting the Other Defaults” section of this
application note for additional information.

3. You can maximize the number of lines per page by

using the Lotus 1-2-3 Unformatted printing option.
For example, if both Lotus 1-2-3 and the HP Laserdet
4 printer are set to 60 lines per page and your
spreadsheet does not contain headers, footers, or
borders, you can print 60 lines on the page by
selecting the Unformatted printing option. To select
the Unformatted printing option, press [/] [P]rint
[Pirinter [Olptions [Olther [UInformatted.

Spreadsheets  Problem: Spreadsheets that print correctly on non-HP
Formatted For  Laserdet printers do not print correctly on your HP

Incorrectly

Laserdet 4 printer.

Solutions:

1. Make sure you are using the HP LaserdJet 4 printer

driver. If not, press: [/] [Wlorksheet [Gllobal [Dlefault
[Plrinter [N]ame and select it.

2. Refer to the “Setting Printer Defaults: Step 2" section

of this note for instructions about configuring Lotus
1-2-3 to work with your HP Laserdet 4 printer. Make
any changes needed.

3. Clear the spreadsheet format by pressing: [/] [Plrint

{Pirinter [Cllear [Flormat.

Nothing Prints  Problem: Printer does not print.

Solutions:

1.

2.

If the printer’s Form Feed light is on, press the
[On Line] key to take the printer offline, then press
the [Form Feed] key to eject the page.

Make sure the correct DOS MODE commands are in
your AUTOEXEC.BAT file and your interface
selection in Lotus 1-2-3 corresponds to the interface
your printer is using. Refer to the “Select Interface”
section of this note.
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Printer Error  Problem: The message Error displays in Lotus 1-2-3
when you print a spreadsheet or graph.

Solutions:

1. If your document is a spreadsheet, make sure a print
range is specified: [/] [Plrint [P]rinter [R]ange and
specify the range to print. If your document is a
graph, make sure the graph has been selected: [/]
[Plrint [Plrinter [Ilmage, then select [Clurrent or
[Nlamed.

2. With some computers, interface selection Output
Device LPT1 works better than selecting Parallel 1 or
Serial 1. Press [/] [Wlorksheet [G]lobal [D]efault
[Plrinter [IInterface and select [5]0utput Device
LPT1:, then press [Q]luit [Ulpdate [Q]uit to save the
selection.

All Print is on One  Problem: The entire spreadsheet prints on a single line.
Line (Thisusually appears as a solid black line at the top of
the page.)

Solution: Press [/] [W]lorksheet [Gllobal [D]efault
[Plrinter [A]utoLLF [N]o, then [Q]uit [Ulpdate [Q]uit.

€

“xx LOAD” ’paper Problem: Printer displays xx LOAD when sending a
size’  print job to the printer. xx could be MP, PC, or LC.
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Cause: The (page size) command sent to the printer does
not match the paper size loaded in the paper cassettes, or
match the paper size setting in the printer’s Paper Size
menu (this applies only if the MP Tray is set to MP
TRAY=CASS in the Config menu).

Solution: Make sure the paper cassettes contain the
paper size required by the print job, or if you have the
MP Tray set to MP TRAY=CASS, make sure the paper
size 1s specified correctly in the printer’s Paper Size menu
(press the [Paper Size] key).
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ERROR 21 (Print  Problem: The message 21 PRINT OVERRUN appears
Overrun) in the printer’s control panel display.

Cause: The document being printed contains an area {or
areas) that is too complex for the printer to print.

Solutions:

1. Reduce the complexity of the document by using
smaller fonts or remove bolded and underlined font
attributes.

2. Reduce the document’s print resolution (for example,
choose 300 dpi instead of 600 dpi).

3. Turn on the printer’s Page Protection feature. (See
your printer user’s manual for instructions about how
to use this feature.)

ERROR 20 (Mem  Problem: The message 20 MEM OVERFLOW appears
Overflow) in the printer’s control panel display.

Cause: You have run out of available memory in your
printer. This may happen when you try to print a
spreadsheet that downloads too many soft fonts or
contains high resolution rules such as shades and/ or

graphs.
Solutions:

1. Reduce the spreadsheet’s print resolution (for
example, choose 300 dpi instead of 600 dpi).

2. Purchase additional memory for your printer.
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Other Problems  If you have other problems or if these suggestions have
not resolved the problem:

1. Read the “General Information” section of this
application note.

2. Print similar spreadsheets. Is the problem isolated to
one spreadsheet? If so, check for differences in print
settings.

3. Repeat the installation procedures.

4. Refer to your Lotus 1-2-3 Release 3.1/3.1+ Reference
manual or call Lotus Technical Support for assistance
in using Lotus 1-2-3 functions or macros.

5. Call Hewlett-Packard’s Customer Support Center:

Telephone . . . . . . ... . ... .... (208) 323-2551
Hours (Mon, Tue, Thu, Fri) . ... 7amto6PM MST
Wednesdays. . .. .. ....... 7 AM to 4 PM MST

When you call Hewlett-Packard, please call from a
telephone next to your computer and HP LaserJet 4
printer. Assisting you often requires access to your printer
and Lotus 1-2-3 application. You should also have a
current copy of the printer’s self-test available. The
printer’s self-test will allow you to quickly identify
current, printer settings for the support technician.
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About This
Chapter

HP First Fax
Retrieval System
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Hewlett-Packard
Distribution

CompuServe
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This document is designed to assist you in setting up and
using Lotus 1-2-3 Release 2.3 with your HP Laserdet 4
printer.

HP provides Software Application Notes and printer
drivers for selected software packages. These notes and
printer drivers are available through the following
distribution sources:

If you would like to have a list of drivers and Software
Application Notes faxed to you:

1. Dial (800) 333-1917 from any touch-tone telephone.
2. Select (1) for HP FIRST.

3. Follow the voice prompts that guide you to select an
index or to enter a document ID number for product
information.

When you have selected all the documents you want,
you will be prompted to enter the telephone number
of the receiving FAX machine.

After HP FIRST acknowledges your documents are
ready, the system will dial the telephone number of
the FAX machine you selected, and the documents
you requested will be sent.

The time required to receive your information will vary
depending on the length or complexity of the documents
you requested.

Software Application Notes and printer drivers are
available for selected software packages through
Hewlett-Packard Distribution. Call (303) 353-7650 for
information (Monday through Friday, 7 AM to 6 PM,
MST).

If you are a member of CompuServe, you can download
Software Application Notes and software printer drivers
from the HP Peripherals Forum.



Lotus
Development
Corporation

Fonts

Supported Fonts

Unsupported Fonts

Customer Support
Customer Support Number . . . .. .. (900) 454-9009
Hours . . ... ........ 9 AM to 6 PM, M-F EST
Charge . . . First minute free, $2 subsequent minutes
“Prompt” Member Support . . . . .. .. (800) 223-1662
Hours . ... ... ....... 24 hours, 7 days a week

Required Identification . .. . .. Member ID number

The fonts listed below can be accessed by using setup
strings with the Lotus 1-2-3 Unlisted printer driver. Refer
to the font manuals for the appropriate setup strings.
Some of these fonts can be used only with Wysiwyg
(“What you see is what you get.”). See the “Printing With
Wysiwyg” section of this note.

Cartridge Fonts 92286... Soft Fonts 33412...

A, C,DE G, HICJ L MN, DA,
PC*, QR Y Super Fonts 33412/33413...
Cartridge Fonts 92290... DC
S1

Cartridge Fonts C2053A...
€03, Co4*, Co7*
Cartridge Fonts C2055A...

cot*

*These cartridges contain both fixed and proportionally
spaced fonts. The proportional fonts on these cartridges
are not supported by Lotus 1-2-3 print menus. Any attempt
to use a proportional font (accessed by setup strings) will
result in improperly aligned spreadsheet columns (except
when using Wysiwyg).

Cartridge Fonts 92286...
BFKPTU VW X2Z

Soft Fonts 33412...
AC, AD, AE, AF, RA, RB, SA, SB,

Cartridge Fonts 92290... TA, TB, UA, UB
s2
Cartridge Fonts C2053A... Super Fonts 33412...
Co1, €02, C05, Co6, Co8 AG
Type Director...
All
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The information in this section will help you install your
HP Laserdet 4 printer in Lotus 123 release 2.3. For
additional installation information, see the Lotus 123
Getting Started booklet.

We suggest including the following MODE command(s) in
your AUTOEXEC.BAT file. Consult your DOS manual or
Your Guide to Setting Up the HP LaserdJet 4 Printer, which
shipped with your printer, for more information about the
AUTOEXEC.BAT file.

If your printer connects to one of the computer’s parallel
ports (LPTx:), enter the following command in your
AUTOEXEC.BAT file:

MODE LPTx:,P

(Where x= the computer’s parallel port; for example,
LPT1, LPT2, etc.)

If your printer connects to one of the computer’s serial ports
(COMx), enter the following commands in your AUTO-
EXEC.BAT file:

MODE COMx:9600,N,8,1,P
MODE LPT1:=COMx

(Where x= the computer’s serial port; for example, COM1,
COM2, etc.)

9600 is the factory default baud rate of the HP Laserdet 4
printer. If your printer is set for a different baud rate,
replace 9600 in the above MODE command with the baud
rate setting of your printer.

The following printing options are available in Lotus
1-2-3 Release 2.3.

1. You can print using the HP LaserJet 4 PCL 5 printer
driver (a Wysiwyg driver).

2. You can print using the HP LaserdJet series text and
Laserdet III, IIID, and IIIP graphics printer drivers.

Install the HP LaserdJet series text printer driver if you plan
to use setup strings or print multiple ranges on a page; and
install the LaserdJet II1, IIID, and ITIP graphics printer
driver if you plan to use the Lotus 1-2-3 PrintGraph feature,




Option 1 If an HP Laserdet 4 PCL 5 Wysiwyg driver is not in the
Installing the HP LaserJet  printer box, you can order it free of charge from
4 PCL 5 Wysiwyg Printer Hewlett-Packard Distribution at (303) 353-7650; this
Driver  driver is also available on CompuServe in the HP
Peripherals Forum.

Follow the instructions in the README file on the Lotus
1-2-3 Release 2.3 printer driver disk to update to the HP
LaserJet 4 PCL 5 Wysiwyg printer driver. You can print
the README file by typing the following command at a
DOS prompt:

COPY README PRN

After typing the above command, press the [Enter] key. If
the [Form Feed] light on the printer’s control panel

stays on after the README file has printed, more data is
in the print buffer. To print the remaining data in the
print buffer use the following steps:

1. Press and release the [On Line] key to take the
printer offline.

2. Press and release the [Form Feed] key to print the
data in the print buffer, then press and release the
[On Line] key to put the printer back online.

Lotus 1-2-3 for DOS  If you are a network administrator and need to update
Release 2.3 Network the printer driver for the Lotus 123 for DOS Release 2.3
Edition Network Edition, you will need the Lotus 2.3 Network
Edition update disk. This disk is available electronically
from the HP Peripherals Forum on CompuServe, from
Hewlett-Packard Distribution at (303) 353-7650, or from
Lotus Development Corporation.

Option 2 Installing the Laserdet series text and Laserdet 111, 111D,
Installing the LaserJet  and IIIP graphics printer drivers for your HP Laserdet 4
series Text and LaserJet printer is a two-step process. Follow all the procedures
I, MD, and P Graphics under each step and complete steps 1 and 2 before

Printer Drivers: Step1  Printing.

Tx If you plan to print without using Wysiwyg, or if you plan

Note ﬂ to use setup strings or print multiple print ranges on a
page, install the HP LaserdJet series text printer driver.
Install the Laserdet I11, I1ID, and IIIP graphics printer
driver if you plan to use the Lotus 1-2-3 PrintGraph
option.
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Loading Lotus 1-2-3  If you are already at the Install screen, skip to the
Release 2.3 INSTALL “Installing the Printer Driver” section below. However, if
Program you are not in Lotus 1-2-3 and want to enter the Lotus

1-2-3 sub directory, type CD\123r23 (or the sub directory
where the Lotus program resides) and press [Enter], At
the DOS prompt, type LOTUS and press {Enter] to bring
up the Lotus 123 Access System Menu. Use your cursor
keys to highlight Install, then press [Enter] to run the
Install program.

Installing the Printer  Use the following steps to install the LaserdJet series text
Driver printer driver and the LaserdJet III, IIID, and IIIP
graphics printer driver. See the README file on the
Lotus 1-2-3 Release 2.3 printer driver diskette for
instructions about loading the HP LaserJet 4 PCL 5
Wysiwyg driver.

1. Read the instructions on your screen, then press
[Enter].

2. Select Change Selected Equipment on the MAIN
MENU, then press [Enter].

3. Select Modify the Current Driver Set on the CHANGE
SELECTED EQUIPMENT menu, then press [Enter].

4. Select Text Printer on the Modify Current Driver Set
menu, then press [Enter].

5. Select HP on the TEXT PRINTER SELECTION
menu, then press [Enter].

6. Select LaserJet series on the TEXT PRINTER
SELECTION menu, then press [Enter]. You will
return to the MODIFY CURRENT DRIVER SET
menu.

7. Select Graphics Printer on the MODIFY CURRENT
DRIVER SET menu, then press [Enter].

8. Select HP on the GRAPHICS PRINTER
SELECTION menu, then press [Enter].

9. Select Laserdet III, IIID, and IIIP , then press
[Enter]. You will return to the MODIFY CURRENT
DRIVER SET menu.

10. Select Return to Previous menu on the MODIFY
CURRENT DRIVER SET menu, then press [Enter].

11. Select Save the Current Driver Set on the CHANGE
SELECTED EQUIPMENT menu, then press [Enter].
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12. Read the instructions on the SAVING YOUR
CHANGES screen, then press [Enter]).

13. Read the instructions on the GENERATING FONTS
screen, then press [Enter].

14. Select the set of font sizes you want to use with
Wysiwyg on the GENERATING FONTS menu.
Whether you choose Basic, Medium, or Extended
depends on the font sizes you need and the amount of
disk space you have available. The box on the
GENERATING FONTS menu gives information
about disk-space requirements.

M Basic gives a maximum font point size of 24, medium a
Note # maximum font point size of 36, and extended a maximum
font point size of 72. The larger the set of fonts, the more
disk space will be required.

15. Select the font set you want, then press [Enter].

16. AGENERATING FONTS screen will display while
fonts are being generated. When font generation is
complete, press any key to end Install.

Step 1 is now complete. Continue with Step 2 before
printing.

Setting Printer  Step 2 is changing the Lotus 1-2-3 default settings to
Defaults: Step 2  work correctly with the HP Laserdet 4 printer. After
running the INSTALL program, you need to select your
printer defaults. The following instructions guide you
through this process.

Selecting 1-2-3  From the Lotus 1-2-3 Access Menu highlight 1-2-3, then
press [Enter].

Accessing the Printer  Press [/] [Wlorksheet [Gllobal [D]efault [Plrinter.
Default Menu

Selecting the Interface 1. Press [I]nterface and select the number that
corresponds to the interface you are using. Available
interfaces are:

1 =Parallel 1 5 = DOS device LPT1
2 =Serial 1 6 = DOS device LPT2
3 = Parallel 2 7 = DOS device LPT3
4 = Serial 2 8 = DOS device LPT4
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Setting the Other Defaults

Note '.'ﬂ
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Interface options 1 and 3 (Parallel) allow Lotus 1-2-3 to
route information directly to the appropriate parallel port.
Options 5-8 (Qutput devices) allow information to be
routed according to the DOS MODE commands you
entered in your AUTOEXEC.BAT file when you set up the
HP Laserdet 4 printer. (See the “Parallel Interface”
section of this note and Your Guide to Setting Up the HP
LaserdJet 4 Printer). Options 5-8 are often used if you are
experiencing communications or time-out problems.

If you choose a number specifying a serial interface,
another menu giving baud rate options will be displayed.
Choose the baud rate that matches the setting on your
printer. The HP LaserdJet 4 printer default baud rate is
9600.

2. Press [Enter] to save the interface selection.

1. Use these settings when creating new spreadsheets.
Press each of the letters indicated below and make
the selections listed (for example, press [AlutoLF,
select NO, then press [Enter]).

[AlutoLF . . . . . .. .. ... ... ... ...... No
[Lleft (margin) . ... ... .............. 0
[Rlight (margin). . . ... ... ........... 80
[Tlop (margin) . . . . .. .. .. .. ... ... .... 0
[Blottom (margin) . . . . .. ... ........... 0
[Plg-Length . . . ... ... For no cartridge drivers 60
Wlait . . .. .. .. .. No
[Sletup . . . . .. . .. ... .... Leave setup blank
[N]lame. . . . . Select the HP driver that you installed
2. Press [Q]uit, then [Ulpdate to save the default
selections.

3. Press [Qluit to exit the menu.

Step 2 is now complete, and Lotus 1-2-3 Release 2.3 is
now configured to print with your HP Laserdet 4 printer.
Continue to the next section for information about
printing spreadsheets,

If you installed a printer driver during the Install
(Change Selected Equipment) procedure and it does not
show up in the spreadsheet selection (/] [W]orksheet
[Gllobal [Dlefault [Plrinter [Nlame), reinstall the printer
driver.




Reformatting  Spreadsheets that have been printed on printers other
Existi ng than an HP Laserdet printer (for example, Epson, IBM)
must be reformatted to print correctly on the HP Laserdet
Spreadsheets 4 printer. To reformat existing spreadsheets to the default
settings, follow these instructions:

1. Retrieve your spreadsheet.
2. Press [/] [Plrint [Plrinter [Cllear [Flormat [Q]uit.

3. Your spreadsheet is now reformatted to the default
settings you entered earlier. However, if you wish to
change other parameters, including setup strings, do
SO NOW,

4, Save your spreadsheet.

5. Print the spreadsheet. In the printer (/] [Plrint
[Plrinter) menu, select the range to be printed, then
press [Allign [Glo [P]age. If you want to print using
Wysiwyg, see the “Printing with Wysiwyg” section of
this note.
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General
Information

Form Feed Light

Worksheet Page
Command
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Formatting
Spreadsheets

Maximizing The
Printable Area

This section provides general guidelines for printing
spreadsheets.

The indicator next to the [Form Feed] key on the HP
Laserdet 4 printer lights whenever page data is stored in
the printer’s memory. Make sure the Form Feed light is
off before sending information to the printer. To print the
data in the printer’s buffer, press and release the

[On Line] key to take the printer offline, press and
release the [Form Feed] key to feed out the document,
then press and release the [On Line] key to return the
printer online.

Lotus 1-2-3 does not send a form feed at the end of the
document; therefore, data may remain in the printer’s
buffer. To automatically eject the last page of your
document, embed a Worksheet Page command in the
bottom left cell of your print range. To enter this
command press:

[/] [W]orksheet [Plage

This command automatically inserts a page break, and a
double colon (::) appears on your screen.

AN\027E in a setup string will prevent the Worksheet Page
command from executing.

Example:

If your print range is A1..D115, position the cursor in
A116 and press [/] [Wlorksheet [Plage. Then change your
print range to A1..D116.

When setting margins or using headers, footers, or
borders, you must select the Formatted option (this is
selected by default) within Lotus 1-2-3. Tb select the
Formatted option, press:

[/] [Plrint [Plrinter [Olptions [Olther [Flormatted

To maximize your vertical printable area, select the
Unformatted printing option. If you are not printing
headers or footers, this option gives you a three-line top
and bottom margin. To select this option, press:

[/1 [PIrint [Plrinter [Olptions [O]ther [Ulnformatted
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“.l If Unformatted is chosen, headers, footers and borders
Note # cannot be printed.

Printing Footers = When printing footers, use the [Plage command (selected
after pressing [Glo in the Printer menu) to eject the last
page from the printer. If this option is not selected, Lotus
1-2-3 cannot identify the last page and will not print the
footer.
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Printing Special T print special characters available in your HP LaserJet

Characters 4 printer, press [Alt] [F1] and then the two character
Compose Sequence from the following table (after you
enter the second Compose value, the character appears on
your screen). First, find the decimal value of the special
character you want to print. (The special characters and
their decimal values can be found in the Symbol Sets
section of the Appendix in your HP Laserdet 4 Printers
User’s Manual). Next, use the corresponding two
character Compose Sequence to access the special
character.

Special Character Decimal Value Chart

Compose Decimal Compose Decimal Compose Decimal Compose Decimal
Sequence Value Sequence Value Sequence Value Sequence Value
A 161 ?? 185 i 209 O~ 233
Ar 162 X0 186 o/ 210 o~ 234
E 163 L= 187 AE 211 us* 235
EA 164 Y= 188 a* 212 us* 236
E" 165 SO 189 i 213 (03 237
A 166 ff 190 o/ 214 Y" 238
" 167 ] 191 ae 215 y" 239
‘(space) 168 ar 192 A" 216 P- 240
‘(space) 169 et 193 it 217 p- 241
A(space) 170 oA 194 o" 218 us* 242
“(space) 171 ur 195 u” 219 us* 243
~(space) 172 a’ 196 E 220 us* 244
U 173 e’ 197 i" 221 us* 245
ur 174 o' 198 ss 222 us* 246
us* 175 v 199 or 223 14 247
us* 176 a’ 200 A 224 12 248
us* 177 e' 201 A~ 225 a_ 249
us* 178 o 202 a~ 226 o_ 250
us* 179 u 203 D- 227 < 251
C, 180 a" 204 d- 228 us* 252
c, 181 e" 205 I 229 > 253
N~ 182 o" 206 I 230 +- 254
n~ 183 u 207 o 231 us* 255
I 184 A* 208 o 232

US* - Unsupported

“.l Special characters are accessed from the current active
Note # symbol set. For example, decimal #210 in the Roman 8
symbol set is the character @. To specify an alternative
symbol set, include the command for the desired symbol
set in a Lotus 1-2-3 setup string (e.g., \027(10U for the
PC-8 (IBM-US) symbol set).
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Example:

To print the British pound sign in the Roman-8 symbol
set, find decimal value 187 in the table above. To the left
is the two character Compose Sequence, Li=. Press [Alt]
(F1] then L=.

For additional information about special characters, refer
to your Lotus 1-2-3 for DOS Release 2.3 User’s Guide or
call Lotus Technical Support.

Embedding Printer  Lotus 1-2-3 Release 2.3 supports embedded printer
Commands commands. This feature gives advanced users the power
to enhance printer output.

Lotus 1-2-3 requires that embedded printer commands be
placed in a blank row, at the left-most column of the
current print range. An embedded printer command
requires one row to initiate the command, and one row to
terminate the command; therefore, any action or feature
accessed by an embedded printer command is active for a
minimum of one row.

To embed a printer command, precede the command with
two vertical bars (| | ). After typing the two vertical bars,
the worksheet will show only one bar but the cell content
line will show two.

Example:

To embed the printer command for italic print, position
your cursor in the left-most column of a blank row in your
print range, then enter the following: | 1\027(s18S. This
command will give italic print to the currently selected
font.

".l To avoid unwanted page ejects, do not include a reset
Note # command \027E in embedded printer commands.
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Common Tasks The following pages provide information about print
features, setup strings, font selection, and print settings.

Resetting the  The following setup strings and settings are valid only if
Printer’s Printing  your HP Laserdet 4 printer’s Printing Menu is currently
set to factory defaults. Tb reset the printer’s Printing
Menu tol;:f?:l:g Menu to its factory default settings use these steps:

1. Press [On Line] to take the printer offline.

2. Hold down the [Shift] and [Menu] keys on the
printer for about 10 seconds until RESET=MENU
appears.

Besides returning the printer to its factory default
settings, Reset Menu also clears the page buffer,
removes all temporary personality data such as
downloaded typefaces, and resets all printing
environment parameters (such as number of copies,
paper size, ete.). Items in the Config, Parallel, Serial
and AUX10 menus will not be reset.

3. Press the [On Line] key to return the printer online.

Selecting Setup  If you are using the Lotus 1-2-3 LaserJet series printer
Strings driver, you can select font and line-spacing attributes for
your spreadsheet by entering setup strings.

To enter a setup string, press [/] [P]rint [P]rinter
[O]ptions [S]etup, then enter the desired setup string
from the lists on the “Portrait Printing” and “Landscape
Printing” sections of this note. Refer to your Lotus 1-2-3
for DOS Release 2.3 User’s Guide for more information
about using setup strings.
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Portrait Printing

l.| When using the setup strings on this page, note the differ-

Note '# ences in these characters:
f =lower case letter “1” 1 = numeric one
O = upper case letter “O” # = numeric zero
[/] [P]rint [Plrinter [Olptions [Sletup [Plage [M]argins

Length [Rlight
LETTER PAPER, 60 lines per page (6 lines/inch):

10 cpi \P27& £2a00\927(sfp10H 60 80
12 cpi \P27& £2a00\F27(sgfp12H 60 96
16.67 cpi*  \#27&£2a#0\P27(s¥p16.67h8.5v0T 60 134
LETTER PAPER, 66 lines per page (6.6 lines/inch): +
10 cpi \P27& £2a07.27C\P27(sfp14H 66 80
12 cpi \G27& £2a807.27C\927(sgp12H 66 96
16.67 cpi* \@P27&¢2a007.27C\F27(s@¥p16.67h8.5v4T 66 134
LETTER PAPER, 80 lines per page (8 lines/inch):
10 cpi \P27& (2afo8D\#27(sdpldH 80 80
12 cpi \P27& £2a008D\F27(sfpl2H 80 96
16.67 cpi* \P27&£2a008D\P27(sffp16.67h8.5vAT 80 134
LEGAL PAPER (using a legal tray), 78 lines per page (6 lines/inch):
10 cpi \P27& £3a00\927(sgplgH 78 80
12 cpi \P27& £3200\927(sfpl12H 78 96
16.67 cpi* \@27&£3a00\027(sPpl16.67Th8.5vAT 78 134
LEGAL PAPER (using a legal tray), 104 lines per page (8 lines/inch):
10 cpi \P27& £3a008D\927(sfploH 100 80
12 epi \P27& £3a008D\F27(sfpl2H 100 96
16.67 cpi* \P27&£3a008D\F27(sfpl16.67h8.5vAT 100 134
LEGAL PAPER (manual feed), 78 lines per page (6 lines/inch):
10 cpi \P27& £3a2hPO\F27(sgfplFH 78 80
12 cpi \P27& £3a2hPO\F27(spl 2H 78 96
16.67 cpi* \P27&£3a2hFO\P27(sffp16.67h8.5vAT 78 134
LEGAL PAPER (manual feed), 104 lines per page (8 lines/inch):
10 cpi \P27& £3a2hdo8D\#27(sdp10H 100 80
12 cpi \F27& £3a2hdo8D\927(s@pl2H 100 96
16.67 cpi* \#27&¢3a2hFo8D\F27(sfpl6.67h8.5v4T 100 134

*This printer command will produce 16.67 character per inch (cpi) Line Printer type. Since the
HP LaserJet 4 printer has scalable Courier and scalable Letter Gothic typefaces, the font
selection command could be written \@27(sfp16.67h4H99T to produce 16.67 pitch Courier or
\@27(sfp16.67h4142T to produce 16.67 pitch Letter Gothic.
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Landscape Printing

[/] [Plrint [P]rinter [O]ptions [Sletup [Plage [Mlargins
Length [Rlight
LETTER PAPER, 45 lines per page (6 lines/inch):

10 cpi \P27&£2a10\@27(sdp10H 45 106
12 cpi \027& £2a10\@27(sPp12H 45 127
16.67 cpi*  \@27&(2a10\P27(sP¥p16.67ThgT 45 177
LETTER PAPER, 66 lines per page (8.8 lines/inch):
10 cpi \P27& (2al05.45C\ @27 (sPp10H 66 106
12 cpi \P27&£2a105.45C\@27(sPp12H 66 127
16.67 cpi*  \027&(2a105.45C\@27(sfp16.67hAT 66 177
LEGAL PAPER (using a legal tray), 45 lines per page (6 lines/inch):
10 cpi \P27& £3a10\P27(sPp10H 45 136
12 cpi \#27&£3a10\027(sp12H 45 163
16.67 cpi* \@27&(3a10\027(s@p16.67ThdT 45 227
17.75 cpi** \P27&£3a10\@27(s@pl7.75h4099T 45 240
LEGAL PAPER (using a legal tray), 66 lines per page (8.8 lines/inch):
10 cpi \P27& £3al05.45C\@#27(sdp10H 66 136
12 cpi \P#27&£3a105.45C\@27(sdp12H 66 163
16.67 cpi* \@27&£3a105.45C\@#27(sdp16.67h@T 66 2217
17.75 cpi*™* \@27&(3a105.45C \@27(s@p17.75h4099T 66 240
LEGAL PAPER (manual feed), 45 lines per page (6 lines/inch):
10 cpi \PH27& £3a2h10\027(sdp10H 45 136
12 epi \F27& £3a2h10\@27(s@p12H 45 163
16.67 cpi* \P27&(3a2h10\027(sdp16.6ThdT 45 2217
17.75 cpi** \P27&£3a2h10\H27(sdp17.75h4499T 45 240
LEGAL PAPER (manual feed), 66 lines per page (8.8 lines/inch):
10 cpi \@#27& £3a2h105.45C\@27(sdp10H 66 136
12 cpi \J27&£3a2h105.45C\F27(s@p12H 66 163
16.67 cpi* \@#27&(£3a2h165.45C\P27(s@p16.67ThdT 66 2217
17.75 cpi** \P27& (3a2h105.45C\@#27(sP¥p17.75h4099T 66 240

*This printer command will produce 16.67 character per inch (cpi) Line Printer type. Since the
HP LaserdJet 4 printer has both scalable Courier and scalable Letter Gothic typefaces, the font
selection command could be written \#27(s@p16.67h4099T to produce 16.67 pitch Courier or
\927(sfp16.6Th4192T to produce 16.67 pitch Letter Gothic.

**The HP Laserdet 4 printer offers scalable Courier and scalable Letter Gothic typefaces. This
printer command will produce 17.75 pitch Courier print. If Letter Gothic typeface is needed, the
printer command should be modified to read \@27(sffp17.75h4142T.
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|
Printing With
Wysiwyg

Common Tasks  This section provides information about using your HP
LaserJet 4 printer with the Lotus 1-2-3 version 2.3
Wysiwyg option.

Wysiwyg allows far greater control of print functions

than Lotus 123 version 2.3 alone provides. Fonts can be
selected for specific sections of the worksheet;
underlining, shading, and bolding can be applied to a
specific range; paper feed options can be selected; and the
Preview function can be used to view the spreadsheet as it
will appear when printed.

Enabling Wysiwyg To use Wysiwyg, you must load it into memory. Wysiwyg
can be added automatically upon entering Lotus 1-2-3 or
invoked during the current Lotus 123 session. The
following instructions apply to adding Wysiwyg during a
Lotus 1-2-3 session. Check the Lotus 123 documentation
for instructions about loading Wysiwyg automatically.

1. Start Lotus 1-2-3.

2. To enable Wysiwyg, hold down the [Alt] key on your
computer’s keyboard, then press the [F10] key.

3. Select [Alttach.
4. Highlight WYSIWYG.ADN, then press [Enter].

5. Select No Key if you plan to use [:] (colon) or use a
mouse to display the Wysiwyg main menu. This
Wysiwyg function may also be assigned to [Alt-F7],
[Alt-F8], [Alt-F9] or [Alt-F10]. After making your
selection, the Wysiwyg add-in program will load into
memory. Press [Q]uit to return to the Lotus 1-2-3
spreadsheet screen.

".l Press [:] (colon) or press the alternate key you chose
Note ﬂ during the add-in process to activate the Wysiwyg menu.
To use Lotus 1-2-3 menus and functions, use the [/] key.
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Selecting a Printer and

Font Cartridge

Formatting a Page

Note '.ﬂ

Inserting or Removing a

Page Break

Specifying Page

Orientation and Paper

Location

Selecting Fonts

Wysiwyg supports the following Hewlett-Packard
cartridges:

Cartridge Fonts 92286

A,B,C,D,EF GH,
LEKLMNPQT
U, VY, Z

To choose a printer, press [:] [Plrint [Clonfig [Plrinter.
Select the HP LaserJet 4 PCL 5, then press [Enter].

Select [1]st Cartridge and select your cartridge from
the cartridges listed, then choose [Q]uit.

To select the Page-Size, Margins, Titles, Borders, and
Compression for your document, press [:] [Plrint
[L]ayout and make all page layout settings.

. Press [Qluit to exit the Layout menu.

If you change the margin settings below the defaults,
Top=.5", Bottom=.55", Left=.5", Right=.5", data may be
lost.

Wysiwyg allows you to insert and remove manual page
breaks in spreadsheets.

To insert a page break press: [:] [Wlorksheet [Plage, then
choose either [R]ow or [Clolumn.

To remove a page break, press: [Wlorksheet [Plage
[Dlelete.

1.
2.
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Press [:] [PIrint [Clonfig [Olrientation.

Select the document Orientation (Portrait or
Landscape), then press [Enter].

Select [Blin, set the paper location (manual feed or
tray), then press [Enter].

Press [Q]uit to exit the Config menu.

To select a Wysiwyg font, press [:] [Flormat [Flont.
You may select any of the listed fonts by highlighting
or typing the font number.

When asked for the range to change, highlight the
area to be formatted by using the “arrow” keys, then
press [Enter].



3. Change the attributes of Wysiwyg fonts by typing [:]
[Flormat. The Format menu lists the following
attribute selections: Bold, Italics, Underiine, Color,
Lines, Shade, and Reset.

4. Select the attribute you want to apply to a given
range by typing the first letter of the attribute (for
example, press [I] for italics), or highlight the
attribute with the cursor, then press [Enter] to select
it.

5. Press [Slet, select the range to be changed by using
the arrow keys to highlight the range, then press
[Enter].

You can use up to eight typefaces per worksheet file.

|l.I
Note .ﬂ

Selecting Cartridge Fonts b access cartridge fonts, follow these steps to modify the
font set to include the cartridge fonts you plan to use:

1. Press [:] [Flormat [Flont [R]eplace, and type the
number of a listed font you want to replace with one
of the cartridge fonts, then press [Qlther.

2. At the Select typeface menu, highlight the font you
want to add to your font list, then press [Enter].

3. Type in the point size of the cartridge font you want
to use (make sure the point size is available on your
cartridge), then press [Enter]. The cartridge font will
be listed in the Wysiwyg font selection box (see Note
below).

4. Type the number of the font to select it, highlight the
range to be changed, then press [Enter].

“.| If you want the font list change to be permanent, press [:]
Note # [Flormat [Flont [D]efault [Ulpdate, then press [Q]uit.

Printing a Document 1. To print a Wysiwyg document, press [:] [Plrint
[R]ange [S]et. Select the printable range by typing in
the range values or by pressing [.] (period key), then
using the arrow keys to highlight the range. After the
range 1s highlighted, press [Enter].

2. To select a printer, press [Clonfig [Plrinter, then
select the HP LaserdJet 4 printer driver you installed.

3. Press [Q]uit.
4. Press [Glo to print the document.
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Printing on Legal-size
Paper

Press [:] [Plrint [L]ayout [Plage-size [6]:Legal, make
other Page Layout selections, then press [Q]uit.

. Press [Clonfiguration [Qlrientation, then select

Portrait or Landscape.

Press [Blin and choose the paper location (Manual or
Tray), then press [Q]uit.

. Set Range, then press [Glo to print the document.

Tx To print on legal-size paper, you must have the universal

Note # paper tray set to legal, the MP tray configured as legal, or
have specified “Manual” under Wysiwyg’s Bin selection
option.

Printing Reverse Text = The Wysiwyg option allows printing white text on a black
background. To print reverse text follow these steps:

Printing a Graph
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1.

Press [:] [Flormat [SThade [S]olid, highlight the range
you want to have a solid shade, then press [Enter].

. Press [:] [Flormat [Flont, select the font you want,

specify the range to change, then press [Enter].

Press [Flormat [Clolor [R]everse, range, then press
[Enter].

4. Type text.

Press [:] [PIrint [R]ange [S]et, specify the range to
print, then press [Enter].

Press [Clonfig [Plrinter, select the HP LaserJet 4
printer driver you installed, then press [Enter].
Press [Qluit, then [Glo to print the document.

Press [:] [Plrint [Rlange [Slet. Select the printable
range by typing in the range values or highlighting
the area with the arrow keys, then press [Enter].

. Press [L]ayout, make page format settings, then

press [Q]uit to exit the Layout menu.

. Press [Clonfig [Plrinter, then select the HP LaserdJet

Printer driver you installed.

Press [Olrientation (Portrait or Landscape) to choose
page orientation.

. Press [Blin to select paper location (Manual or Tray),

then press [Q]uit.
Press [Glo to print the graph.



Common Problems

Out of Memory Error  Problem: An Out of Memory error message appears in
Lotus 1-2-3 while trying to print using Wysiwyg.

Cause: There is not enough available memory (RAM) in
your computer.

Solutions:

1. Disable the Lotus 1-2-3 Undo feature by typing [/]
[Wlorksheet [Gllobal [D]efault [O]ther [Ulndo
[Dlisable [Ulpdate [Q]uit.

2. Check your AUTOEXEC.BAT and CONFIG.SYS files
for any memory resident programs that are loaded
during startup. (For information on AUTOEXEC.BAT
and CONFIG.SYS files, check your DOS manual.)

3. If you use [/] [Slystem to exit Lotus 1-2-3, type exit,
not 123, to re-enter Lotus; otherwise the program will
attempt to load a second copy of itself. If you have
more than one copy of Lotus 123 running at once, exit
to the DOS level, then re-enter Lotus 1-2-3.
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PrintGraph This section provides information to help you configure
and use Lotus 123 PrintGraph with your HP LaserJet 4
printer. For additional information, see your Lotus 1-2-3

for DOS Release 2.3 User’s Guide.

Load Lotus 1-2-3 v enter the Lotus 1-2-3 sub directory, type CD\123r23
{or the sub directory where the Lotus 1-2-3 program
resides), then press [Enter]. At the DOS prompt, type
LOTUS and press [Enter] to display the 1-2-3 Access
System. Select PRINTGRAPH on the Lotus 123 Access
System menu, then press [Enter] to run the PrintGraph
program.

Configure the Printer  Perform the following steps to configure your HP LaserJet
4 printer to work with PrintGraph:

Printing Tasks

1. Press [Slettings [H]lardware [IInterface, then press
the number that corresponds to the interface for your
computer/printer configuration.

2. Press [Plrinter, highlight a selection, press the Space
Bar, then press [Enter].

Select [Q]uit to return to the Select menu.
Press [Alction [Plause, then press [N]o.
Press [Elject, then press [Yles.

Press [Q]uit.

SR

Confirm that your Interface, Printer Type, Paper Size,
and Action Settings are set properly. If they are
correct, press [S]ave to write a new configuration file
for PrintGraph.

Printing on Letter-size  Tob print on letter-size paper in portrait orientation, follow
Paper in Portrait  these steps:

Orientation
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1. Press [Slettings [Ilmage [Slize [H]alf [Q]uit [Q]uit
[H]ardware [Slize-Paper [L]ength=11 [W]idth=8.5
[Qluit [Quit [Qluit.

2. Choose [TImage Select, highlight the name of the
graph you want to print, press the space bar to mark
the graph, then press [Enter].

3. Press [A]lign [G]o to print the document.



Printing on Letter-size ~ For letter-size paper with landscape orientation, set the
Paper in Landscape  Image Size to Full, the Length to 8.5, and the Width to 11.

Orientation | pyogq [Slettings [TImage [Slize [Flull [Qluit [Q]uit
[Hlardware [Slize-Paper [L]ength=8.5 [Wlidth=11
[Qluit [Qluit [Qluit.

2. Choose [TImage-Select, highlight the name of the
graph you want to print, press the space bar to mark
the graph, then press [Enter].

3. Press [Allign [Glo to print the document.

“.l Do not set the control panel of the printer to a landscape

Note # font (Orientation=L on the front panel). This setting may
cause a 21 PRINT OVERRUN error on the printer (this
error means information sent to the printer is too complex
and if printing resumes, data loss may occur). Refer to
your HP Laserdet 4 and 4M Printers User’s Manual for
information about ERROR 21). If the printer displays 21
PRINT OVERRUN, press [Continue] to resume printing.
Tb avoid an ERROR 21, reduce page complexity, or use
the printer’s Page Protection feature.

Legal Size Paper - Paper  PrintGraph supports printing legal-size paper from a
Location legal-size tray, from the MP Tray configured to a
legal-size, or from manual feed. Set the paper size to
PAPER=LEGAL in the printer’s Printing Menu and set
manual feed=on if you want to manually feed the paper.

Printing on Legal-size Paper in Portrait Orientation

Set the Image Size to Half, the Length to 14, and Width to
8.5 to print on legal-size paper in portrait orientation.

1. Press [Slettings [TImage [Slize [H]alf [Q]uit [Qluit
[H]ardware [Slize-Paper [Llength=14, [Wlidth=8.5
[Qluit [Qluit [Q]uit.

2. Choose [Ilmage-Select, highlight the name of the
graph to be printed, press the space bar to mark the
graph, then press [Enter].

3. Press [Allign [Glo to print the document.
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Printing on Legal-size Set the Image Size to Full, the Length to 8.5, and the
Paper in Landscape  Width to 14 to print on legal-size paper in landscape
Orientation orientation.

1. Press [Slettings [IImage [Slize [Flull [Q]uit [Q]uit
[H]ardware [Slize-Paper [L]ength=8.5, [Wlidth=14
[Qluit [Qluit [Q]uit.

2. Choose [Ilmage-Select, highlight the name of the
graph to be printed, press the space bar to mark the
graph, then press [Enter].

3. Press [A]lign [Glo to print the document.

1K To use the entire legal sheet of paper, use the Manual

Note ﬂ image size setting. When using Manual image size, the
width and length settings are dependent on the rotation
setting (orientation).

Novell Networks =~ When printing graphs through a Novell network, make
sure that the File Contents selection in the Novell utility
PRINTCON is set to Byte stream rather than Text. An
incorrect setting can cause a blank page to print.
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Common This section provides solutions to the common problems
associated with using Lotus 1-2-3 Release 2.3 with your

Problems HP LaserdJet 4 printer. These and other problems may be
avoided if you follow the instructions in the “Installation,
General Information” and “Common Tasks” sections of
this note.

Page Does Not Eject  Problem: The last page of the spreadsheet does not
automatically eject.

Solution: The keystroke sequence to follow (assuming
you have already correctly set your print range and
desired print options) when printing a spreadsheet is:

[/] [Plrint [Plrinter [A]lign [Glo [Plage

The [Plage command sends the printer a form feed
command which causes the printer to eject the page.

Creeping Text Problem: The first page of your spreadsheet prints
correctly but following pages have larger and larger top
margins (for example, creep down).

Solutions:

1. If you are using a setup string that contains a vertical
line spacing command (which affects the number of
lines printed on the page), set the Lotus 1-2-3 page
length to the number of lines per page specified by
the vertical line spacing command. For example: if
you are printing a portrait document, a vertical line
spacing command which prints 6.6 lines per inch will
require a 66 lines per page page length setting in
Lotus 1-2-3 (6.6 lines per inch x 10 inches); if you are
printing a landscape document, a vertical line
spacing command that produces 8.8 lines per inch
will require a 66 lines per page page length setting in
Lotus 1-2-3 (8.8 lines per inch x 7.5 inches). See the
“Common Tasks,” “Portrait Printing,” and “Landscape
Printing” sections of this application note for
additional information.

2. If you are not using a setup string which contains a
vertical line spacing command, and you are printing
a portrait letter-size document, set the Lotus 1-2-3
page length to 60 to correspond to FORM=60 LINES,
which is your HP Laserdet 4 printer’s default lines
per page. See the “Setting the Other Defaults” section
of this application note for additional information.
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Another Printer Print

3. You can maximize the number of lines per page by

using the Lotus 1-2-3 Unformatted printing option.
For example, if both Lotus 1-2-3 and the HP LaserdJet
4 printer are set to 60 lines per page and your
spreadsheet does not contain headers, footers, or
borders, you can print 60 lines on the page by
selecting the Unformatted printing option. To select
the Unformatted printing option, press [/] [Plrint
[Plrinter [Olptions [Olther [Ulnformatted.

Spreadsheets Problem: Spreadsheets that print correctly on non-HP
Formatted For  LaserJet printers do not print correctly on your HP

Incorrectly

Laserdet 4 printer.

Solutions:

1. Make sure you are using the HP LaserdJet 4 printer

driver. If not, press: [/] [Wlorksheet [G]lobal [Dlefault
[Plrinter [Nlame and select it.

. Clear the spreadsheet format ([/] [Plrint [Plrinter

[Cllear [Flormat), and reset to the Lotus 1-2-3
defaults you set in the “Setting Printer Defaults:
Step 2" section of this note.

Nothing Prints  Problem: Printer does not print.

Solutions:

1.

2.

If the printer’s Form Feed light is on, press the
[On Line] key to take the printer offline, then press
the [Form Feed| key to eject the page.

Make sure the correct DOS MODE commands are in
your AUTOEXEC.BAT file and your interface
selection in Lotus 1-2-3 corresponds to the interface
your printer is using. Refer to the “Select Interface”
section of this note.

Printer Error  Problem: The message Error displays in Lotus 1-2-3
when you print a spreadsheet or graph.

Solutions:

1.
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If printing a spreadsheet, make sure a print range is
specified: [/] [Plrint [Plrinter [Rlange and specify the
range to print. If your document is a graph, make
sure the graph has been selected: [/] [Plrint [P]rinter
[Ilmage, then select [Clurrent or [N]amed.



All Print is on One
Line

“xx LOAD” ’paper
size’

ERROR 21 (Print
Overrun)

2. With some computers, interface selection DOS Device
LPT1 works better than selecting Parallel 1 or Serial
1. Press [ /] [W]orksheet [G]lobal [D]efault [Plrinter
[IInterface and select [5]DOS Device LPT1:, then
press [Q]uit [Ulpdate [Q]uit to save the selection.

Problem: The entire spreadsheet prints on a single line.
(This usually appears as a solid black line at the top of
the page.)

Solution: Press [/] [W]orksheet [Gllobal [D]efault
[Plrinter [A]utoLF [N]o, then [Q]uit [Ulpdate [Q]uit.

Problem: Printer displays xx LOAD when sending a print
job to the printer. xx could be MP, PC, or LC.

Cause: The (page size) command sent to the printer does
not match the paper size loaded in the paper cassettes, or
match the paper size setting in the printer’s Paper Size
menu (this applies only if the MP Tray is set to MP
TRAY=CASS in the Config menu).

Solution: Make sure the paper cassettes contain the
paper size required by the print job, or if you have the MP
Tray set to MP TRAY=CASS, make sure the paper size is
specified correctly in the printer’s Paper Size menu (press
the [Paper Size] key).

Problem: The message 21 PRINT OVERRUN appears
in the printer’s control panel display.

Cause: The document being printed contains an area, or
areas, which are too complex for the printer to print.

Solutions:

1. Reduce the complexity of the document by using
smaller fonts or removing bolded and underlined
attributes.

2. Reduce the print resolution of the document (for
. example, choose 300 dpi instead of 600 dpi).

3. Turn on the printer’s Page Protection feature. (See
your printer user’s manual for instructions about how
to use this feature.)
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ERROR 20 (Mem
Overflow)

Other Problems

Problem: The message 20 MEM OVERFLOW appears
in the printer’s control panel display.

Cause: You have run out of available memory in your
printer. This may happen when you try to print a
spreadsheet that downloads too many soft fonts or
contains high resolution rules such as shades and/ or
graphs.

Solutions:

1. Reduce the print resolution of your spreadsheet (for
example, choose 300 dpi instead of 600 dpi).

2. Purchase additional memory for your printer.

If you have other problems or if these suggestions have
not resolved the problem:

1. Read the “General Information” section of this
application note.

2. Print similar spreadsheets. Is the problem isolated to
one spreadsheet? If so, check for differences in print
settings.

3. Repeat the installation procedures.

4. Refer to your Lotus 1-2-3 Release 2.3 User’s Guide or
call Lotus Technical Support for assistance in using
Lotus 1-2-3 functions or macros.

5. Call Hewlett-Packard’s Customer Support Center

Telephone . . .. .. ... ....... (208) 323-2551
Hours (Mon, Tue, Thu, Fri) . . . . . 7 AM to 6 PM MST
Wednesdays . .. .......... 7 AM to 4 PM MST

When you call Hewlett-Packard, please call from a
telephone next to your computer and HP LaserJet 4
printer. Assisting you often requires access to your printer
and Lotus 1-2-3 application. You should also have a
current copy of the printer’s self-test available. The
printer’s self-test will allow you to quickly identify
current printer settings for the support technician.
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About This
Chapter

Software Application
Notes and Printer
Drivers

HP First FAX
Retrieval System

Hewlett-Packard
Distribution

HP Peripherals
Forum on
CompuServe

WordPerfect’s
Bulletin Board
Service (BBS)

This chapter is designed to assist you in setting up and
using WordPerfect 5.1 with your HP LaserdJet 4 printer.

HP also provides Software Application Notes and printer
drivers for additional selected software packages. These
notes and printer drivers are available through the
following distribution sources:

If you would like to have a list of drivers and Software
Application Notes faxed to you:

1. Dial (800) 333-1917 from any touch-tone telephone.
2. Select (1) for HP FIRST.

3. Follow the telephone voice prompts.

When you have selected all your documents, enter
the telephone number of the receiving FAX machine.
After HP FIRST acknowledges your documents are
ready, the system will dial the telephone number of
the FAX machine you selected, and the documents
will be sent to you.

Software Application Notes and printer drivers are
available for selected software packages through
Hewlett-Packard Distribution. Call (303) 353-7650 for
information (Monday through Friday, 7 AM to 6 PM,
MST).

If you are a member of CompuServe, you can download
Software Application Notes and software printer drivers
from the HP Peripherals Forum.

If you have a modem, you can download printer drivers
free from the WordPerfect bulletin board by calling the
number designated for your modem type.

BBS IBM (Baud 1200 -2400) . . . . . .
BBS High Speed (Baud 9600 - 38400) .
BBS 68000 (Baud 1200-2400) . . . . . (801) 226-1605
BBS Unix (Baud 1200 - 2400) (801) 228-9909

If you have questions or need help in using WordPerfect’s
BBS, call the following number for information.

WordPerfect BBS Support (801) 228-9904

(801) 225-4414
(801) 225-4444
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WordPerfect Customer Support
i WordPerfect 5.1 Installation . . . . . . . (800) 533-9605
Corporation Printer Support . . « .+ .+ . . . (800) 541-5170
Feature Support . . ... ... ..... (800) 541-5096
Network Support . . . . ... ... ... (800) 321-3389
GraphicsSupport. . . . . ... ... .. (800) 321-3383
Hours . .. .. ... ... ..... 7 AM to 6 PM MST
Charge ... ..... ... . ... . .c.... None
Required Identification . .. .. .. .License Number
Ordering Printer Disk Updates . . . . . (800) 321-4566

Supported Fonts

Bitmapped Fonts and  WordPerfect 5.1 supports all HP bitmapped font and
Scalable Typeface scalable typeface products. Support for bitmapped font
Products  cartridges, scalable typeface cartridges, and disk-based
bitmapped (soft) fonts are located on the Printer 1 HP
LaserdJet printer driver, and on the WPHP51 through
WPHP53 printer drivers. The WPHP53.ALL file includes
support for all three HP scalable typeface cartridges.

Support for disk-based scalable typefaces is available on
the AutoFont Support disks which ship with the
typefaces. To use AutoFont Support, you must have a PTR
program dated 9-26-90 or later. To check the date of your
PTR program, enter your WordPerfect 5.1 directory and
type DIR PTR.EXE at the prompt.

M Tob use AutoFont Support, the WordPerfect PTR.EXE file
Note # must be dated 9/26/90 or later. To check the date of this
file, enter the directory where you have installed WordPer-
fect 5.1 and type DIR PTR.EXE. Your screen should dis-
play something similar to the following:

PTR.EXE 9-26-90

If your PTR.EXE file is dated earlier than 9/26/90, you
can order the updated file from WordPerfect Corporation
(for a fee) by calling (800) 222-9409. Instructions for in-
stalling AutoFont Support and updating the PTR file are
packaged with the AutoFont Support disks.

Built-in Printer Fonts =~ WordPerfect 5.1 will let you use the printer’s internal
fonts in your documents along with any HP disk or
cartridge typefaces and fonts (both bitmapped and
scalable), up to 255 fonts per document,
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Installation

Installing Updated Printer
Drivers (from
WordPerfect Corporation)

Installing an Updated
Printer Driver (from
Hewlett-Packard)

Note '.'J
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If you received your printer driver from WordPerfect

Corporation, follow these steps to install the printer
driver:

1. Insert your WordPerfect Installation disk into drive A:
and type A:Install, or if you have copied your
Install program to your hard disk, you may run
install from the directory where the Install program
resides.

2. Follow the WordPerfect prompts for printer
installation.

3. Take a moment to read the Printer Helps and Hints
screen (use the cursor keys to scroll down through all
the information).

When you have completed the installation, the printer
driver will be present and selected (marked with an
asterisk) in WordPerfect.

If you received a printer driver from Hewlett-Packard see
the disk label for detailed instructions about loading the
driver.

Selecting the HP LaserJet 4 Printer:

If you received your updated printer driver from
Hewlett-Packard, you need to perform the following steps
to select the printer driver in WordPerfect 5.1:

1. Enter WordPerfect 5.1.

2. Press [Shift] (F7], [S] Select, [A] Additional, and
highlight the HP Laserdet 4 printer driver on the list
of available printers.

3. Press [S] Select, then press [Enter] to accept the
printer file name which is listed, or type a file name
of your choice, then press [Enter].

4. Read the Printer Helps and Hints screen (use the

cursor keys to scroll down through all the
information).

The Printer Helps and Hints screen contains information
about one method of printing reverse text (white text on a
black background). Another method of printing reverse
text is outlined in the “Reverse Printing” section of this
note.




Setting up the Serial
Configuration

5. Press [F'7] Exit to return to the Select Printer: Edit
screen. You are now ready to make additional
configuration changes to the printer driver, if needed.

Configuring Your Printer Driver:

If you do not want to make additional changes to the
printer driver, press [F7] three times to exit to a
document screen. However, you may now continue to
configure the printer driver by: 1) changing the Port,
(default will be LPT1:); 2) selecting a Sheet Feeder; 3)
selecting Cartridges and Fonts (if you have additional HP
font products); 4) choosing the Initial Base Font (which
WordPerfect will use as a default for all subsequent
documents); and 5) entering the Path for Downloadable
Fonts and Printer Command Files if you plan to use
downloaded disk-based fonts or typeface products.

If your HP LaserdJet 4 printer is connected to a serial port
(for example, COM1:), complete the following steps:

1. At the Select Printer: Edit screen ([Shift] [F7], [S],
[E]), select [P] Port.

2. WordPerfect will display a list of ports 1-LPT1,
2-L.PT2, 3-LPT3, 4COM1, 5-COM2, 6-COM3,
7-COM4, 8-Other. Enter the number which
corresponds to the appropriate port (for example, 4
for COM1).

3. Specify the printer’s baud rate, parity, etc. The correct
settings are shown below.

Select Printer: COM Port
1-Baud 9600
2 - Parity None
3 - Stop Bits (1 or 2) 1
4 - Character Length (7 or 8) 8
5 - XON/XOFF No
Selection: 0_

The printer’s default baud rate is 9600. If you will be
operating your printer at a baud rate other than 9600,
specify that baud rate.

4. Confirm that your settings match those above, then
press [Enter] to exit the Select Printer: COM Port
screen.

5. Press [F7] three times to return to a WordPerfect
document screen.
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Installing a Sheet Feeder

Installing Fonts and
Typefaces

Installing Bitmapped Font
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Note '.'ﬂ

5-6 WordPerfect version 5.1

Complete the following steps to install a sheet feeder for
your HP LaserJet 4 printer.

1. At the Select Printer: Edit screen ([Shift] [F7], [S],
[(E]), select [S] Sheet Feeder.

2. Highlight the HP LaserdJet 4 sheet feeder, then press
[S] Select.

3. Read the Sheet Feeder Helps and Hints screen, then
press [F7] Exit to return to the Select Printer: Edit
menu.

4. Press [F'7] three times to return to a WordPerfect
document screen.

Bitmapped cartridges provide a limited number of fonts at
fixed point sizes. Scalable typeface cartridges, however,
allow you to select point sizes for your fonts in quarter-point
increments ranging from .2 point to 999.7 points.

If you have a scalable typeface cartridge, see the
“Installing Scalable Typeface Cartridges” section of this
note.

1. At the Select Printer: Edit screen ([Shift] [F7], [S],
{ED), select [C] Cartridges and Fonts.

2. Highlight Cartridges and press [S] Select.

3. Highlight the desired font cartridge name then press
[*] to select the cartridge. An asterisk will appear
next to the selected cartridge. To de-select a font,
highlight the cartridge name then press [*] again, or
press the [Backspace] or [Delete] keys while the
cartridge is highlighted.

If you do not see your font cartridge listed as an option on
the Cartridges menu, you have two alternatives:

1. Order an updated printer disk from WordPerfect
Corporation.

2. If your font cartridge package includes AutoFont Support
disks, follow the instructions in the “Installing Scalable
Typeface Cartridges” section of this note. AutoFont Support
will enable WordPerfect (version 5.1) to support your new
font cartridge. (To use AutoFont Support, your PTR.EXE file
must be dated 9/26/90 or later.)




4. Press [F7] five times to install the fonts and return to
a document screen.

For information about how to select one of the fonts on
the cartridge within your document, see the “Selecting
Fonts” section of this note.

Installing Bitmapped  The following steps will help you install bitmapped

Disk-based (Soft) Fonts  disk-based fonts for use with WordPerfect 5.1. Bitmapped
disk-based font products provide a selection of fonts in
several fixed point sizes. Disk-based scalable typefaces,
however, can be scaled by the HP Laserdet 4 printer to
sizes ranging from .2 point to 999.7 points. See the
“Installing Disk-Based Scalable Typefaces” section of this
note.

1. At the Select Printer: Edit screen ([Shift] [F7], [S],
[E]), select [C] Cartridges and Fonts.

WordPerfect 5.1 includes printer driver support for
all of HP’s bitmapped disk-based fonts. These printer
drivers are located on the WordPerfect 5.1 Additional
Printers disk. (AutoFont Support disks will not be
available for the bitmapped disk-based font products.)

2. Highlight Soft Fonts, then press [S] Select.

3. Highlight the name of your bitmapped disk-based
font group, then press [S] to Select.

“.l WordPerfect 5.1 presets the memory available for fonts

Note ﬂ for the HP Laserdet 4 printer to 700K. If you have an HP
Laserdet 4 printer and optional memory, highlight Soft
Fonts and press [Q] Change Quantity. Specify the
available memory:

1720 K (for 1 MB of optional memory)
2720 K (for 2 MB of optional memory)
3720 K (for 3 MB of optional memory)
4720 K (for 4 MB of optional memory)

If you are using the HP LaserdJet 4 printer’s Page
Protection feature, you need to reduce the amount of
memory you are using for your fonts by the amount that
you are using for page protection (1065 K - Letter; 1264 K
- Legal).

4. Scroll through the list of available disk-based fonts,
and mark the disk-based fonts you want with a [+],
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an [*], or a [+] and an [*]. To de-select a font,
highlight it, then press [+] or [*].

Press [+] to mark the disk-based font if you want

WordPerfect to automatically download each time you
print.

Press [*] to mark the disk-based font if the font will
be downloaded as a permanent, font outside of
WordPerfect by a downloading utility, or if you plan
to have WordPerfect download the font when you
initialize the printer by pressing [Shift] [F'7] [I]
before you print.

Mark a font with both the * and [+] to allow
WordPerfect to swap the fonts in or out as necessary.
Fonts marked with a [+] and an [*] will need to be
initialized (downloaded) by WordPerfect.

Repeat step number 4 for each disk-based font.

5. Press [F7] twice to save your selections and exit, the

Select Printer: Soft Fonts screen.

6. Press [F7] to Exit the Select Printer: Cartridges and

7.

8.

Fonts screen and install the fonts.

At the Select Printer: Edit screen, select [D] Path for
Downloadable Fonts and Printer Command Files and
specify the path where your bitmapped disk-based
font files are installed. For example: if your
disk-based font files are installed in the
C:\HPFONTS directory, type C:\HPFONTS, then
press [Enter].

Press [F7] twice to exit to the Print menu screen. If
you selected your disk-based fonts with an asterisk,
you may now choose [I] (Initialize) to download the
fonts to the printer.

If you selected your fonts with a +, you will not need to
initialize (download the fonts). WordPerfect will download
the fonts for you as needed.

Scalable typeface cartridges are selected the same way as
bitmapped font cartridges. (See the “Installing Bitmapped
Font Cartridges” section of this note for instructions
about how to install a cartridge printer driver).



If you do not find your cartridge in the list of available
cartridge printer drivers, you may either call WordPerfect
and request printer driver support files, or you may use
the AutoFont Support diskettes which came with your
cartridge to install printer driver support.

".l Tb use AutoFont Support, the WordPerfect PTR.EXE file
Note # must be dated 9/26/90 or later. To check the date of this
file, enter the directory where you have installed
WordPerfect 5.1 and type DIR PTR.EXE. Your screen
should display something similar to the following:

PTR.EXE 9-26-90

If your PTR.EXE file is dated earlier than 9/26/90, you
can order the updated file from WordPerfect Corporation
(for a fee) by calling (800) 222-9409. Instructions for
installing AutoFont Support and updating the PTR file
are packaged with the AutoFont Support disks.

Installing Disk-Based  Hewlett-Packard’s MasterType Library offers an
Scalable Typefaces  assortment of disk-based Scalable Typeface Collections
and individual scalable typefaces. To use these typefaces
with WordPerfect 5.1, you must first install the AutoFont
Support disks that are included with all scalable typeface
products introduced June, 1990 or later (see NOTE above).

Selecting Scalable  Once AutoFont support is installed, select disk-based
Typefaces  scalable typefaces the same way as disk-based fonts. (See
the “Installing Bitmapped Disk-based Fonts” section of
this note for instructions about installing your scalable
Typefaces.)
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General
Information

Helps and Hints

The following paragraphs summarize the Printer Helps
and Hints associated with WordPerfect’s printer
definition. Read this information carefully; it will help
you avoid many of the common problems discussed later
in this application note.

Initializing the printer (downloading permanent
disk-based (soft) fonts) will delete all disk-based fonts in
printer memory and those fonts marked with an asterisk

(*) will be downloaded.

m Line draw is not supported with proportionally
spaced fonts.

m To prevent ERROR 21, we recommend that you
install extra memory in the printer and turn Page
Protection on.

m White text on a black background is available
through strikeout after making a minor modifica-
tion to the printer definition using the PTR pro-
gram. See the Printer Helps and Hints screen when
installing your printer driver for instructions about
making this change to the printer definition, or call
WordPerfect customer support for assistance.

Sheet Feeder  When you select a sheet feeder, WordPerfect assigns a bin
Definition  number to each paper feed option available on the printer

HP LaserJet 4 Bin Numbers:
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Binl................... Paper Cassette
Bin2.................... Manual Paper
Bind.................. Manual Envelope
Bind........... ... .. ... ..., MP Tray
Bin5.............. Optional Lower Cassette
Bin6............. Optional Envelope Feeder



Common Tasks This section contains information to help you perform
frequent tasks with your HP Laserdet 4 printer.

Selecting Fonts  The font and font attributes are selected using
WordPerfect’s Font selection feature, [Ctrl] [F8].

Bitmapped fonts are offered in a selection of specific point
sizes. If you select a scalable font, WordPerfect 5.1 will
allow you to specify a point size between .2 and 999.7
points in quarter-point increments.

The base font is the font in which normal text is printed.
All other font attributes (for example, bold) are usually
variations of the base font.
Changing Fonts  To change fonts within a document:
1. Position the cursor where you want to change fonts.
2. Press [Ctrl] [F8] to display the Font menu.
3. Select [F] Base Font to display a list of available fonts.
4

. Highlight the font of your choice, then press [S] Select
to choose the font. If the font is scalable, WordPerfect
will prompt you to enter a point size after you select
the font.

Changing Font Attributes  Tb change a font’s appearance (for example, bold, italic,
outline or shadow);
1. Press [Ctrl] [F8] to display the Font menu.
Select [A] Appearance.
Select the desired attribute.
Type your text.

S

Press the right arrow key, or press [Ctrl] [F8} and
select [N] Normal, to return to the previous font.
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Changing Font Size  Font size is specified by choosing a new base font and
specifying the size you want (for example, Courier, 200
points) or by using the Font Size menu. To change a font’s
size by using the Fon¢ Size menu (options include
Superscript, Subscript, Small, Fine, Large, Very Large,
and Extra Large) follow these steps:

1. Press [Ctrl] [F8] to display the Font menu.

Select [S] Size.

Select the desired size.

Type your text.

A

Press the right arrow key or press [Ctrl] [F8] and
select [N] Normal to the previous font.

Changing Existing Text  To change the attributes or size of existing text, select the
text using WordPerfect’s Block feature ([Alt] [F4]).

1. Move the cursor to the beginning of the text you want
to change, press [Alt] [F4], then use the cursor to
highlight the text you want to modify.

2. Press [Ctrl] [F'8] to display the Font menu.
3. Select [S] Size, or [A] Appearance.
4. Select the desired attribute.
Reverse Printing The HP Laserdet 4 printer will allow you to print white

text on a black background (reverse printing), as shown
below, by using two methods: User Box or Strikeout.

HP LaserdJet
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Using the User Box  Follow the steps below to activate reverse printing in
Method  WordPerfect using the User Box method:

1. Press [Alt] [F9], [U] User Box, [O] Options.

2. Select [G] % Shading and enter 100%, then press
[F7] to return to your document.

3. Press [Alt] [F9], [U] User Box.

4. Select [C] Create. This step introduces a screen that
allows you to select the size of the box and its

placement. Once you have entered your settings,
choose [E] Edit.

5. Press [Ctrl] [F8], [F] Base Font. Highlight the
desired font and press [Enter]. (Enter point size, if
appropriate.)

6. Press [Ctrl] [F8], [C] Print Color. Press (W] White,
then press [Enter]. Type in the desired text, then
press [F7] twice to return to your document.

Using the Strikeout  Another method of printing white text on a black
Method background involves modifying the printer definition
using WordPerfect’s PTR program. For information about
this method, read the instructions on the Printer Helps
and Hints screen when you install your printer driver, or
if you need further assistance, call WordPerfect’s
customer support.

Rotating Text  The HP Laserdet 4 printer can print text in four
directions on the same page using the PCL language. The
following instructions will print text upside down on the
page using WordPerfect’s User Box feature.

1orIese] dH

Follow these steps to rotate the direction of text on a page:

1. Press [Alt] [F9], [U] User Box, [C] Create, [H]
Horizontal Position. Select the desired position (Left,
Right,or Center), [S] Size, [B] Set Both. Enter the
dimensions of the User Box, then press [E] Edit.

2. Press [Ctrl] [F8], [F] Base Font. Highlight the
desired font, then press [S] to Select. Enter point size,
if appropriate, then press [Enter].
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3. Type the desired text, then press [Alt] [F9]. Type the
number next to the number of degrees of desired
rotation (180 in the example above). Press [F7] twice
to return to your document.

Creating Forms  With WordPerfect 5.1 you can create custom forms for
odd-sized paper and envelopes, and use Bin numbers to
select specific paper locations, When you select a form,
you are telling the printer the size, orientation, and
location of your paper.

Follow these steps to create a custom form:

1. Press [Shift] [F8], [P] Page, [S] Paper Size/ Type, [A]
Add, [O] Other.

2. Enter the name of your form (for example,
Letterhead) and press [Enter].

3. Select [S] Paper Size.

4. Select one of the page sizes listed if you are using a
standard page size, or select [Q] Other if you do not
see your page size listed (see Note below). Press
[Enter] to return to the Format: Edit Paper
Definition menu.

e If you are creating a form with a non-standard paper size,
Note # Select [Q] Other. Type the width (in inches) and press
[Enter]. Specify the height (in inches) and press [Enter]
to return to the Format: Edit Paper Definition menu.

5. Select [F] Font Type, and choose the orientation of the
font you want to use (for example, landscape, if you
are printing an envelope).

6. Select [L] Location, then choose [C] Continuous for
paper cassette feed, [M} Manual for manual feed, or
[B] Bin number if you have installed a sheet feeder
definition for your printer. (For example, to create a
form for the automatic envelope feeder, choose [B]
Bin, type the number 6, then press [Enter]. To select
paper cassette continuous feed, choose [B] Bin, type
the number 1, then press [Enter]).

7. Press [F'7] Exit to save your changes and return to
the Format: Paper Size/Type screen.

8. Make sure the desired form is highlighted, choose [S]
Select the form, then press [F7] to return to your
document.,
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Printing Letter-Size
Paper in Landscape
Orientation

Printing Legal-Size
Paper (Continuous -
Using the MP Tray)

Follow these steps to print on letter-size paper in
landscape orientation:

1. Press the [Home] key three times and the up arrow
key once to position the cursor at the start of your
document.

2. Press [Shift] [F8], choose [P] Page, then [S] Paper
Size/Type.

3. Highlight Standard - Wide, then press [S] Select.
4. Press [Enter] twice to return to your document.

The HP Laserdet 4 printer will automatically rotate your
fonts to the landscape orientation.

Printing on legal-size paper using continuous (tray feed)
is a two-step process. The first step is configuring the
printer for continuous feed from either the universal
paper cassette or the MP Tray, and the second step is
editing the WordPerfect Legal, and/or Legal Wide form.

Step 1. - Configuring the Printer for MP Tray Continuous
Feed:

If you have the universal paper cassette, which supports
legal-size paper, set the paper-size dial on the cassette for
legal paper. However, if you have only the standard paper
cassette which came with the printer, you must configure
the printer so the legal-size paper will feed continuously
from the MP Tray.

To configure the printer for continuous MP Tray feed,
follow these steps:

1. Press and release the [On Line] key to take the
printer offline.

2. Press and release the [Menu] key five times -
[CONFIG MENU] will appear in the printer’s control
panel display.

3. Press and release the [Item] key and make sure the
display reads MP TRAY=CASS *. If it does, proceed
to step 5.

4. If the control panel display does not read MP
TRAY=CASS *, press and release the [+] key until the
display reads MP TRAY=CASS, then press the
[Enter] key to display MP TRAY=CASS *,

5. Press the [On Line] key to exit this menu.
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6. To set the MP Tray size, press and release the

[On Line] key to take the printer offline.

7. Press and release the [Paper Sizel key and make

sure it reads MP TRAY=LEGAL *. If the display
indicates a different MP Tray size, press and release
the [+] key until the display reads

MP TRAY=LEGAL, then press the [Enter] key to
display MP TRAY=LEGAL *,

8. Press the [On Line] key to return the printer online.

The printer is now configured for legal-size paper in the
MP tray.

Step 2 - Selecting Legal-Size Paper (Continuous Feed)
in WordPerfect

1.

Press the [Home] key three times and the up arrow
key once to position the cursor at the beginning of
your document.

Press [Shift] [F8], choose [P] Page, then [S] Paper
Size / Type.

. Highlight your Legal (or Legal-Wide) form. If your

form is set to Manual, (the default), go to step 4. If it
is already set to Continuous, or Bin I, go to step 5.

Select [E] Edit, [L.] Location, [C] Continuous, then
press [F'7] to save changes and exit to the Format:
Paper Size/Type screen.

5. Press [S] Select.
6. Press [Enter] twice to return to your document.
7. Press [Shift] [F7], [F] Full Document to print your

document.

Printing Legal-Size  Follow these steps to print on legal-size paper using the
Paper (Manual Feed) manual-feed option:

1.

2.
3.

5-16 WordPerfect version 5.1

Press the [Homel key three times and the up arrow
key once to position the cursor at the beginning of
your document.

Press [Shift] [F8), [P] Page, then [S] Paper Size/ Type.

‘Highlight the appropriate legal form (Legal or

Legal-Wide), and press [S] Select.



".| Make sure this form is listed as Manual (the default). The
Note # paper location will be listed under the Loc caption on the
screen. Also check your form to make sure that Prompt to
Load is set to NO. (See the “Computer Beeps When
Printing” section of this note for instructions about
changing Prompt to Load.)

4. Press [Enter] twice to return to your document.

5. Press [Shift] [F7], [Fl Full Document to print the
document.

6. When the printer prompts MF FEED LEGAL, press
and release the [On Line] key to print the page.

".l If your computer beeps when you try to print, press
Note # [Shift] [F7], choose [C] Control Printer, and read the
message on the screen. Press [G] Go, if appropriate.

Printing Com-10  You must create a form to use the optional automatic
Envelopes (Using  envelope feeder. For information about creating forms, see
the Optional the “Creating Forms” section of this note.

Automatic Envelope Printing an Envelope from the Optional Envelope

Feeder) Feeder:

Once you have created the envelope feeder form, follow
these steps to print on Com-10 (4-1/8" x 9-1/2") envelopes
using the envelope feeder:

1. Press the [Home] key three times and the up arrow
key once to position the cursor at the beginning of
your document.

2. Press [Shift] [F8], [P] Page, then [S] Paper Size/ Type.

3. Highlight the envelope feeder form you created and
press [S] Select.

4. Press [M] Margins. Enter 2" for the top margin and
enter 1" for the bottom margin, then press [Enter] to
go to the Format menu.

5. Press [L] Line, then [M] Margins. Enter a left margin
of 4" and a right margin of 1",

6. Press [Enter] and [F7] Exit to return to your
document.

Type the addresses, separating each address with a page
break ([Ctrl] [Enter]). When you are ready to print, press
[Shift] [F7], [F] Full Document.
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Printing Com-10  Printing Com-10 envelopes using continuous (tray feed) is
Envelopes  atwo-step process. The first step is setting up the printer

(Continuous - Using
the MP Tray)

for continuous feed from the MP Tray, and the second step
is editing the WordPerfect Envelope - Wide form.

Step 1 - Configuring the Printer for MP Tray Continuous
Feed:

Follow these steps to configure your printer to print
envelopes continuously from the MP Tray:

1.

Press and release the [On Line] key to take the
printer offline.

. Press and release the [Menu] key five times -

CONFIG MENU will appear in the printer’s control
panel display.

. Press and release the [Item] key and see if the

display reads MP TRAY=CASS *. If it does, proceed
directly to step 5.

If the control panel display does not read MP
TRAY=CASS *, press and release the [+] key until the
display reads MP TRAY=CASS, then press the
[Enter] key to display MP TRAY=CASS *,

Press and release the [On Line] key to exit this
menu.

. Tob change the MP Tray size, press and release the

[On Line] key to take the printer offline.

. Press and release the [Paper Size] key and see if the

display reads MP TRAY=COM10 *.

. If the display indicates a different MP Tray size, press

and release the [+] key until the display reads
MP TRAY=COM10, then press the [Enter] key to
display MP TRAY=COM10 *,

Press the [On Line] key to save the selection and go
back online.

The printer is now configured to print a COM-10 size
envelope from the MP tray.

5-18 WordPerfect version 5.1



Step 2 - Printing an Envelope:

Follow these steps to print Com-10 (4-1/8" x 9-1/2")
envelopes using the MP Tray for continuous envelope
printing:

1. Press the [Home] key three times and the up arrow
key once to position the cursor at the beginning of
your document.

2. Press [Shift] [F'8], [P] Page, [S] Paper Size/ Type.

3. Highlight the Envelope - Wide form. If your form is
set to Manual, (the default), go to step 4. If your form
is set to Continuous, or Bin I, press [S] Select, and go
to step 5.

4. Select [E] Edit, [L] Location, [C] Continuous, press
[F'7] to save changes and exit to the Format: Paper
Size/Type screen, then press [S] Select.

5. Press [M] Margins. Enter 2" for the top margin, and
enter 1" for the bottom margin, then press [Enter]
again to go to the Format menu.

6. Press [L]Line, [M] Margins. Enter a left margin of 4"
and a right margin of 1". Press [Enter] again, then
[F7] to return to your document.

7. Type the addresses, separating each address with a
page break [Ctrl] (Enter].

8. Press [Shift] [F7], [F] Full Document to print your
document.

Printing Com-10  Follow these steps to print Com-10 envelopes using
Envelopes (Manual manual feed. '
Feed) 1. Press the [Home] key three times and the up arrow

key once to position the cursor at the beginning of
your document.

2. Press [Shift] [F8], [P] Page, [S] Paper Size/ Type,
highlight the Envelope Wide form, and press [S]
Select.

I Make sure this form is listed as Manual (the default). The

Note # paper location will be listed under the Loc caption on the
screen. Also check your form to make sure that Prompt to
Load is set to NO. (See the “Computer Beeps When
Printing” section of this note for instructions about
changing Prompt to Load.)
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3. Press [M] Margins. Enter 2" for the top margin and
enter 1" for the bottom margin, then press [Enter] to
go to the Format menu.

4, Press [L] Line, [M] Margins. Enter a left margin of 4"
and a right margin of 1." Press [Enter] again, then
[F7] to return to your document.

5. Type the addresses, separating each address with a
page break [Ctrl] [Enter].

6. Press [Shift] [F7], [F] Full Document to print your
document.

7. When the message MF FEED COM10 appears on the
printer’s control panel display, press and release the
[On Line] key to print the envelope.

".l If your computer beeps when you try to print, press
Note g [Shift] [F7], choose [C] Control Printer, and read the
message on the screen. Press [G] Go, if appropriate.

Printing Special  The HP Laserdet 4 printer will print (graphically or from
Characters one of the resident symbol sets) all of the characters in
Appendix P of the WordPerfect User’s Manual. Those
characters that you create with the [Ctrl] [V] Compose
function will be sent to the printer as graphics figures.

Printing a special character within a document:

1. Position the cursor where the character is to be
printed.

2. Press [Ctrl] [V] Compose. The prompt Key = will
appear at the bottom of the screen.

3. Enter the WordPerfect character map number where
the special character is located (0-12), a comma, the
character number, then press [Enter].

Example:

The copyright symbol,, is in map 4, character number 23.
Press [Ctrl] [V], [4], [,], [23], [Enter] to select this

character.
".l The character displayed on the screen will often not
Note ﬂ match the character selected to print.
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Embedding Printer  Printer commands can be embedded in WordPerfect 5.1
Commands documents. See the Printer Command section of your
user’s manual for a listing of printer commands. The
steps required to embed printer commands in a
WordPerfect 5.1 document are as follows:

1. Press [Shift] [F8], [O] Other, [P] Printer Functions.
2. Select [P] Printer Command, [C] Command.

3. Enter the printer command. To enter the escape
control character, (Ec), type , then enter the
remainder of the printer command in its ASCII form.
There should be no spaces in the command.

Example:
Ec&15X would be entered as &15X

4. Press [Enter], then [F7] to return to your document.
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Common This section provides a troubleshooting approach to
solving the common problems associated with using

Problems WordPerfect with an HP Laserdet 4 printer. In most
cases, these problems can be avoided if you follow the
guidelines presented in the “General Information” and
“Common Tasks” sections of this application note.

Computer Beeps Problem: If you choose to manually feed paper, the
When Printing  computer beeps when you try to print. WordPerfect’s
Printer Control screen ([Shift] [F7], [4]) displays the
message Insert paper, press G to continue.

Cause: The Prompt To Load setting for the Paper
Size / Type Selected is set to Yes.

Solution: Change the Prompt Tb Load setting for the
Selected Paper Size/Type to No. ([Shift] [F8], [2], [7], [E]
Edit, [r] Prompt to Load, [N] No, [F7]).

Units of Measure Problem: Some of the procedures (for example, creating
forms and formatting envelopes) listed in this application
note do not work as expected.

Cause: Your default units of measure may not be set to
inches.

Solutions:

1. Include the quote mark (type 4" rather than 4) when
entering the margin and form size specifications
listed in this application note.

2. Set your default units of measure to inches. Press
[Shift] [F1], [E] Environment, [U] Units of Measure,
(D] Display and Entry of Number, specify [“], then
press [F7] to Exit.

Incorrect Font Problem: Your document, or a portion of it, does not
print in the correct font.
Causes:

1. Did you install the correct printer definition and
fonts?

2. When selecting fonts, are you specifying the desired
font or simply specifying the size (for example, Large
or Very Large)?

3. If you are using a font cartridge, is the font cartridge
properly inserted?
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4, If a disk-based font or typeface has been marked * , has
the printer been initialized ((Shift] [F7] [I]
Initialize)?

Solutions:

1. Make sure the HP Laserdet 4 printer is selected
(marked with an asterisk [*]). To check the printer
selection, press [Shift] [F7], [S] Select. If the HP
Laserdet 4 printer is not marked with an asterisk,
highlight HP Laserdet 4 and press [S] Select. If you
do not see the HP Laserdet 4 listed, refer to the
“Printer Driver Installation” section of this note for
instructions about adding printer driver support.

2. Rather than specifying size (for example, Large or
Very Large), press [Ctrl] [F8], [F] Base Font, and
select the desired font.

3. If the font is a cartridge font, take the printer offline
and insert the font cartridge firmly - you should hear
and feel the cartridge click into place. Return the
printer online and try printing again.

4. If you are using disk-based (soft) fonts which you
have marked with an asterisk [*], you will need to
Initialize the printer before you print: ([Shift] [F7]
(1] Initialize).

Problem: At the Format: Paper Type screen ([Shift]
[F7], (2], [7]), you don’t see the form you need listed.

Cause: The currently selected printer definition does not
contain user-defined forms because forms were deleted or
the printer driver was reselected or reinstalled.

Solutions:

1. Press [Shift] [F7] and confirm that the proper printer
definition has been selected.

2. If no forms have been created, existing forms have
been deleted, or if you reinstalled or reselected your
printer, create the necessary forms. Refer to
“Creating Forms” in the “Common Tasks” section of
this application note.
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Other Problems  If you are having other types of problems, or if the
suggestions provided in this section have not resolved the
problem:

1. Look at your document in the View mode and
compare it to your hard copy.

2. Read the “General Information” section of this
application note.

3. Try printing similar documents. Can you isolate the
problem to one document? If so, use WordPerfect’s
Reveal Codes function [Alt] [F3] and Search function
[F2] to find and delete invalid or misplaced format
selections.

4. Repeat the installation procedures. This will help
ensure proper installation of the correct printer
definition.

5. Refer to your WordPerfect user’s manual or call
WordPerfect Customer Support if you need assistance
in using WordPerfect’s functions (columns, macros,
merge) or PTR program.

6. Call Hewlett-Packard’s Customer Support Center.
Calling for Help At the Hewlett-Packard Customer Support Center, our

trained technicians will be happy to help you with your
printing needs.

Hours (Mon, Tue, Thu, Fri) . . .. .. 7 AM to 6 PM MST
Wednesday . . ... .......... 7 AM to 4 PM MST
Telephone . . . . .. ... ... ...... (208) 323-2551

When you call Hewlett-Packard, please call from a phone
next to your computer and HP LaserdJet 4 printer.
Assisting you often requires access to your printer and
WordPerfect application. You should also have a current
copy of the printer’s self-test available. This will allow you
to quickly identify current printer settings for the support
technician.
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